1. About this manual .................................................................7
  1.1. Copyrights .................................................................7
  1.2. Trademarks .................................................................7
  1.3. General .................................................................7
  1.4. Use of symbols ..............................................................8
  1.5. Document conventions ................................................8
  1.6. Related documents ......................................................9
  1.7. Document revisions ......................................................9

2. Introduction ............................................................................11
  2.1. About this section .......................................................11
  2.2. COM 500 as communication gateway .........................11
  2.3. COM 500 engineering process .......................................11

3. Safety information ..................................................................13
  3.1. About this section .......................................................13
  3.2. Backup copies ...........................................................13
  3.3. Fatal errors ...............................................................14
  3.4. Status codes .............................................................14

4. Instructions ...............................................................................15
  4.1. About this section .......................................................15
  4.2. Overview of COM 500 ..................................................15
    4.2.1. COM 500 application .............................................16
    4.2.2. Functional environment ...........................................17
    4.2.3. Communication Programming Interface ....................17
  4.3. Installation ......................................................................18
    4.3.1. Upgrading COM 500 revision 1.0...4.0 to 4.1 ............18
    4.3.2. Software installation ...............................................18
    4.3.3. COM 500 start-up ....................................................19
    4.3.4. Presentation order of pictures and dialogs ...............20
  4.4. System configuration ....................................................20
    4.4.1. Base system configuration ......................................21
    4.4.2. Communication system configuration ......................22
    4.4.3. Configuration tips ...................................................24
  4.5. Signal generation ........................................................26
    4.5.1. Reusing an existing application ..............................26
    4.5.2. Importing signals ...................................................26
    4.5.3. Building a COM 500 application ............................27
  4.6. Signal engineering .......................................................28
    4.6.1. Adding icon for Signal Cross-Reference Tool ............30
    4.6.2. Adding icon for Communication Diagnostics dialog ....30
    4.6.3. Using Signal Cross-Reference Tool .........................30
4.6.3.1. Menus .................................................................31
4.6.3.2. Toolbar ..............................................................32
4.6.3.3. Tabs ................................................................32
4.6.4. Opening and closing Signal Cross-Reference Tool ..........34
4.6.5. Defining NCC properties ............................................34
  4.6.5.1. Adding NCC ......................................................35
  4.6.5.2. Deleting NCC ....................................................37
  4.6.5.3. Defining NCC properties .....................................37
4.6.6. Definition of Function Table download ........................38
4.6.7. Alarm groups ..........................................................39
  4.6.7.1. Adding alarm groups ..........................................40
  4.6.7.2. Editing alarm groups .........................................41
  4.6.7.3. Deleting alarm groups .......................................41
  4.6.7.4. Resetting alarm groups .......................................41
4.6.8. Defining views ........................................................41
4.6.9. Defining attributes for columns .....................................43
  4.6.9.1. Adding new attributes .......................................44
  4.6.9.2. Editing attributes ..............................................44
  4.6.9.3. Deleting attributes ............................................44
4.6.10. Defining auto-address parameters .................................44
4.6.11. Indication address overlap check ................................45
4.6.12. Signal handling .....................................................46
  4.6.12.1. Adding signals ...............................................46
  4.6.12.2. Editing signals ...............................................46
  4.6.12.3. Deleting signals ...............................................46
4.6.13. Defining indication cross-references ............................47
  4.6.13.1. Adding cross-references ...................................49
  4.6.13.2. Deleting cross-references ..................................53
4.6.15. Defining command cross-references ............................56
  4.6.15.1. Adding cross-references ...................................58
  4.6.15.2. Deleting cross-references ..................................60
4.6.16. Defining parameters ................................................61
4.6.17. Importing and exporting cross-references .....................63
  4.6.17.1. Exporting cross-references ................................63
  4.6.17.2. Importing cross-references .................................64
4.6.18. Printing cross-references .........................................65
4.7. Using COM 500 .........................................................70
  4.7.1. Communication Diagnostics dialog ............................70
    4.7.1.1. Link Layer diagnostics ...................................70
    4.7.1.2. Alarm Group diagnostics ................................72
    4.7.1.3. System information .........................................76
4.7.1.4. Application tab ....................................................76
4.7.2. Traceability ..........................................................78
4.7.3. Command authorization .............................................80
4.7.4. Recording signal routing to log files .................................81

5. Technical description ........................................................87
5.1. Hardware requirements ....................................................87
5.2. Available protocols .........................................................87
  5.2.1. Information about protocols .....................................88
  5.2.2. CPI ........................................................................89
5.3. Data flow .........................................................................90
  5.3.1. Indications .................................................................91
    5.3.1.1. Mechanism and data types ....................................91
    5.3.1.2. Telegrams and parameters ..................................92
    5.3.1.3. Handling of analog and digital values .................97
    5.3.1.4. Deadband .......................................................98
  5.3.2. Commands ...............................................................99
    5.3.2.1. Mechanism and data types ....................................99
    5.3.2.2. Telegrams and parameters ..................................99
    5.3.2.3. Command confirmations in IEC 60870-5-101/104 ....101
  5.3.3. System messages, system and application commands ....102
  5.3.4. Time synchronization ...............................................102
5.4. Cross-reference and parameter files ..................................103
  5.4.1. Cross-reference files ...............................................103
  5.4.2. System and application parameter file ........................103
  5.4.3. Parameter files of the Signal Cross-Reference Tool ......103
5.5. Application objects ........................................................104
  5.5.1. Introduction ............................................................104
  5.5.2. Application objects created by COM 500 .................104
  5.5.3. Application objects modified by COM 500 ...............105
5.6. COM 500 command procedures .........................................105
  5.6.1. Description of the command procedures ......................106
  5.6.2. Modifications to the command procedures .................111
5.7. File summary ..................................................................112
  5.7.1. VSO files .................................................................112
  5.7.2. INI files .................................................................112
  5.7.3. Text files for command procedure source code ...........112
  5.7.4. Text files for object creation and other purposes ..........113
5.8. Exporting and importing cross-references with Microsoft Excel .........................................................114
5.9. Converting cross-references from Microsoft Excel to COM 500 cross-references .................................118
5.9.1. Cross-Reference File Converter ........................................ 118
  5.9.1.1. Source File Parameters ........................................ 119
  5.9.1.2. Signal Identification Column Positions .................... 120
  5.9.1.3. Cross-Reference Identification Column Positions ........ 121
  5.9.1.4. Preview .......................................................... 122
  5.9.1.5. Destination Parameters ....................................... 122
  5.9.1.6. Conversion Example .......................................... 123

6. Appendix ......................................................................... 125
  6.1. Command procedure changes ....................................... 125

7. Index .............................................................................. 129
1. About this manual

1.1. Copyrights

The information in this document is subject to change without notice and should not be construed as a commitment by ABB Oy. ABB Oy assumes no responsibility for any errors that may appear in this document.

In no event shall ABB Oy be liable for direct, indirect, special, incidental or consequential damages of any nature or kind arising from the use of this document, nor shall ABB Oy be liable for incidental or consequential damages arising from use of any software or hardware described in this document.

This document and parts thereof must not be reproduced or copied without written permission from ABB Oy, and the contents thereof must not be imparted to a third party nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license and may be used, copied, or disclosed only in accordance with the terms of such license.

Copyright © 2004 ABB Oy
All rights reserved.

1.2. Trademarks

Registrations and trademarks used in this document include:

Windows: Registered trademark of Microsoft Corporation.

1.3. General

This manual provides thorough information on how to use the COM 500 product to make a MicroSCADA based communication gateway. This manual describes how to install, configure and engineer COM 500. Detailed descriptions are given to help the user to provide deeper knowledge about the functionality of COM 500.
This user’s guide is divided into following sections:

**Section 1 - Introduction**
This section provides general information about COM 500, its components and main functions.

**Section 2 - Safety information**
This section gives information about the prevention of hazards and taking backups from the system.

**Section 3 - Instructions**
This section gives an overview of COM 500. It also gives instructions for installation, configurations, engineering and upgrading the software.

**Section 3 - Technical description**
This section contains descriptions about the functionality, design and configuration of COM 500. Detailed description is given to help the user to understand the function of COM 500.

1.4. **Use of symbols**
This publication includes information and caution symbols where it is appropriate to point out safety related or other important information. It also points out useful hints for the reader. The corresponding symbols should be interpreted as follows:

- Caution icon indicates important information or warning related to the concept discussed in the text. It might indicate the presence of a hazard, which could result in corruption of software or damage to equipment/property.

- Information icon alerts the reader to pertinent facts and conditions.

1.5. **Document conventions**
The following conventions are used for the presentation of material:

- The words in names of screen elements (for example, the title in the title bar of a window, the label for a field of a dialog box) are initially capitalized.

- Capital letters are used for the name of a keyboard key if it is labeled on the keyboard. For example, press the CTRL key. The Enter is an exception, for example press Enter.

- Lowercase letters are used for the name of a keyboard key that is not labeled on the keyboard. For example, the space bar, comma key, Enter and so on.

- Press CTRL+C indicates that you must hold down the CTRL key while pressing the C key (to copy a selected object in this case).

- Press ESC E C indicates that you press and release each key in sequence (to copy a selected object in this case).

- The names of push and toggle buttons are boldfaced. For example, click **OK**.

- The names of menus and menu items are boldfaced. For example, the **File** menu.
User's Guide

- The following convention is used for menu operations: **Menu Name** > **Menu Item** > **Cascaded Menu Item**. For example: select **Edit** > **Clear** > **All**.
- The **Start** menu name always refers to the **Start** menu on the Windows Task Bar.
- System prompts/messages and user responses/input are shown in the Courier font. For example, you may be told to define the RP 570 slave protocol to line 1 of NET 1 and add a master station with number 8 into it, the example string is shown as follows in the procedure:
  
  ```
  #EXEC COM_RPSCR:C (@NET=1, @LINE=1, @STATIONS=VECTOR(8), @APPLIC=1)
  ```
- Variables are shown using lowercase letters:

  sequence name

### 1.6. Related documents

The following is a listing of documentation related to the COM 500.

<table>
<thead>
<tr>
<th>Name of the manual</th>
<th>MRS number</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Configuration manual</td>
<td>1MRS751846-MEN</td>
</tr>
<tr>
<td>System Objects manual</td>
<td>1MRS751847-MEN</td>
</tr>
<tr>
<td>Application Objects manual</td>
<td>1MRS751848-MEN</td>
</tr>
</tbody>
</table>

The following COM 500 related manuals provide more detailed information about communication protocols:

<table>
<thead>
<tr>
<th>Name of the manual</th>
<th>MRS number</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNP V3.00 Slave Protocol manual</td>
<td>1MRS751861-MEN</td>
</tr>
<tr>
<td>DNP V3.00 Master Protocol manual</td>
<td>1MRS751860-MEN</td>
</tr>
<tr>
<td>IEC 60870-5-101 Slave Protocol manual</td>
<td>1MRS751863-MEN</td>
</tr>
<tr>
<td>IEC 60870-5-101 Master Protocol manual</td>
<td>1MRS751862-MEN</td>
</tr>
<tr>
<td>IEC 60870-5-104 Slave Protocol manual</td>
<td>1MRS751965-MEN</td>
</tr>
<tr>
<td>IEC 60870-5-104 Master Protocol manual</td>
<td>1MRS751964-MEN</td>
</tr>
<tr>
<td>IEC 61850 Master Protocol (OPC) *1.0 manual</td>
<td>1MRS755321</td>
</tr>
<tr>
<td>Modbus Master Protocol</td>
<td>1MRS752242-MEN</td>
</tr>
<tr>
<td>Modbus Slave Protocol</td>
<td>1MRS751864</td>
</tr>
<tr>
<td>IEC 60870-5-103 Master Protocol manual</td>
<td>1MRS752012-MEN</td>
</tr>
<tr>
<td>OPC Data Access Client</td>
<td>1MRS752246-MEN</td>
</tr>
<tr>
<td>OPC Data Access Server</td>
<td>1MRS755213</td>
</tr>
</tbody>
</table>

### 1.7. Document revisions

<table>
<thead>
<tr>
<th>Version</th>
<th>Revision number</th>
<th>Date</th>
<th>History</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>4.0</td>
<td>15.03.2002</td>
<td>Document created</td>
</tr>
<tr>
<td>B</td>
<td>4.1</td>
<td>30.06.2004</td>
<td>Document updated</td>
</tr>
</tbody>
</table>
2. Introduction

2.1. About this section

This section provides general information about COM 500, its components and main functions.

2.2. COM 500 as communication gateway

COM 500 is an ABB software product. It is a communication gateway running on a MicroSCADA platform. The purpose of COM 500 is to provide a gateway between process devices and up to four upper level systems (NCC). The main tasks of COM 500 are signal re-routing and protocol conversions. The use of COM 500 as a gateway in a substation is illustrated in Fig. 2.-1.

Fig. 2.-1  COM 500 as communication gateway

COM 500 provides a variety of protocols for both the process communication and upper level communication. COM 500 functionality can be combined to a SYS 600 system server with a substation-level Human System Interface (HSI).

2.1. COM 500 engineering process

The engineering process of COM 500 contains the following steps:

1. Software installation
2. System configuration
3. Signal generation
4. Signal engineering

For further details about the engineering steps, refer to Chapter 3. Safety information.

**Signal engineering process**

Signal engineering in the COM 500 Signal engineering process contains the following steps:

1. Add the NCCs to the tool and define the information related to it, for example, the protocol to be used. Define also the alarm groups you want to use.
2. Check that all the indications and commands (that is input and output process objects) that are needed are shown in the tool. If they are not, add them.
3. Check that all the necessary attributes for indications and commands are correctly shown in the tool. If they are not, add the missing attributes or change their definitions.
4. Define to which NCCs COM 500 should send the indications. Connect the indications to alarm groups, if needed.
5. Configure the commands to be received from the NCCs.
6. Adjust the system and application parameters.
3. Safety information

3.1. About this section
This section gives information about the prevention of hazards and taking backups from the system.

3.2. Backup copies
We suggest that you take backup copies before making any changes, especially the ones that might have side effects. Software and data need to be copied to another place, usually to a CD or a backup tape. A writable CD and DAT tape are commonly used.

Backup copying facilitates the restoration of the application software in case of a disk crash or other severe failure when stored data is lost. It is therefore recommended that backup copies are taken regularly.

There should be at least two system backup copies and two application copies. A new backup is copied over the oldest backup. This way the latest version is available even if the backup procedure fails.

Detailed information on how to take backup copies should be delivered to the customer with the application.

System backup
Usually a system backup is taken after the application is made. It should be taken again when changes are made to the MicroSCADA system. For example, this is needed when the driver configuration or network setup is changed.

Application backup
Application backup is also taken at the same time with the system backup, after the application is made. It should be taken again when changes are made to the application. For example, if pictures or databases are edited or new pictures are added.
3.3. Fatal errors

A fatal error is an error that causes a break-down or a locked situation in the MicroSCADA program execution.

Handling

In case of a fatal error:

1. Write down the possible MicroSCADA error messages.
2. Shut down the MicroSCADA main program. If this cannot be done in the MicroSCADA Control Panel, try to end the task in the Task Manager of Windows 2000.

   Shutting down the base system computers by switching off the power might damage the files.

3. In Windows, the data kept in the main memory at the moment of a fatal error is placed into the drwtsn32.log file. It is placed into the system folder, for example Winnt. Analyse and copy the data in it.
4. Restart the system.

Report the program break-down together with the possible MicroSCADA error messages and the information from the drwtsn32.log file to the MicroSCADA supplier.

3.4. Status codes

Error messages in SCIL are called status codes. A list of status codes and short explanations can be found in the SYS 600 Status Codes manual.
4. Instructions

4.1. About this section

This section gives an overview of COM 500. It also gives instructions for installation, configurations, engineering and upgrading the software.

4.2. Overview of COM 500

COM 500 is a communication server, which provides communication gateway functions for mapping signals between the process devices and up to four upper level systems. The upper level system is here called the Network Control Center (NCC). It is the system to which COM 500 sends information for supervising and controlling the processes of the customers and from which COM 500 receives process control commands. COM 500 also handles system co-ordination tasks, such as dynamic assignments of control command authorities and communication supervision.

COM 500 supports a variety of protocols for connecting the process devices to upper level systems. It is typically connected to the network by some telecontrol protocols. For example, NCC using the RP 570 protocol can be connected to LON, SPA or IEC 60870-5-103 devices via COM 500 gateway.

RP 570 Process devices can be connected to it by using different protocols, such as SPA.

COM 500 is based on MicroSCADA technology, such as SYS 600. It can be integrated to the SYS 600 for cost savings in compact system solutions. It provides the user with an interface needed for signal engineering and communication diagnostics.

Function

The main task of COM 500 is to handle data transfer between the process devices and up to four network control centers. Data transfer usually involves protocol conversion. Other tasks, such as communication supervision and command authority checking are also involved.

Both the process devices and the network control system may be products of ABB or a third party. Certain documents, for example interoperability lists and device profiles, can be used for verifying the compatibility between COM 500 (IEC 60870-5-101) and other systems (DNP 3.0).

Example system

COM 500 runs on the MicroSCADA platform and can communicate both via PC-NET and the DCP-NET unit. Several communication frontends may be connected to increase the system performance. COM 500 can be used as a stand-alone gateway, in co-operation with SYS 600 or as a combined SYS-COM system, see Fig. 4.2.-1.
4.2.1. COM 500 application

The use of a COM 500 application depends on the type of the system. In case of a stand-alone gateway, the application is used merely for signal rerouting but in case of a combined SYS-COM, the application is also used for process control and management, and it acts both as a communication gateway and a Substation Controlling System (SCS).

The above is based on the layered structure of the MicroSCADA software, presented in Fig. 4.2.1.-1. The application layer can have different functions, which are independent of the lower layers.

From the communication point of view, the COM 500 application sees each process unit and NCC as a system object. Setting the attributes of the system objects can change the properties of the communication channels.
Communication between COM 500 and a NCC is based on the command procedures implemented in the SCIL programming language. These procedures send information from the COM 500 application to a NET unit for protocol conversion and transmission. Usually one command procedure is needed for each type of data. Data can also be transferred based on the application and system commands, such as general interrogation commands, and at special situations, for example at the application start-up and after communication disturbances. When the system is running, process events generally activate the command procedures via event channels.

Commands and setpoints from a NCC to a substation are brought into the COM 500 application via process objects. They activate the command procedures via event channels. Command procedures send the actual control commands to the process units. System and application commands are also received using the process objects. The content of the COM 500 command procedures is described in Chapter 5.

Technical description.

4.2.2. Functional environment

The functional environment of a COM 500 application can be described by using the environment model shown in Fig. 4.2.2.-1. The COM 500 Application communicates through the Base System and NET Unit. In addition to NCCs and COM 500 Application, the Base System can also communicate with a SCS Application at the same time.

![Environment model of COM 500](image)

4.2.3. Communication Programming Interface

COM 500 provides support for the Communication Programming Interface (CPI), which is an environment for protocol development that can be used for implementing new protocols to MicroSCADA. CPI is a collection of functions programmed in the C language for making communication software that converts between the MicroSCADA internal protocol and other protocols. CPI is available on request.
CPI based communication software can be used for process communication or for upper level communication. The CPI library contains functions to send and receive messages to or from COM 500. It also contains functions to pack and unpack data. The CPI based communication software and COM 500 communicate through the TCP/IP network. The program that uses the CPI interface in COM 500 must emulate an RTU profile, which has process objects of type RTU-200 process database interface. CPI is described in more detail in Chapter 5. Technical description.

4.3. Installation

4.3.1. Upgrading COM 500 revision 1.0...4.0 to 4.1

If you want to upgrade an existing COM application to COM 500 revision 4.1, please observe the following notes.

If the previous revision of COM 500 is 1.0...1.0C, you must prepare the application for both the Base Tools and COM 500 by using the Control MicroSCADA Application dialog box before starting MicroSCADA. When upgrading from revision 2.0 or later version, preparing is not needed.

COM 500 revision 4.1 has a mechanism that makes all the required modifications to the application to update an older revision to revision 4.1. This mechanism is started when a monitor is opened to a COM 500 application the first time after the installation of COM 500 4.1. After the mechanism has been run you must restart MicroSCADA to take all the modifications in use. The modifications are described in detail in Section 4.3.3. COM 500 start-up.

If any project specific modifications have been made to the command procedures of the previous COM 500 revision, the modifications must be copied to the matching new command procedures. The signal configuration, that is the contents of the cross-reference tables, does not need any changes. The content of the command procedures is described in Chapter 5. Technical description.

For changes needed in the configuration files, Section 4.4. System configuration for details.

4.3.2. Software installation

Installation procedure

1. Install the required software products as follows:
   • If the system is used solely as a stand-alone communication gateway, only COM 500 software needs to be installed.
   • If the system is used also as a substation control system with a local HSI, install also SYS 600.
   • If the application is built by using the LIB 5xx application libraries, install also LIB 500 and the other LIB 5xx products needed.
2. Prepare the application for Base Tools, LIB 500 (if needed) and COM 500 using the Control MicroSCADA Application dialog box. For more information on preparing the application, refer to the SYS 600 Installation and Commissioning manual.
4.3.3. COM 500 start-up

Actions at start-up

COM 500 automatically creates all the necessary application objects, such as event and time channels, command procedures and so on, when a monitor is opened to a COM 500 prepared application for the first time after the installation of COM 500 software.

COM 500 also creates the directory \sc\apl\<name>\com500 that is used for storing cross-reference files and parameter files.

Updating from revision 1.0…1.0 C

The application objects (event channels, command procedure and so on) of COM 500 revision 3.0 have been renamed not to follow the LIB 5xx conventions, as was the case in the older COM 500 revisions. The cross-reference pointer is also stored in a different attribute in revision 3.0.

COM 500 provides an automatic application update script that goes through the process database of a COM 500 application and does the following changes:

- The cross-reference pointer of a process object is moved from the FI attribute to the new TI attribute.
- The event channel name is changed from BNU_* to COM_*.
- The old COM 500 command procedures BNU_*:C are maintained, the new corresponding command procedures are named COM_*:C.
- The predefined command procedure APL_INIT_1:C is modified to execute the new COM 500 initialization procedure.

The cross-reference text files BNU_XR*.TXT are also renamed COM_*.TXT. Indication cross-reference data is moved to the free type process objects for permanent storage. The icons of COM 500 tools in Tool Manager are modified to point to /COM/ACTIVE/COM_.

Updating from revision 2.0, 3.0 and 4.0

The command procedures have changed from the previous releases. The modified command procedures are automatically updated in the application, and as a safety measure the existing command procedures COM_*:C in the application are copied to the name TMP_*:C. All the command procedures have a new header in revision 4.1, and therefore all the procedures are updated. Note that only the command procedures included in the list of Appendix are copied.

The Signal Cross-Reference Tool adds automatically the digital input and output process objects to the standard view definition. Indication cross-reference data is moved to the free type process objects for permanent storage. The icons of the COM 500 tools in Tool Manager are modified to point to /COM/ACTIVE/COM_.

19
4.3.4. Presentation order of pictures and dialogs

Depending on which software the COM 500 application is prepared for, the login dialog can be different. The following two cases can be found:

- When the application has been prepared for Base Tools and COM 500, the Stand-Alone COM 500 login dialog is shown when a monitor is opened to the application. After login, the Communication Diagnostics dialog is opened. Both the Tool Manager and the Signal Cross-Reference Tool can be accessed directly from this dialog.

- When the application has also been prepared for LIB 500, the LIB 500 login dialog is used. After login, the picture defined in the LIB 500 Application Settings dialog as the first picture is opened. The Signal Cross-Reference Tool and the Communication Diagnostics dialog can be opened from the Tool Manager after they have been added to it, refer to Section 4.6.1. Adding icon for Signal Cross-Reference Tool and Section 4.6.2. Adding icon for Communication Diagnostics dialog.

4.4. System configuration

Configuration files

In COM 500, the base system is configured in the SYS_BASCON.com file. COM 500 revisions 1.0...1.0C provided a specific base system configuration file SYS_COM500.com.

The SYS_BASCON.com and SYS_COM500.com files are ASCII files, which can be edited with a text editor, for example with Notepad in the Windows or with SCIL Program Editor.

Base system objects

Each base system has a set of objects that specify the base system and its environment, hardware and software, as well as the physical and logical connections of the base system and its applications.

Base system objects are defined with SCIL commands in the SYS_BASCON.com file, which is executed each time the base system is started. With a few limitations, you can also define and modify the base system objects any time when COM 500 is running. During the operation, the base system objects are in the primary memory of the base system computer.

Communication system objects

Each NET unit contains a set of system objects, which specify communication line properties, connected devices and so on. These objects can be created, modified and deleted by SCIL, and setting the attributes of the objects can change the properties. Each communication line is represented by one object, as well as each station created on a line.

In case of PC-NET, the process communication system objects can be defined by using the System Configuration Tool or by using SCIL statements.
In case of DCP-NET units, communication system objects are defined by using the so called preconfiguration. During the operation, the system objects are in the memory of the DCP board, which is the protocol hardware used.

4.4.1. Base system configuration

COM 500 base system

Basic configuration of the base system, for example the base system itself, nodes, links and MicroSCADA monitors, is defined in the SYS_BASCON.com file. The base system configuration is described in detail in the SYS 600 System Configuration manual.

Use of SYS_BASCON.com file

The new SYS_BASCON.com template provides all the necessary definitions for COM 500. If the new template is used, the characters -; must be removed from the beginning of the lines shown below in order to activate the definitions for a COM 500 application:

-; PQ = 15, ;Number of parallel queues
-; QD = (1,1,0,0,0,1,1,1,1,1,1,1,1,1,1,1,-) ;Parallel queue dedication

If the system has no older revision of COM 500 installed, the use of the old SYS_COM500.com requires adding the application definition (without -: in the beginning) to the lines shown above. The following station type definitions must also be added:

#CREATE STY22:B = LIST(NA = "SPI", DB = "STA", CX = "S.P.I.D.E.R/RP570")
#SET STY29:BCX = "IEC"
#SET STY30:BCX = "DNP"

The use of the System Configuration Tool included in the MicroSCADA 8.4.2 (or later) Base Tools requires the use of the SYS_BASCON.com file.

Use of SYS_COM500.com file

The definitions made in this file have been added to the SYS_BASCON.com template included in MicroSCADA 8.4.2 and therefore SYS_COM500.com is no more needed. However, if the 8.4.2 template or later is not used, the following corrections should be made to SYS_COM500.com:

#SET SYS:BRC = 0

should be changed to

#SET SYS:BRC = 2000

The following SCIL statement should be:

#SET STY29:BCT(3) = "UNKNOWN"

refer to Section 4.4.3. Configuration tips for more information.
4.4.2. Communication system configuration

Protocols

COM 500 supports several protocols. For example, protocols SPA, LonTalk and IEC 60870-5-101 master can be used for process communication and RP 570 slave and IEC 60870-5-101 slave protocols for upper level communication with Network Control Centers (NCC). Some protocols are implemented both in PC-NET and the DCP-NET unit, whereas new protocols are supported in PC-NET only. For more information on the protocols, refer to Chapter 5. Technical description.

The following chapters provide information for the configuration of the RP 570 slave, IEC 60870-5-101/104 slave, Modbus slave and DNP 3.0 slave lines and stations needed for communication with the upper level systems. Communication system configuration needed for a CPI application is described in the CPI Programming manual. If Modbus slave is used, the configuration is described in the Modbus Slave manual.

When the upper level communication is configured, it is very important to match the parameters (attributes) of the communication line and station to the parameters of the upper level system. The attributes of the communication line and station system objects are described in detail in the System Objects manual.

The communication system configuration needed for the process communication (master protocols) is similar to the one in SYS 600 and is described in the System Configuration manual.

DCP-NET unit

DCP-NET program contains a preconfiguration. It contains system objects and attributes that provide the default configuration. Each time the DCP-NET unit is loaded and started, the preconfiguration becomes valid.

The preconfiguration can be viewed, edited and documented off-line or on-line. Off-line operations are done with the NETCONF Tool, which runs in the DOS environment. During the operation the base system is configured using a preconfiguration tool.

The preconfiguration has the following limitations:

• A maximum of 20 process units can be preconfigured for a NET unit
• All attributes cannot be preconfigured

The IEC 60870-5-101 slave protocol or DNP 3.0 slave protocol are not supported in the DCP-NET unit.

The easiest way to configure the RP 570 slave line and station for a DCP-NET unit is to use the preconfiguration.
An example of the DCP-NET preconfiguration line attributes for the RP 570 slave protocol is shown Table 4.4.2-1.

Table 4.4.2-1  DCP-NET preconfiguration for the RP 570 slave protocol

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>PO</td>
<td>Protocol</td>
<td>16</td>
</tr>
<tr>
<td>IU</td>
<td>In Use</td>
<td>1</td>
</tr>
<tr>
<td>MS</td>
<td>Message Application</td>
<td>1</td>
</tr>
<tr>
<td>MI</td>
<td>Message Identification</td>
<td>0</td>
</tr>
<tr>
<td>LK</td>
<td>Link Type</td>
<td>0</td>
</tr>
<tr>
<td>BR</td>
<td>Baud Rate</td>
<td>9600</td>
</tr>
<tr>
<td>SB</td>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>PY</td>
<td>Parity</td>
<td>2</td>
</tr>
<tr>
<td>RD</td>
<td>Receiver Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>TD</td>
<td>Transmitter Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>OS</td>
<td>Output Synchronization</td>
<td>1</td>
</tr>
<tr>
<td>RE</td>
<td>Redundancy</td>
<td>2</td>
</tr>
<tr>
<td>TI</td>
<td>Timeout Length</td>
<td>3</td>
</tr>
<tr>
<td>NA</td>
<td>NAK Limit</td>
<td>3</td>
</tr>
<tr>
<td>EN</td>
<td>ENQ Limit</td>
<td>3</td>
</tr>
<tr>
<td>DE</td>
<td>CTS Delay Length</td>
<td>40</td>
</tr>
<tr>
<td>ER</td>
<td>Embedded Response</td>
<td>0</td>
</tr>
<tr>
<td>RP</td>
<td>Reply Poll Count</td>
<td>10</td>
</tr>
<tr>
<td>PD</td>
<td>Poll Delay</td>
<td>100</td>
</tr>
<tr>
<td>PS</td>
<td>Buffer Pool Size</td>
<td>20</td>
</tr>
<tr>
<td>PP</td>
<td>Polling Period</td>
<td>3</td>
</tr>
<tr>
<td>CN</td>
<td>Connection</td>
<td>Ignored</td>
</tr>
</tbody>
</table>

An example of the DCP-NET preconfiguration process unit attributes for the RP 570 slave protocol is shown in Table 4.4.2-2.

Table 4.4.2-2  DCP-NET preconfiguration for the RP 570 slave protocol

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Type</td>
<td>SPI</td>
<td></td>
</tr>
<tr>
<td>Physical Device Number</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>LI</td>
<td>Line Number</td>
<td>1</td>
</tr>
<tr>
<td>AL</td>
<td>Allocation</td>
<td>1</td>
</tr>
<tr>
<td>AS</td>
<td>Allocating Application</td>
<td>1</td>
</tr>
<tr>
<td>IU</td>
<td>In Use</td>
<td>1</td>
</tr>
<tr>
<td>MI</td>
<td>Message Identification</td>
<td>0</td>
</tr>
<tr>
<td>MS</td>
<td>Message Application</td>
<td>1</td>
</tr>
<tr>
<td>SA</td>
<td>Station Address (Decimal)</td>
<td>1</td>
</tr>
<tr>
<td>DE</td>
<td>Diagnostics Enabled</td>
<td>0</td>
</tr>
<tr>
<td>DI</td>
<td>Diagnostic Interval</td>
<td>0</td>
</tr>
<tr>
<td>FS</td>
<td>Fast Select during Suspension</td>
<td>0</td>
</tr>
<tr>
<td>RT</td>
<td>Reply Timeout</td>
<td>20</td>
</tr>
<tr>
<td>SP</td>
<td>Message Split</td>
<td>0</td>
</tr>
<tr>
<td>SU</td>
<td>Suspension Time</td>
<td>60</td>
</tr>
<tr>
<td>Name</td>
<td>Ignored</td>
<td></td>
</tr>
</tbody>
</table>
PC-NET

PC-NET can be configured either by using the System Configuration Tool or with SCIL. Using the System Configuration Tool is preferred when configuring COM 500. Detailed information about using the System Configuration Tool is provided in the System Configuration manual.

In some cases SCIL statements are used for configuration. COM 500 provides standard command procedures for creating communication lines and stations for the RP 570 slave, IEC 60870-5-101 slave and DNP 3.0 protocols. Command procedure COM_RPSCR contains communication line and station definitions for the RP 570 slave protocol. It needs to be executed every time PC-NET is restarted, for example, from the predefined command procedure APL_INIT_1:C.

As input the command procedure COM_RPSCR needs the NET number, line number, vector of stations and message application number.

The following command defines the RP 570 slave protocol to line 1 of NET 1 and adds a master station with number 8 into it:

```
#EXEC COM_RPSCR:C (@NET=1, @LINE=1, @STATIONS=VECTOR(8), @APPLIC=1)
```

Command procedure COM_101SCR defines the lines and stations for the IEC 60870-5-101 slave protocol. It also needs to be executed every time PC-NET is started. As input the command procedure needs the NET number, line number, communication mode (0 = balanced, 1 = unbalanced), vector of stations and message application number.

The following command defines a balanced IEC 60870-5-101 slave protocol to line 2 of NET 1 and adds a master station with number 9 into it:

```
#EXEC COM_101SCR:C (@NET=1, @LINE=2, @MODE=0, @STATIONS=VECTOR(9), @APPLIC=1)
```

The following command defines an IEC 60870-5-104 slave protocol to line 2 of NET 1 and adds a master station with number 9 into it:

```
#EXEC COM_104SCR:C (@NET=1, @LINE=2, @STATIONS=VECTOR(9), @ip_addr=VECTOR("host"), @APPLIC=1)
```

For a DNP 3.0 slave protocol the lines and the station can be created by using the command procedure COM_DNPSCR, which needs also to be executed every time PC-NET is started. As input this command procedure needs the NET number, line number, vector of stations and message application number.

The following command defines a DNP 3.0 slave protocol to line 3 of NET 1 and adds a master station with number 10 into it:

```
#EXEC COM_DNPSCR:C (@NET=1, @LINE=3, @MODE=0, @STATIONS=VECTOR(10), @APPLIC=1)
```

4.4.3. Configuration tips

IEC 60870-5-101/104 protocols

When configuring the IEC 60870-5-101/104 slave lines and stations it is very important to match the message field length attributes (IL, CL, PL and SL, see the System Configuration manual for details) to the corresponding parameters of the
master system. A mismatch with these attributes can lead to a situation where communication appears to be running properly, but the messages are incorrectly interpreted or not set to the process database at all.

The semantics of the cause of transmission is different in MicroSCADA and in IEC 60870-5-101/104. Therefore, if MicroSCADA is used as the IEC master, the following definition should be made to the station type:

```
#SET STY29:BCT(3) = "UNKNOWN"
```

If this definition is not made, spontaneous events (COT = 3) are not registered in the process database.

Application and system commands, as well as unrecognized messages sent from the NCCs are received in process objects and interpreted by the COM 500 command procedures. To ensure that these commands are received and executed properly, the following things should be checked:

- The MI attribute of each slave station should have its default value (29000 + station number).
- The CA attribute of each IEC 60870-5-101/104 slave station should have its default value (32000).
- The value of the PC (Process Data Confirmation) attribute of each IEC slave station should be set to 0 in order to ensure proper confirmation and termination of the IEC commands. System and Application commands are not confirmed automatically when the attribute is set to the automatic test mode.
- If COM 500 is not synchronized from the NCC, the value of the RM (Running Mode) attribute of the IEC slave station should be so that bit 1 of the value is set (RM = 2 if no other bits are set). Otherwise data is sent with an invalid time tag status to the master.
- By default, COM 500 waits for a secured command from the master. The select command must come before the execute command. If you want to use direct commands, the station attribute RM bit 4 must be set. Otherwise a negative acknowledgement is sent to the master.

**DNP V3.00 protocol**

Some requests and unknown messages sent from the NCC are received in process objects and interpreted by the COM 500 command procedures. To ensure that these messages are received and interpreted properly, the following things should be checked:

- The MI attribute of each slave station should have its default value (30 000 + station number).
- The CA attribute of each DNP 3.0 slave station should have its default value (32 000).
- By default, COM 500 sends data with dynamic variations. If the value changes in indication but not the status, a variation without status are sent. If the status changes, the status is also sent. If the station attribute RM bit 1 is set, the variations are fixed to same as in the master’s request.

When data is send as a double binary signal, two binary data objects with consecutive addresses are used for the two bits of the value.
4.5. Signal generation

The signals, that is process objects for COM 500, need to be generated. The signals can be generated by:

- Reusing an existing application or parts of an existing application
- Importing signals
- Building a COM 500 application

4.5.1. Reusing an existing application

Reusing an existing application is recommended especially when SYS 600 and COM 500 are used in parallel. After the SYS 600 application has been built, it (directory \sc\apl\<name>) can be copied as such to the COM 500 computer.

If only gateway functionality is required (no HSI, printouts and so on) it is enough to copy only the directory \sc\apl\<name>\apl_ that contains the necessary databases. If an existing COM 500 application is reused, for example in another substation, the directory \sc\apl\<name>\COM500 must also be copied.

After copying the application it must be prepared for COM 500 in the COM 500 computer. Make also the required changes in SYS_BASCON.com.

When reusing a complete application that has been prepared for LIB 500 you must do one of the following:

- Install LIB 500 to the COM 500 computer
- Rename the file \sc\apl\<name>\apl_\apl_lib.txt

4.5.2. Importing signals

Importing signals means that process objects are imported from another application by using load files and tools made for this purpose. Importing process objects can take place in the following ways:

- By using the MicroSCADA DB <--> text tool in both source and target (COM 500) applications
- By using the LIB 500 Database Import/Export Tool in both source and target applications
- By using the LIB 500 Database Import/Export Tool to import a load file generated by the SigTOOL software

When using the LIB 500 Database Import/Export Tool, the required scale objects must be created manually in the target application.

For more information on the Database Import/Export Tool, see the LIB 500 Operator’s Manual.
4.5.3. Building a COM 500 application

Building a COM 500 application (creating the process database) is similar as building a SYS 600 application: the actual gateway functionality is provided by the COM 500 software and the definitions made using the Signal Cross-Reference Tool in the signal engineering phase. A COM 500 application can be built in the following ways:

- Manually by creating process objects one by one.
- Using the LIB 5xx application library software.

Building a COM 500 application manually is quite troublesome and comes into question only in case the number of signals is very small. Process objects can be created by the Object Navigator of the Base Tools, using the Signal Cross-Reference Tool or by SCIL.

If process objects already exist in the database, cross-reference information can be imported, refer to Section 4.6.17. Importing and exporting cross-references.

In case of a combined SMS-COM system, we strongly recommend building the application by using the LIB 5xx application software. It is possible even if no HSI is required, since LIB 5xx provides an effective graphical engineering environment where the process database can be built fast and easily. LIB 5xx provides support for most types of process devices, and the LIB 5xx picture functions create the correct number of process objects with suitable attribute values.

In Stand-Alone COM 500 the application is built without LIB5xx software. This means using the MicroSCADA DB <--> text tool in both source and target (COM 500) applications or creating process objects manually one by one.

For building a COM 500 application using the LIB 5xx software the following software must be installed:

- LIB 500 application library base software.
- Any LIB 5xx software containing the needed functionality.

To create the application:

1. Create pictures for the application. These pictures consist of background and picture functions for controlling and supervising the process units. Use Picture Editor for creating the pictures. In addition to supporting the creation of a background, it provides tools for handling picture functions. If the COM 500 application is to be used only as a gateway (no HSI) the pictures can be created as drafts, that is picture editing should not be given much effort.

2. Install the necessary standard functions from the application libraries. The picture function is simply given an identification and placed into the picture.

3. Configure the picture function. Set the parameters of the picture function according to the configuration of the process unit and the application. Use the Standard Configuration Tool for this purpose. For more information related to these three first steps, refer to SYS 600 Picture Editing manual.

Each picture function creates all the application objects it requires. These application objects are usually created at the configuration phase. In addition to the Standard Configuration Tool, Process Object Definition Tool is used to define the process objects.
Application check list

The following issues must be noted when building and maintaining the COM 500 application.

- The Table Index (TI) attribute of the process objects has been reserved for COM 500 cross-reference purposes. Changing any TI value in the application may result in a severe malfunction.
- The Free Integer (FI) attribute of those output process objects included in a command in the Signal Cross-Reference Tool is used for database queries. This attribute should not be changed.
- COM 500 uses event channels named COM_* to activate command procedures. These must not be removed from the process objects. If any other event channel is to be attached to a process object, the corresponding command procedure (command procedure name = event channel name) must be attached as a secondary object of this event channel.
- Application objects with logical name COM_* or BNCC* are internal COM 500 objects, and must not be modified.
- A free type object with logical name COM_GENVAR is an internal COM 500 object, and must not be modified.
- APL:BSV elements 20... 29 are reserved for COM 500.
- Station local/remote switch must be in remote position to enable commands from any NCC.
- The names of the NCCs to perform commands must be in the Authorized Centers list of the Station Authority dialog, which is accessed via the Stations menu of a LIB 5xx station picture.

4.6. Signal engineering

Signals are divided into indications and commands, that is input and output process objects. Indications are sent from process units to COM 500 where they are rerouted to one or several NCCs. Usually there are single indications, double indications and measurements that need to be forwarded to the NCCs.

Commands are sent from the NCC to COM 500 where they are rerouted to process units. Secured commands, direct commands and setpoints are typical commands that are sent. The rerouting of indications and commands is presented in Fig. 4.6.-1.
Signal Engineering process

Signal Engineering means that COM 500 is told how to reroute the signals. This is done by using the Signal Cross-Reference Tool. Signal Engineering contains the following steps:

1. Add the NCCs to the tool and define the information related to it, for example the protocol that should be used. Define also the signals you want to use. This step is described in Section 4.6.5. Defining NCC properties and Section 4.6.7. Alarm groups.

2. Check that all the indications and commands that are needed are shown in the tool. If they are not, add them. This step is described in Section 4.6.12. Signal handling.

3. Check that all the necessary attributes for indications and commands are correctly shown in the tool. If they are not, add the missing attributes or change their definitions. This step is described in Section 4.6.9. Defining attributes for columns.

4. Define the NCC to which COM 500 should send the indications. Give the address and additional definitions for the signals. This step is described in Section 4.6.13. Defining indication cross-references.

5. Define the address to which COM 500 should send the command received from the NCC. When you want to receive a command in a specific form or you want to send a reply for a command to the NCC, define the Response Indication on the General column of the Commands tab. This step is described in Section 4.6.14. Initialization of event state signals.

Signal Engineering is done in the Signal Cross-Reference Tool, which are described in the following sections.
4.6.1. Adding icon for Signal Cross-Reference Tool

To add an icon for the Signal Cross-Reference Tool to the Tool Manager:
1. Select the System Configuration tab.
2. Select Insert Tool from the Edit menu.
3. Select Signal X-references from the list of tools. The Tool Properties dialog appears on the screen.
4. Click OK. The Signal Cross-Reference Tool is added to the Tool Manager.

4.6.2. Adding icon for Communication Diagnostics dialog

To add an icon for the Communication Diagnostics dialog to the Tool Manager:
1. Select the System Configuration tab.
2. Select Insert Tool from the Edit menu.
3. Select Signal COM 500 Diagnostics from the list of tools. The Tool Properties dialog is displayed on the screen.
4. Click OK. The Communication Diagnostics dialog is added to the Tool Manager.

4.6.3. Using Signal Cross-Reference Tool

The Signal Cross-Reference Tool is a tool that is used for mapping signals from the process devices to the NCCs (monitoring direction) and vice versa (controlling direction). The Signal Cross-Reference Tool can also be used for making NCC and alarm group definitions, as well as setting the system and application parameters.

If ComTool is already open in another monitor, Fig. 4.6.3.-1 is shown:

![ComTool](image)

**Fig. 4.6.3.-1 Caution dialog of ComTool**

The Signal Cross-Reference Tool is shown in Fig. 4.6.3.-2. It contains a menubar at the top with six menus, which are the Cross-Reference menu, Edit menu, Signal menu, View menu, Settings menu and Help menu.

Below the menubar there is a toolbar with twelve shortcut buttons, a drop-down menu for the views and a button named Define to access the View Definitions dialog. The Signal Cross-Reference Tool contains four notebook tabs, which are the Indications tab, Commands tab, NCCs tab and Parameters tab.
4.6.3.1.

**Menus**

The **Cross-Reference** menu is used for opening the Cross-Reference Import and Export dialogs, the Print and Page Setup, and Print dialogs. If you select Exit, the Signal Cross-Reference Tool is closed.

The **Edit** menu contains functions for cutting, copying and pasting text between the text boxes located in tabs and dialogs of the Signal Cross-Reference Tool. It is also used for opening the Find dialog that can be used for finding text strings from the signals and the cross-reference data.

By using the **Signal** menu, signals (process objects) can be added and edited. The scale of analog input process objects can be edited. The **Signal** menu is also used for opening the Column Attributes dialog, which is used for defining and ordering attributes to be shown on the Indications and Commands tabs.

You can use the **View** menu to change the view in the Signal Cross-Reference Tool. When you select a view name from the **View** menu, the signals are read from the process database both to the Indications and Commands tab. The **View** menu can also be used for opening the View Definitions dialog. The View Definitions dialog is used to define search conditions for signals displayed on the Indications and Commands tabs. The signals are searched from the process database.

The **Settings** menu is used for setting the toolbar visible and invisible and for choosing the select method to be used when editing signals or cross-reference information. The **Settings** menu contains an item for enabling and disabling the address overlap check of input signals. The **Settings** menu can also be used for opening the Auto Addressing dialog. By using the Auto Addressing dialog the address offsets for Indications and Commands can be defined. Refer to Section 4.6.10. Defining auto-address parameters for more details. It is also possible to enable or disable the displaying of internal process objects in ComTool. When the menu item Internal Process Objects as Indications is unselected (default), the
internal process objects with the logical name prefix BNCC* are hidden in the Indications tab and in the list of Response Indications. When this menu item is selected, the internal process objects for COM 500 can be seen.

![Fig. 4.6.3.1.-1 Settings menu](image)

The Help menu displays information concerning the Signal Cross-Reference Tool, such as identification, version number, revision and license information.

### 4.6.3.2. Toolbar

The toolbar of the Signal Cross-Reference Tool shown in Fig. 4.6.3.2.-1 contains twelve shortcut buttons for quick access of the different functions. From left to right the functionality of the buttons is: Exit, Cut, Copy, Paste, selection method Line, selection method Free, Delete, Add signal, Import, Export, Edit signal and Scale. The toolbar also provides a drop-down menu for selecting the view and a Define button to access the View Definitions dialog.

![Fig. 4.6.3.2.-1 Toolbar of Signal Cross-Reference Tool](image)

### 4.6.3.3. Tabs

#### Indications tab

The Indications tab is used for defining signal cross-references for indications, that is input process objects. By defining the address you can specify where the signal should be send to. However, you can also define the behaviour of the signals (refer to the NCC specific columns below).

By default, indication signals include columns for five attributes. The included attributes are:

- Object Identifier
- Object Text
- Logical Name
- Index
- Process Object Type
The tab has also NCC specific columns:

- Address
- Alarm group
- Signal handling
- Scale
- Signal class

Signal related definitions are displayed inside the indication signal definition area at the bottom of the Indications tab. The indication signal statistics area includes numeric information concerning signals of the application. For example, a number of indication signals, connected (cross-referenced) signals and the number of signals that are connected to a selected NCC are shown.

**Commands tab**

The Commands tab is used for defining signal cross-references for commands, that is output process objects. This tab includes columns for the same attributes as the Indication tab. The following information is entered for each command signal per NCC:

- Command type
- Purpose
- Command group
- Response indication
- Address
- Signal handling attributes

As the Indication tab, the Commands tab also includes statistics.

**NCCs tab**

The NCCs tab is used for adding or deleting NCCs or for defining properties of the NCCs. This tab contains a list of the NCC names. At the bottom of the tab there are buttons for adding and deleting NCCs. NCC specific information is displayed on the right side of the tab. Protocol, station number, name, comment text operation mode and group alarm information are displayed for the selected NCC.

Alarm groups are listed inside the alarm information area. You can modify the alarm groups by clicking the corresponding Add, Edit or Delete buttons on the tab, when a NCC is selected. Group alarms can be reset by using the Reset button.

**Parameters tab**

A separate tab for the common parameters is included in the Signal Cross-Reference Tool to enable defining the COM 500 system and application parameters. These common parameters include time-out parameters and authorization check parameters.

These attributes and their values are saved into a parameter file. The parameter file is taken as input both for the command procedures and the Signal Cross-Reference Tool, when they are started. Changing the attributes affects the functionality of the active system.
4.6.4. Opening and closing Signal Cross-Reference Tool

To open the Signal Cross-Reference Tool, double-click the Signal Cross-Reference Tool icon on the System Configuration tab of the Tool Manager. You can also click the icon and select File > Open. If there is no icon for the Signal Cross-Reference Tool, refer to Section 4.6.1. Adding icon for Signal Cross-Reference Tool to add an icon for the tool. The Signal Cross-Reference Tool can also be opened from the Engineering menu of the COM 500 Communication Diagnostics dialog.

To close the Signal Cross-Reference Tool, select Cross-Reference > Exit or double-click its closing box.

Properties

When you open or close the Signal Cross-Reference Tool, a Progress Indicator appears on the screen to display the progress of reading indication and command signals from the process database, see Fig. 4.6.4.-1. If the number of indication or command signals exceeds 10 000 according to the current view definition, a notification dialog box is shown on the screen, see Fig. 4.6.4.-2. In this case you should reduce the number of signals included in the current view definition.

4.6.5. Defining NCC properties

NCC properties are defined on the NCCs tab, see Fig. 4.6.5.-1. If you edit these fields, the alarm group names and the drop-down menus of the NCC names that are shown on the Indications and Commands tabs are also changed.
Fig. 4.6.5.-1  NCC tab of Signal Cross-Reference Tool

NCC definitions concern the upper level systems COM 500 is meant to be communicating with. COM 500 can be connected up to four NCCs. Before any alarm group or signal definitions can be made, NCC definitions should already exist.

4.6.5.1. Adding NCC

To add an NCC, click the Add button at the bottom of the NCCs tab. A new NCC is added to the NCC name list. The NCC name is generated according to the following convention:

name [number], where the name is NCC and the number is 1 to 4.

The name can be edited and its maximum length is 10 characters.
When a new NCC is added, the following dialog is shown in ComTool, see Fig. 4.6.5.1.-1. In this dialog the user is able to select the NCC type. The possible selections can be chosen from the list of protocols.

![Add NCC dialog for selecting protocol type](AddNCC_a)

**Fig. 4.6.5.1.-1 Add NCC dialog for selecting protocol type**

When the NCC type has been selected, ComTool locates the configured station numbers from the base system that match the appropriate station type. When a correct station number is selected in this dialog, the new NCC type are added into ComTool, see Fig. 4.6.5.1.-2.

When the Modbus NCC type is selected, ComTool locates the station types of RTU from the base system. Fig. 4.6.5.1.-2 shows the found station numbers of the RTU station type.

![Add NCC2 dialog for selecting station number](AddNCC2.tif)

**Fig. 4.6.5.1.-2 Add NCC2 dialog for selecting station number**

On the NCCs tab there is an option button for Modbus NCC type. After the NCC has been added to the list of protocols, the NCC tab shows the defined protocol of the NCC. The appropriate Protocol option is set (see Fig. 4.6.5.-1).
### 4.6.5.2. Deleting NCC

To delete an NCC:

1. Click the NCC name in the list.
2. Click **Delete**. A notification dialog appears on the screen.
3. Click **Yes** and the NCC disappears.

When an NCC is deleted, all the alarm group and signal definitions related to the NCC in question are also deleted.

![Information icon]

You can delete only the last NCC from the list.

---

### 4.6.5.3. Defining NCC properties

Each NCC should have the following properties defined:

- **Protocol**, either RP 570, IEC 60870-5-101/104, Modbus, DNP 3.0 or CPI. This is the communication protocol used for communication with the upper level system.
- **Station number**. This is the number of the STA:S object number representing the upper level system.
- **Name**, default name NCC ‘n’ (n=number) is given when a new NCC is added, see above. This name is also used as the command source name in the COM 500 command authority check mechanism.
- **Comment Text**. This is a free text with the maximum length of 30 characters.
- **Send Group Alarms at Start-up**. If this parameter is set, the value of the group alarm signal will be sent to the upper level system as a non-time-tagged binary message. This is applicable for IEC 60870-5-101/104. This parameter has no effect on spontaneous alarm signals which are generated in process devices after the communication establishment.
- **Function Table definitions**, refer to Section 4.6.6. Definition of Function Table download.
- **Communication Enabled**. As a default, the NCC communication is enabled. If explicitly required, the NCC communication can be disabled by unsetting the check box. Then data forwarding command procedures do not send data to the selected slave station object. This feature can be accessed by project specific engineering through free type object COM_GENV AR:IZ(5..8) where indexing is related to the used NCC number in configuration. For example, the third NCC in configuration uses COM_GENV AR:PIZ7.
- **Operation Mode**. This parameter is valid only for the DNP 3.0 protocol and it describes how messages are sent between the slave (COM 500) and the master (NCC). The descriptions of the operation modes are as follows (please refer to DNP V3.00 documentation for details):
  - **Quiescent Operation**. In this mode the master does not poll the slave, all the communication is based on unsolicited report-by-exception messages. The master can send application layer confirmations to the slave.
• **Unsolicited Report-by-Exception Operation.** The communication is basically unsolicited, but the master occasionally sends integrity polls for Class 0 data to verify that its database is up-to-date.

• **Polled Report-by-Exception Operation.** The master frequently polls for event data and occasionally for Class 0 data.

• **Static Report-by-Exception Operation.** The master polls only for Class 0 data or the specific data it requires.

To define the properties of an NCC:

1. Check either RP 570, IEC 60870-5-101/104, Modbus, CPI or DNP 3.0 Protocol check box to select the protocol the NCC uses.
2. Enter the Station number, Name and Description for the NCC.
3. Check the Send Group Alarms at Start-up check box if you want to use this feature.
4. In case of the DNP 3.0 protocol, select the Operation Mode.

### 4.6.6. Definition of Function Table download

In the NCC information panel you can define the Function Table download. Select the Function Table (FTAB) source, if you are using the RP 570 or CPI protocol for the NCC (see Fig. 4.6.6.0.-1).

![NCC Information panel](image)

In the File Location field you see which Function Table file has been chosen, and the path to it. In order to change the Function Table source, click the **Browse** button.

After clicking this button, a standard File Chooser opens. The default file extension is set to .hex (Function Table files).

If Function Table is downloaded from the NCC, the user can define the Function Table to be old when the NCC sends the FCOM_COLDSTART command. The definition can be done by checking the box next to Mark Function Tables old during FCOM_COLDSTART command below the File Location field. After this procedure, the NCC needs to download the Function Table to COM 500 again.
If a file, that is not a Function Table configuration file, is chosen in the File Chooser, the following dialog is displayed to the user.

![File Chooser](image)

**Fig. 4.6.6.-1**  File Chooser

If a file, that is not a Function Table configuration file, is chosen in the File Chooser, the following dialog is displayed to the user.

![Error dialog](image)

**Fig. 4.6.6.-2**  Error dialog when non-FTAB file has been chosen

### 4.6.7. Alarm groups

A group alarm collects several inputs into a single binary alarm signal, which is forwarded to the NCCs. For example, all alarms within one bay, or all the trip signals can be grouped to reduce the amount of signals sent to the NCCs. The group alarm can also be used to differentiate the alarms. For example, according to the priority of the alarm the signals can be divided into different groups.

The COM 500 group alarm works as follows:

- When the first of the connected signals gets into the alarming state, the group alarm is set, that is binary value 1 is sent to the alarm group address.
• As long as at least one of the connected signals is alarming, the group alarm remains set.
• When the last of the connected signals gets into the non-alarming state, the group alarm is reset, that is binary value 0 is sent to the alarm group address.

Each NCC can have up to 2000 alarm groups and 65535 signals can be connected to an alarm group. Note that it is possible to connect a signal to an alarm group without mapping the signal itself to a NCC, meaning that the value of the signal is not sent. For more information about alarm groups and their diagnostics, refer to Section 4.7.1.1. Alarm Group diagnostics.

4.6.7.1. Adding alarm groups

To add an alarm group:

1. Click **Add**. The Alarm Group Definitions dialog appears on the screen, see Fig. 4.6.7.1.-1 below.

![Alarm Group Definitions dialog](image)

2. Type the Alarm group name.
3. Enter the alarm group Address depending on the NCC protocol.
4. There is also an option to invert the alarm group state. By default, COM 500 uses value 0 for normal value, and value 1 for alarming value. When the box **Send as Inverse Value** is checked, value 1 becomes normal value and value 0 alarming value, when the alarm group state is sent to the NCC.
5. **Send as Pulse**

   If signals in an alarm group never get a non-alarming value from a device, the used alarm group may remain in the alarming state forever. If the alarm group value is defined to be sent as a pulse, every time an alarm occurs in a signal, it is immediately set with a non-alarming value in the alarm group. For example, if a disturbance recorder starts, the NCC gets the alarming and non-alarming event in a short time.

6. **Send with Long Time Tag**

   There is also an option to send the alarm group information to NCC of type IEC 101 by using Long Time Tag. As a default, the Long Time Tag is not selected.
7. Click **OK**.
8. A new alarm group is added to the alarm group list. If an alarm group already exists with the same address, a notification dialog box is displayed on the screen. Change the address of the new or the existing alarm group.

4.6.7.2. Editing alarm groups
To edit an alarm group:
1. Select an alarm group on the list.
2. Click **Edit** to open the Alarm Group Definitions dialog.
3. Change the definitions in the corresponding text fields.
4. Click **OK**.

4.6.7.3. Deleting alarm groups
To delete an alarm group:
1. Click an alarm group on the list to select it.
2. Click the **Delete** button. The notification dialog appears on the screen.
3. Click **Yes**. The alarm group disappears.

4.6.7.4. Resetting alarm groups
To reset an alarm group:
1. Click an alarm group on the list to select it.
2. Click the **Reset** button. The notification dialog appears on the screen.
3. Click **Yes**. The group alarm is reset.

   Resetting the group alarm does not reset the alarms of the signals connected to the group alarm.

4.6.8. Defining views
The query conditions of the signals included on the Indications and Commands tabs are modified in the View Definitions dialog.

**Opening the View Definitions dialog**
To open the View Definitions dialog select **View > Define**, see Fig. 4.6.8.-1. You can also click the **Define** button in the toolbar to access the View Definitions dialog.
View definitions

By default, a non-editable view called Standard is assigned with the Signal Cross-Reference Tool. To view the query conditions of the indication and command signals defined for a view, click the view name on the list. Figure 3.5.9-1 shows an example of a view called Eastwick and its conditions.

Adding view definitions

To add a new view definition, click Add. A new view name is added to the list based on the convention:

name [view number]

where the name is name for view and the view number is the number of the view in View Definitions.

By default the query conditions of the Standard view are copied to the new view. These conditions can be modified to suit the purposes of the new view.

Closing the View Definitions dialog

Click OK to close the View Definitions dialog. The validity of the new view condition is checked, and if it is invalid, a dialog will be shown. The names of the valid view definitions are added as separate menu items to the View menu.
4.6.9. Defining attributes for columns

You can modify the column attributes attached to the Indications and Commands tabs by using the Column Attributes dialog.

Opening the Column Attributes dialog

To open the Column Attributes dialog, select Signal > Column Attributes (see Fig. 4.6.9.-1 below).

![Column Attributes dialog](image)

By default, five columns are attached to the Indications and Commands tabs. These are:

- Object Identifier (OI)
- Object Text (OX)
- Logical Name (LN)
- Index (IX)
- Process Object Type (PT)

Order of attributes

To change the order of the attributes, select the attribute you want to relocate and then click the Up or Down buttons.

Closing the Column Attributes dialog

Click OK to close the dialog. If new attributes were added to the list, new columns have been added to the Indications and Commands tabs. These are located on the right side of the tab.

Defining attribute column widths

To define the attribute column widths on the Indications and Commands tabs, move the rulers. The width of the column is set, when you drop the ruler.
If you change the width of a column on the Indications tab, the corresponding column will also be changed on the Commands tab and vice versa.

4.6.9.1. Adding new attributes

To add a new attribute:
1. Click **Add**.
2. Select the attribute you want to add to the list from the Attribute drop-down menu.
3. Type a Title for the new attribute. If no title is specified for the new attribute, a two-char attribute name is used as the default title. The new attribute is added to the list.

4.6.9.2. Editing attributes

To edit an attribute in the Column Attributes dialog, select the attribute on the list. Then modify the attribute information either in the Attribute drop-down menu or in the title text field.

4.6.9.3. Deleting attributes

To delete an attribute from the Column Attributes dialog, select the attribute on the list and click **Delete**.

It is not possible to delete all the column attributes. At least one attribute must be defined.

4.6.10. Defining auto-address parameters

Auto-addressing parameters are used when cross-reference signals are copied and pasted in the Signal Cross-Reference Tool. The purpose of the auto-addressing mechanism is to define address offsets to avoid address overlaps when cross-reference data is copied and pasted. For example, if the cross-references of an indication connected to a RP 570 NCC are copied and the address of the signal is 002^001 while the RP 570 address offsets are 1 (block number) and 2 (bit number), the NCC address of the signal where the cross-reference is pasted will be 003^003.

For the different NCC protocols the auto-addressing parameters are as follows:
- For RP 570 and CPI block address 1…255 and bit address 0…15 for binary objects and block 1…2000 for analog objects
- For IEC 60870-5-101/104 IEC address 1…65535
- For DNP V3.00 index 1…65535
- For Modbus block address 1…125 and bit address 0…15 for binary objects and block 0…2000 for analog objects

IEC 60870-5-101/104 and DNP V3.00 addresses depend of the used IL (Information object address Length) station attribute value.

Auto-addressing parameters are defined using the Auto Addressing dialog shown in Fig. 4.6.10.-1.
4.6.10. Auto Addressing dialog

Opening the Auto Addressing dialog
To open the Auto Addressing dialog select Settings > Auto Addressing.

Defining auto-addressing parameters
To define the auto-addressing parameters, select the used NCC protocols and write the address offsets in the corresponding text fields.

Closing the Auto Addressing dialog
Click OK to close the dialog. The defined auto-addressing parameters will be used when cross-reference information is pasted in the Signal Cross-Reference Tool.

4.6.11. Indication address overlap check
By selecting the corresponding item in the Settings menu, the Indication Address Overlap Check can be taken in use. When it is in use, this function checks for address overlaps every time a new address is given, and if an overlap is detected, the user is notified with a dialog (see Fig. 4.6.11.-1). Unselecting the corresponding menu item can disable the address overlap check.
The notification dialog appears also in some other cases, for example if consecutive bit addresses for DB (Double binary indication) type objects are given, or if the same bit address is given for DB and BI (Binary input) type objects. This is because the DB and BI type objects are found in the same memory space in the RP 570, Modbus and CPI protocols.

Note that when the address overlap check is in use it may decrease the performance of the Signal Cross-Reference Tool, especially if the number of indication signals is significant.

4.6.12. Signal handling

It is possible to add, delete and edit signals, that is process objects, by using the Signal Cross-Reference Tool. The attributes of the existing process object can also be modified.

4.6.12.1. Adding signals

To add signals, the following steps should be taken:

1. Select New from the Signal menu. This opens the New Signal dialog shown in Fig. 4.6.12.1.-1.
2. Enter the logical name and index of the new signal. Click OK and the signal appears in the Signal Cross-Reference Tool.

For more detailed information about creating new process objects, refer to the Application Objects Engineering reference manual.

![New Signal dialog](NewSignal.png)

Fig. 4.6.12.1.-1 New Signal dialog

4.6.12.2. Editing signals

To edit the attributes of an existing signal the following steps should be taken:

1. Double-click the row of the signal to be edited. This opens the Process Object Definition Tool.
2. Edit the attributes. Click OK.

4.6.12.3. Deleting signals

In order to delete a signal take the following steps:

1. Change the Selection method to Line from the Settings menu.
2. Select the line of the signal to be deleted.
3. Select **Delete** from the Edit dialog or press CTRL+B. This opens a confirmation dialog box.

4. Click **OK** and the signal is deleted.

### 4.6.13. Defining indication cross-references

Cross-references for indication signals are defined on the Indications tab (see Fig. 4.6.13.-1.). Cross-referencing of indication signal means defining either the address or additional definitions. It is also possible to define the signal handling of a cross-referenced signal. When an address has been defined for the signal, the indication is sent to the NCCs. When an alarm group has been defined for the signal, the alarm group is activated. However, refer to the note below.

For each indication (input process object) the following properties should be defined:

- **NCC address**, that is the address in the upper level system where the signal is sent to. In RP 570, Modbus and CPI the address consists of a block number (1... 255 for RP 570 and CPI, 1... 125 for Modbus) and possibly a bit number (0... 15). In IEC 60870-5-101/104 and DNP V3.00 protocols the address is an integer (IEC address) the range of which is determined by the Information Address Length (IL) attribute of the corresponding station. The address can be omitted if the signal is only connected to a group alarm and the value itself is not sent.

- **Alarm group information**, that is the alarm group to which the signal is connected. This information can be omitted if the signal is not sent to any alarm group. Note that the alarm group is presented as a number in the Signal Cross-Reference Tool.

- **Signal handling attributes**. These attributes define how the signal is handled before it is sent to the NCCs, for example a double binary signal can be sent as a single indication. Note that the alarm group is presented as a number (a bitmask of the numbers of the selected signal handling attributes) in the Signal Cross-Reference Tool.

- **Signal class**. For signals connected to IEC 60870-5-101/104 or DNP, you can select the signal class that it used when the signal is sent to the NCC.

- **Scale algorithm**. For each analog signal you can also select the scale algorithm that is used when the signal is sent to the NCC. If no signal is selected, the signal will be scaled with algorithm 1:1.

- **Group interrogation for IEC 60870-5-101/104**. Interrogation group number (integer 1...16) is added to Free Integer (FI) attribute of the cross-reference process object. By default, value of FI attribute is 0. Signal specific group number is defined to ComTool as follows (See Fig. 4.6.13.-2). Add a FI attribute into ComTool from Column Attribute dialog. Rename the column title from FI - Free Integer to Group Nr.
**Indications tab of Signal Cross-Reference Tool**

Fig. 4.6.13.-1

<table>
<thead>
<tr>
<th>NCC 1 [IEC101]</th>
<th>NCC 2 [IEC101]</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>TEST1</strong> Bay local/remote-switch</td>
<td>SIB1</td>
</tr>
<tr>
<td><strong>TEST1</strong> Bay local/remote-switch</td>
<td>SIB11</td>
</tr>
<tr>
<td><strong>TEST1</strong> Breaker position indication</td>
<td>SIB11B1</td>
</tr>
<tr>
<td><strong>TEST1</strong> Disconnect position indication</td>
<td>SIB11D1</td>
</tr>
<tr>
<td><strong>TEST1</strong> Disconnect device control block</td>
<td>SIB11D1</td>
</tr>
<tr>
<td><strong>ss</strong></td>
<td>Truck position indication</td>
</tr>
<tr>
<td><strong>ss</strong></td>
<td>Disconnect position indication</td>
</tr>
<tr>
<td><strong>TEST1</strong> Earth sw. position indication</td>
<td>SIB11E1</td>
</tr>
<tr>
<td><strong>ss</strong></td>
<td>Earth sw. position indication</td>
</tr>
<tr>
<td><strong>TEST1</strong> Current L1</td>
<td>SIB11M1</td>
</tr>
<tr>
<td><strong>TEST1</strong> Current L2</td>
<td>SIB11M1</td>
</tr>
<tr>
<td><strong>TEST1</strong> Current L3</td>
<td>SIB11M1</td>
</tr>
<tr>
<td><strong>TEST1</strong> Neutral current L0</td>
<td>SIB11M1</td>
</tr>
<tr>
<td><strong>TEST1</strong> Blocking or control</td>
<td>SIB11M1</td>
</tr>
<tr>
<td><strong>TEST1</strong> Current in phase L1 In</td>
<td>SIB11M1</td>
</tr>
<tr>
<td><strong>TEST1</strong> Current in phase L2 In</td>
<td>SIB11M1</td>
</tr>
<tr>
<td><strong>TEST1</strong> Current in phase L3 In</td>
<td>SIB11M1</td>
</tr>
<tr>
<td><strong>TEST1</strong> Active Power</td>
<td>SIB11M1</td>
</tr>
<tr>
<td><strong>TEST1</strong> Reactive Power</td>
<td>SIB11M1</td>
</tr>
<tr>
<td><strong>TEST1</strong> Current in phase L1 A</td>
<td>SIB11M1</td>
</tr>
<tr>
<td><strong>TEST1</strong> Current in phase L2 A</td>
<td>SIB11M1</td>
</tr>
<tr>
<td><strong>TEST1</strong> Current in phase L3 A</td>
<td>SIB11M1</td>
</tr>
<tr>
<td><strong>TEST1</strong> Breaker position indication</td>
<td>SIB181</td>
</tr>
<tr>
<td><strong>TEST1</strong> Breaker open interlocked</td>
<td>SIB181</td>
</tr>
<tr>
<td><strong>TEST1</strong> Breaker close interlocked</td>
<td>SIB181</td>
</tr>
</tbody>
</table>

**Indication Definitions:**

- **NCC name:** NCC.1
- **Alarm group:**
- **Signal handling:** 2 - Send with Time Tag

---

**User’s Guide**

MicroSCADA Pro

COM 500 *4.1

1MRS751858-MEN
To add a cross-reference for the indication signal:

1. Click the correct signal row in the indication signals list.
2. Select a NCC by clicking a field below the NCC column. Note that if the data type of the selected signal is not supported by the protocol of the NCC, a message will be shown on the status bar and the selections described below are disabled.
3. Select an alarm group by clicking the button on the right-hand side of the alarm group field. The Alarm Groups dialog appears on the screen. The alternatives include the alarm groups that have been added to the NCC in the NCCs tab. Select one alarm group from the list.
4. Define the address based on the block and bit number for RP 570 protocol, Modbus or CPI, IEC address for IEC 60870-5-101/104 protocol and index for DNP 3.0 protocol.
5. In case of an analog input signal define a scale. It is possible to select a different scale for each signal and for each NCC.
6. Click the button on the right side of the signal-handling field and the Signal Handling Attributes dialog appears on the screen (see Fig. 4.6.13.1.-1.). Select one or several signal handling attributes from the list of attributes. To select several attributes, hold the CTRL key down while clicking the attributes.

7. Define the signal specific class. For the IEC 60870-5-101 protocol the signal classes are 1 or 2. If the class has not been defined, it is 1.

For the DNP protocol the signal classes are 0, 1, 2 or 3. The default class is 1 for binary inputs and double binary indications. By default, class 2 is applied for other signal types.

8. Click OK. The cross-reference of the indication signal is ready. It is displayed under the cross-referenced NCC name.

Indication signal types and the corresponding signal handling attribute values are listed in Table 4.6.13.1-1. When the signal handling attribute Project Specific is selected, a specific block in the corresponding command procedure is executed to enable the project specific modifications. Refer to Chapter 5. Technical description for more details.

**Table 4.6.13.1-1 signal handling attributes related to different data types**

<table>
<thead>
<tr>
<th>Data type</th>
<th>RP 570 / CPI / Modbus</th>
<th>IEC 60870-5-101 / 104</th>
<th>DNP V3.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary input</td>
<td>Project Specific</td>
<td>Project Specific</td>
<td>Project Specific</td>
</tr>
<tr>
<td></td>
<td>Send with Time Tag</td>
<td>Send with Time Tag</td>
<td>Send as Inverse Value</td>
</tr>
<tr>
<td></td>
<td>Send as Inverse Value</td>
<td>Send as Inverse Value</td>
<td>Send as Double Binary</td>
</tr>
<tr>
<td></td>
<td>Send as Double Binary</td>
<td>Send with and without Time Tag</td>
<td>Send Change with Time</td>
</tr>
<tr>
<td></td>
<td>None</td>
<td>Send with Long Time Tag</td>
<td>Send Change with Relative Time</td>
</tr>
<tr>
<td>Double binary</td>
<td>Project Specific</td>
<td>Project Specific</td>
<td>Project Specific</td>
</tr>
<tr>
<td></td>
<td>Send with Time Tag</td>
<td>Send with Time Tag</td>
<td>Send as Inverse Value</td>
</tr>
<tr>
<td></td>
<td>Send as Inverse Value</td>
<td>Send as Inverse Value</td>
<td>Send as Single Indication</td>
</tr>
<tr>
<td></td>
<td>Send as Single Indication</td>
<td>Send with and without Time Tag</td>
<td>Send Change with Time</td>
</tr>
<tr>
<td></td>
<td>None</td>
<td>Send with Long Time Tag</td>
<td>Send Change with Relative Time</td>
</tr>
<tr>
<td>Digital input</td>
<td>Project Specific</td>
<td>Project Specific</td>
<td>Project Specific</td>
</tr>
<tr>
<td></td>
<td>Send with Time Tag</td>
<td>Send with Time Tag</td>
<td>Send as Inverse Value</td>
</tr>
<tr>
<td></td>
<td>Send as Analog Value</td>
<td>Send as Analog Value</td>
<td>Send as Single Indication</td>
</tr>
<tr>
<td></td>
<td>None</td>
<td>Send with and without Time Tag</td>
<td>Send Change with Time</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Send with Long Time Tag</td>
<td>Send Change with Relative Time</td>
</tr>
</tbody>
</table>
The Modbus protocol does not have time tagged events. It does not either separate analog and digital inputs. They are both set to 16 or 32 bits registers.

IEC 60870-5-104 signal handling attributes differ from IEC 60870-5-101 only by the usage of time stamp types. By standard, it is not possible to use the IEC 101 style short time stamps in IEC 104. These are however still possible to use in COM 500. By default, IEC 104 uses long time stamps with date.

The Modbus protocol does not have time tagged events. It does not either separate analog and digital inputs. They are both set to 16 or 32 bits registers.

<table>
<thead>
<tr>
<th>Data type</th>
<th>RP 570 / CPI / Modbus</th>
<th>IEC 60870-5-101 / 104</th>
<th>DNP V3.00</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Analog input</strong></td>
<td>Project Specific</td>
<td>Project Specific</td>
<td>Project Specific</td>
</tr>
<tr>
<td></td>
<td>Send with Time Tag</td>
<td>Send with Time Tag</td>
<td>Send as 16-bit Value</td>
</tr>
<tr>
<td></td>
<td>None</td>
<td>Send as Floating Point Value</td>
<td>Send without Flag</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Send with and without Time Tag</td>
<td>Send Change Event</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Send as Scaled Value</td>
<td>Send with Time</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Send with Long Time Tag</td>
<td>Send Always as Event</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Send as Binary Input</td>
<td>Send Change Event</td>
</tr>
<tr>
<td><strong>Pulse counter</strong></td>
<td>Project Specific</td>
<td>Project Specific</td>
<td>Project Specific</td>
</tr>
<tr>
<td></td>
<td>None</td>
<td>Send with Time Tag</td>
<td>Send as 32-bit value</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Send with and without Time Tag</td>
<td>Send Delta Counter</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Send with Long Time Tag</td>
<td>Send without Flag</td>
</tr>
<tr>
<td></td>
<td></td>
<td>None</td>
<td>Send change Event</td>
</tr>
</tbody>
</table>

IEC 60870-5-104 signal handling attributes differ from IEC 60870-5-101 only by the usage of time stamp types. By standard, it is not possible to use the IEC 101 style short time stamps in IEC 104. These are however still possible to use in COM 500. By default, IEC 104 uses long time stamps with date.

The Modbus protocol does not have time tagged events. It does not either separate analog and digital inputs. They are both set to 16 or 32 bits registers.

I

Fig. 4.6.13.1.-1 SSignal Handling Attribute dialog

In order to select a scale for an analog input signal, click the Scale column of the selected NCC to change the Signal Handling field into the Scale field. Click the button on the right side of this field to open the Scale dialog shown in Fig. 4.6.13.1.-2. Select a scale from the list and click **OK**. Note that the name of the scale cannot be longer than ten characters.
You can edit the attributes of a selected scale object by selecting Scale from the Signal menu, when a cell containing a scale name is selected. This opens the Scale Object Tool dialog shown in Fig. 4.6.13.1.-3. The scaling of analog signals in COM 500 is described more in detail in Chapter 5. Technical description.

**RTU specific configuration**

When adding cross-references for the RTU type signals, the following LIB convention should be checked:

- With binary data: low index is used for storing data which is received from block sending. High index is used for storing event data and its time tag. In COM 500 high index (low index + 100) is used for cross-referencing process data to the NCC.
- In the start-up, the event recording object is in Not Sampled Status and low index is used for data source. It is updated always in start-up procedures, and COM 500 can use it if high index is not updated.

- Other type of data (analog input, pulse counter) is cross-referenced from its low index. Analog Inputs: high index is used for alarm/warning data.

- If data is to be attached to an alarm group, it is taken from the low index

**Cutting, copying and pasting cross-references**

Cross-reference data can be cut, copied and pasted from one signal to another, or from a group of signals to another by taking the following steps:

1. Set the **Selecting method** as **Free** from the Settings menu or the toolbar.

2. Mark the cross-reference data to be cut/copied and pasted with mouse on the Indication tab.

3. Cut or copy the cross-reference data by selecting **Cut** or **Copy** from the Edit menu or by using the corresponding shortcut button of the toolbar.

4. Click the field in the upper left corner of the area where the cross-reference data is to be pasted.

Paste the cross-reference data by selecting **Edit > Paste** or by using the corresponding button.

**4.6.13.2. Deleting cross-references**

To delete cross-reference from the signal:

1. Click an indication signal row.

2. Select a NCC by clicking the table below the appropriate NCC.

3. Clear the **Address** and the Signal class fields. If a signal handling attribute or scale is used, set them to None.

4. If the alarm group has been defined for the indication signal, select None from the **Alarm group** drop-down menu.

5. The cross-reference is deleted between the indication signal and the corresponding NCC.

Cross-reference information can also be deleted using the delete function as follows:

1. Set the **Selecting method** as **Free** from the Settings menu or the toolbar.

2. Mark the cross-reference data to be deleted with mouse on the Indication tab.

3. Delete the cross-reference data by selecting **Edit > Delete** or by using the corresponding button.

**4.6.14. Initialization of event state signals**

The initial state from the event state signals is not received during the communication start-up, for example trip signals. The state is received only when an event occurs in the system. That may be inside 1 minute, or 5 years after the communication start-up. These process objects will be seen as erroneous until the first event occurs. Additional configuration is required to assign the default value into those process objects, which have been cross-referenced in COM 500 to be further sent to the NCC. With this method the indication signals that have been
collected into the Trip Signals list in the Signal Cross-References Tool get a default object value and a valid object status (OK_STATUS). All possible data types are supported. With measurements the used value is 0 and with indications the default value is a non-alarming value (the setting of non-alarming values is based on information in Alarm Generation [AG] and Alarm Activation [LA] process object attributes).

How to add indication signals to the Trip Signals list:

1. Select one signal in the Indications tab. Click the right mouse button and a shortcut menu appears on the screen. Select Add to Trip Signals, see Fig. 4.6.14.-1.

2. You can also do the same procedure in another way. Select one signal in the Indications tab. After this, select Signal from the menubar. Finally, select Add to Trip Signals, see Fig. 4.6.14.-2.

How to remove indication signals from the Trip Signals list:

1. Select one signal in the Indications tab. Click the right mouse button and a shortcut menu appears on the screen. Select Remove from Trip Signals, see also Fig. 4.6.14.-1.

2. This can also be done in another way: Select one signal in the Indications tab. After this, select Signal from the menubar. Finally, select Remove from Trip Signals, see also Fig. 4.6.14.-2.
How to view the indication signals included into Trip Signals list:

- Select Signal > Trip Signals.

As a result, you will see a new dialog, see Fig. 4.6.14.-3. This dialog shows all the existing signals. It is also possible to add new trip signals into the list by using the Add button. If you want to clear some of the existing signals from the list, select one signal and click the Remove button.

![Trip Signals list](image)

*Fig. 4.6.14.-3  Trip Signals list*

When the Add button is used for adding new trip signals, Fig. 4.6.14.-4 appears on the screen:

![Add Trip Signal](image)

*Fig. 4.6.14.-4  Add Trip Signals dialog*
This dialog shows the List of Indications. You can add a new trip signal into the list by selecting the indication signal and clicking **OK**.

In the Trip Signals dialog, there are selections for the behaviour of trip signals in the following situations:

- **Send during General Interrogation.** It is possible to define whether COM 500 sends trip signals during the general interrogation command from the NCC or not. As a default, trip signals are sent.

- **Send when Station Suspended.** It is also possible to define that COM 500 sends trip signals when the station goes to suspended state. The trip signals are sent as a default.

### 4.6.15. Defining command cross-references

Cross-references for commands (output process objects) are defined on the Command tab of the Signal Cross-Reference Tool (see Fig. 4.6.15.-1).

Devices connected to MicroSCADA, which communicate with different protocols, are controlled through different command philosophies on the application level. This means that in addition to being a protocol converter, COM 500 has to be able to make conversions between different methods of command handling. For this purpose the following parameters must be given for each command in the Signal Cross-Reference Tool:

1. **Type**, specifies the control philosophy of the application level
   - For binary output, analog output and digital output process objects:
     - Direct command. Note that the object commands of IEC 60870-5-103 devices must be made using this command type.
   - For binary output process objects:
     - Secured command with two output objects (for example REF 542, tap changer raise/ lower commands).
     - Secured command with four output objects (for example SPACOM devices, REF 543).
     - Secured command with one output object (for example IEC 60870-5-101 devices, RTU 200).
   - For analog output process objects:
     - Secured command with one output object (for example REC 561 devices). This can be received in binary, double binary or analog format depending on the used signal handling attribute and NCC protocol.

2. **Purpose**, specifies the function of an individual signal (output process object). The values displayed in the HSI depend on the Type and are as follows:
   - Open command (secured command/2 output objects)
   - Close command (secured command/2 output objects)
   - Open select (secured command/4 output objects)
   - Close select (secured command/4 output objects)
   - Execute (secured command/4 output objects)
3. **Command group**, specifies the group controlled objects (for example breaker and truck) with output process objects sharing the same logical name, the output objects of the different object should be given different command group numbers. Value: 1 to 5.

For each command signal (output process object) the following properties should be defined:

General, signal-related information (common for all NCCs):

- Command type, that is how the command is presented in the COM 500 process database
- Purpose of the signal
- Number of the command group
- Response indication. This is the input process object that is updated as the result of the command, for example the position indication object of a breaker is the response indication of the breaker (open/close) command. This information ensures that the IEC 60870-5-101/104 messages are sent in the correct order to the NCC when commands are received from the NCC. When response indication is received from the process device, COM 500 sends a command termination to an IEC 60870-5-101/104 NCC. If a command goes to timeout or COM 500 cannot operate the device, then a negative command termination is sent to the NCC. If IEC 60870-5-101/104 protocol is not used to connect any of the NCCs, this information can be omitted.

Response indication cannot be defined for the direct type of commands; it is allowed only for the secured type of commands. Also pasting of response indication ignores the operation. In this case the text Pasted response indication is not allowed for Direct Commands is displayed on the statusbar of ComTool.

NCC related information:

- Signal handling attributes. These attributes define how the signal is handled before it is sent to the process devices, for example an object command can be received as an inverse value. Note that the alarm group is presented as a number (a bit mask of the numbers of the selected signal handling attributes) in the Signal Cross-Reference Tool.

The signal handling attribute Receive as Double Command (bit 2) is used only for IEC-101/104. The signal handling attribute Send as Inverse Value (bit 1, used for all protocols) can be specified for analog outputs in the ComTool.
4.6.15.1. Adding cross-references

To add a cross-reference for a command signal:

1. Click a row in the command signals list.
2. Select the General column by clicking the same command signal row under General column.
3. Select a command type from Type drop-down menu.
4. Select a signal purpose from the Purpose drop-down menu. If the alarm group has been defined for the Indication signal, select None in the alarm groups dialog.
5. Select the Command Group number from the drop-down menu. When the command type is set to direct or Secured / 1 output object, the command group of the cross-referenced signal is automatically set to 1. Note that if you want to change the command group number, you must first set the command type to None and then back.
6. Click the button next to the Indication field and the Indications dialog will be opened (see Fig. 4.6.15.1.-1).
7. Select the correct indication from the list and click **OK**. The selected return indication appears in the indication field.

8. Enter the Address to the command field. Note that if there are several objects constituting one command (for example type secured/4 output objects), the same address will be copied to all the signals of the command. Note also that if the data type of the selected signal is not supported by the protocol of the NCC, a message will be shown on the statusbar, and entering the address is inhibited.

9. Select the Signal Handling Attributes using the Signal Handling Attributes dialog. Note that if there are several objects constituting one command (for example type secured/4 output objects), the same address will be copied to all the signals of the command. The available signal handling attributes are presented in Table 4.6.15.1-1.

**Table 4.6.15.1-1 Command signal handling attributes**

<table>
<thead>
<tr>
<th>Data type</th>
<th>RP 570/CPI/Modbus</th>
<th>IEC 60870-5-101/104</th>
<th>DNP V3.00</th>
</tr>
</thead>
</table>
| Binary output | Project Specific Inverse Value  
Receive as Regulation Command None | Project Specific Inverse Value  
Receive as Double Command None | Project Specific Inverse Value  
Report Status to Master None |
| Analog output | Project Specific None | Project Specific None | Project Specific Report Status to Master None |
| Digital output | Project Specific None | Project Specific None | |

An example of a cross-referenced command consisting of four signals (secured/4 output objects) is presented in Fig. 4.6.15.1.-2. This example is for a breaker open/close command of a REF 543 unit.
Another example in Fig. 4.6.15.1.-3 shows how a secured command with two output objects is defined for raise/lower command of a SPACOM tap changer.

Cutting, copying and pasting cross-references

The delete, cut, copy and paste functions for commands are as for indications except for the fact that only one command can be cut or deleted at a time.

4.6.15.2. Deleting cross-references

To delete all the cross-references from a command signal:

- If you select None from the Type drop-down menu, then all the related command cross-references will be deleted. The General column will also be cleared.
- If a command signal cross-reference is secured/2 output objects or secured/4 output objects, the Address, Signal handling and Type definitions will be removed from the cross-referenced indices, which are in the same command group.

To delete a cross-reference from a command signal:

1. Click a command signal in the command signals list.
2. First select a NCC column, which includes a cross-reference to this signal. Do this by clicking the row under that NCC column.
3. Clear the Address field. If a signal handling attribute has been defined, select None from the Signal Handling Attributes dialog.
   
   If there are multiple command signals in the same command group, their addresses and signal handling attributes will be deleted automatically.
4. Repeat the address and possible signal handling attribute for removing all the NCC columns, which have been connected for the selected signal.
5. The command signal cross-reference is deleted, and the General column is cleared.

IEC 60870-5-101/104 regulating step commands are handled as doublecommands in COM 500.
4.6.16. Defining parameters

Parameters are defined and viewed on the Parameters tab shown in Fig. 4.6.16.-1. It enables the defining of the COM 500 configuration. These common parameters include the following information:

- Time-out parameters
- Authorization checking parameters
- Miscellaneous parameters

These attributes and their values are saved into a parameter file or a free type object. The parameter file is taken as input both for the command procedures and the Signal Cross-Reference Tool, when they are started.

The following parameters can be edited in the Signal Cross-Reference Tool:

**Timeout Information:**

- **NET Initialization Start Delay.** Time (seconds) after which the initialization of the protocol converters in NET is started. This parameter should be set to be the time from MicroSCADA start-up to the moment when all the NET lines and stations have been created. The default value is 60 s.
- **Database Initialization Time.** Time (seconds) in which the COM 500 database is considered as initialized, that is all the input process objects connected to the process devices have been updated. After this time COM 500 sends a Database Initialized message to the NCCs and accepts NCC specific commands from the NCCs. This parameter should be measured using the actual system with all the devices connected. The default value is 120 s.
• **REx Select Execute Delay.** This parameter defines the delay (in milliseconds) between the consecutive select and the execute commands sent to a REx device. The default value is 200 ms.

• **STA Object Status Check Timeout.** Timeout (in seconds) used when checking the state of a station reported as SUSPENDED. The default value is 5000 ms.

• **Response Indication Timeout.** Time (in seconds) after which the command connected to a response indication is terminated. This is the time waited for an indication connected to a command to be updated, before a negative command termination is sent to the IEC 60870-5-101/104 NCC that sent the command. The default value is 60 s.

• **CPI Selection Reset Time.** Time (seconds) after which the internal selection of a CPI command is reset. The default value is 60 s.

Authorization Information:

• **Command Source Check In Use.** This parameter states whether the LIB 500 command source check is in use. When this parameter is set on, the name of the NCC (for example NCC 1) must be on the list of authorized command centers of the application. This list is edited using the Command Authority dialog that can be opened from the LIB 500 Stations menu. If the COM 500 application is not built using LIB 5xx or no HSI (station pictures) is used, this parameter must be set. The default value is TRUE. When a stand-alone version of COM 500 is being used, this selection is dimmed, that is not in use.

• **Station L/R Check In Use.** This parameter states whether the Station Local/Remote switch check is in use. When this parameter is set on, the COM 500 command procedures check that the value of the Station Local/Remote switch process object has the value corresponding to remote position of the switch. The default value is TRUE.

• **Station L/R Object Logical Name.** Logical name of the Station Local/Remote switch process object. This parameter must be given if the station local/remote switch process object is not created by LIB 5xx or Stand-Alone COM 500 is used. Otherwise it should be set to “”, an empty text string. The default value is an empty text string.

• **Station L/R Object Index.** Index of the Station Local/Remote switch process object. This parameter must be given if the Station Local/Remote switch process object is not created by LIB 5xx or Stand-Alone COM 500 is used. Otherwise it should be set to zero. The default value is 0.

Miscellaneous information:

• Send IEC Terminations. The user has the possibility to select if command terminations are sent to the master. By default, this option is enabled.

• Record to Log. The internal message forwarding of COM 500 can be saved to a log and the contents can be read by a separate tool, which can be opened by clicking the Log File Viewer button. It is possible to reset the logging by clicking the Delete Log Files button. This mechanism is meant to be used only in the engineering phase or in the cases when traceability is needed.

• **REC 561 Command Values.** The binary commands are sent as analog values to REC 561. The user can define the values of the commands.
• **IEC Command Received without Select.** It is possible to select whether the commands are accepted without the select command or not. This selection is applicable for the configured commands of type Secured / 1 or Secured / 4 output objects. By default, this option is not selected.

### 4.6.17. Importing and exporting cross-references

#### 4.6.17.1. Exporting cross-references

Cross-reference signal information can be exported from the Signal Cross-Reference Tool into delimited text files. This functionality can be used for producing documentation of the cross-references or to modify the existing cross-references by editing the exported files with a spreadsheet or an ASCII editor. It is also possible to create new cross-references. The exported files have the following names and purposes:

- **COM_XRNCC.xrf** NCC information
- **COM.XRGRP.xrf** Alarm group information
- **COM.XRIND*.xrf** Indication information
- **COM.XRCMD*.xrf** Command information

Depending on the number of indications or commands there can be multiple text files. If one indication text file includes more than 10000 lines, the second text file, called **COM_XRIND1.xrf**, will be taken into use and so on.

Export operation can be started from the menubar by selecting **Export** from the **Cross-Reference** menu, which opens the Export dialog shown in Fig. 4.6.17.1.-1. The user can select one of the alternatives listed below.

- **Indications.** Exported information includes all the attributes included in the column attributes, and for each NCC address, alarm group number, signal handling attribute and scale.

- **Commands.** Exported information includes all the attributes included in the column attributes, command type, purpose, logical name and index of the response indication, and for each NCC address and signal handling attribute.

- **NCCs.** Exported information includes the station number, protocol, NCC name, comment text, operation mode, the parameter Send Group Alarms at Start-Up and Function Table Definition (FTAB). When NCCs are exported, alarm groups are exported to a separate file including the following information: NCC number, alarm group name, alarm group number and address.

- **All.** This includes all the alternatives listed above.

The names of the export files are fixed and the directory is the PICT directory of the current application. It is possible to select whether the first row in the export file includes column names; by default this is set. The following parameters can also be changed:

- **Field Separator.** This is the character that separates consecutive fields in the export file. The possible choices are comma, semicolon and tabulator.

- **Text Delimiter.** The possible choices are “” (double quote) and none (no delimiter).
Clicking **OK** starts exporting. During the export of signals a Progress Indicator is shown to display the percentage of exported signals.

![Export - ComTool](image)

Fig. 4.6.17.1.-1 Export dialog

Refer to Chapter 5. Technical description for information about exporting cross-references with Microsoft Excel.

### 4.6.17.2. Importing cross-references

Importing cross-references from files modifies the cross-information of the current application. Fig. 4.6.17.2.-1 shows the Import dialog, which has two modes:

- **Modify existing cross-references.** In this mode, only the NCCs and signals that are found both in the imported files and the current application can be modified. No new NCCs, alarm groups or signals are created. The row number in the imported file has to match the value of the Table Index (TI) attribute of the process object in the report database. (If a row is imported, but no matching row number is found in the report database, no cross-reference information is imported from the file.)

  This function modifies the existing cross-reference data according to the related information in the rows of the imported file. The value of the Table Index attribute is not modified at all during the import function.

- **Construct new cross-references.** When cross-reference data is imported by using this mode, all the existing cross-references are removed from the report database. After that, the cross-references are recreated according to the information in the rows of the imported file. If new NCCs, alarm groups or signals are detected, they are created. The Table Index attribute values are assigned into the found process objects in the report database, as well as into the corresponding Action Name (AN) attribute values.

  All the cross-reference definitions used by COM 500 must appear in the imported file. Otherwise, some of the previously defined cross-references are lost. This function is applicable only for the indication signals.
The Import operation can be started from the menubar by selecting **Cross-Reference > Import**, which opens the Import dialog shown below. One of the following alternatives can be selected:

- All
- Indications
- Commands
- NCCs

The information included in the alternatives is the same as when exporting. The names of the imported files are also the same as when exporting. Parameters First Row Includes Columns, Field Separator and Text Delimiter should be selected according the file to be imported.

![Import dialog](image)

**Fig. 4.6.17.2.-1 Import dialog**

Clicking the **OK** button starts importing. During the import operation a Progress Indicator is shown to display the amount of imported signals.

Refer to Section 5.8. Exporting and importing cross-references with Microsoft Excel for information about importing cross-references with Microsoft Excel.

### 4.6.18. Printing cross-references

It is possible to print cross-references from the Signal Cross-Reference Tool. This functionality can be made for producing documentation of the application to be sent to the customer or the supplier of the Network Control Center system.
Configuring a printer

The availability of printers and the configuration work needed depends on which context the MicroSCADA monitor is opened to. In COM 500 a monitor is by default opened to the context of the MicroSCADA user, that is the user with the user name MicroSCADA. In this case only local printers can be used for printing from the Signal Cross-Reference Tool. Local printers are:

• Printers connected directly to computer's serial or parallel port.
• Network printers defined as local port.

The procedure how to define a network printer as a local port is described in the System Administration manual.

If a monitor is opened from command prompt or from SCIL with an operating system call, it can be opened to the context of the current operating system user. This requires that the command line option start_as_logon_user is used when opening the monitor. Further details for opening monitors can be found in the System Administration manual. When a monitor is opened to the context of the current operating system user, the printers that are provided by the operating system to the user are also available for printing from the Signal Cross-Reference Tool.

When local printers are used, the MicroSCADA user should have access to these printers.

Since printouts from The Signal Cross-Reference Tool are made by using the Visual SCIL dialogs, the resolution of the display affects the printout. The resolution should be 1024 x 768 or higher.

Printing

When printing from the Signal Cross-Reference Tool, the user can select one of the several options. These options are listed below with information of their content.

NCC printout:
• Name of the NCC
• Description of the NCC
• Protocol of the NCC
• Station number of the NCC
• Alarm group names
• Alarm group addresses

Indications printout:
• Logical name and index
• Unit number and address
• Object identification and object text
• NCC address
• Signal handling attributes
• Alarm Group number
User's Guide

- Scale
- Signal class

Commands printout:
- Logical name and index
- Unit number and address
- Object Identification and Object Text
- Command type, purpose and command group
- NCC address
- Signal handling attributes

Parameters printout:
- Name of the parameter
- Value of the parameter
- Unit of the parameter

Cross-reference information can be printed by selecting Cross-Reference and Print from the menubar. This opens the Print dialog shown in Fig. 4.6.18.-1. The print selection can be:

- **Current page**. When this option is selected, the printout contains the active notebook page, that is indications, commands, NCCs or parameters.
- **All pages**. This option includes all the cross-reference information in the printout.
- **Selected pages**. The printout is made according to the further selections.

![Print dialog](image_url)

All the printed pages contain a header, a number of columns and column titles, and a footer. The title is centered in the header of each paper. Column titles are the names of the column attributes. Under each column, there is cross-reference information.
printed for each signal. Certain fixed signals are allocated into each printed page. The footer contains the name and number of the application, the number of each page and the total number of pages (see Fig. 4.6.18.-2).

**List of Indication Signals**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S182B1</td>
<td>41</td>
<td>Al</td>
<td>010</td>
<td>2</td>
<td>20137</td>
<td>2</td>
<td>2</td>
<td>30137</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>S182B1</td>
<td>42</td>
<td>Al</td>
<td>011</td>
<td>2</td>
<td>20138</td>
<td>2</td>
<td>2</td>
<td>30138</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>S182B1</td>
<td>43</td>
<td>Al</td>
<td>012</td>
<td>2</td>
<td>20139</td>
<td>2</td>
<td>2</td>
<td>30139</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>S182B1</td>
<td>44</td>
<td>Al</td>
<td>013</td>
<td>2</td>
<td>20140</td>
<td>2</td>
<td>2</td>
<td>30140</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>S182B1</td>
<td>45</td>
<td>Bl</td>
<td>009*00</td>
<td>2</td>
<td>20141</td>
<td>2</td>
<td>1</td>
<td>30141</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>S182B1</td>
<td>46</td>
<td>Bl</td>
<td>009*01</td>
<td>2</td>
<td>20142</td>
<td>2</td>
<td>1</td>
<td>30142</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>S182B1</td>
<td>47</td>
<td>Bl</td>
<td>009*02</td>
<td>2</td>
<td>20143</td>
<td>2</td>
<td>1</td>
<td>30143</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>S182B1</td>
<td>48</td>
<td>Bl</td>
<td>009*03</td>
<td>2</td>
<td>20144</td>
<td>2</td>
<td>1</td>
<td>30144</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>S182B1</td>
<td>49</td>
<td>Bl</td>
<td>009*04</td>
<td>2</td>
<td>20145</td>
<td>2</td>
<td>1</td>
<td>30145</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>S182B1</td>
<td>50</td>
<td>Bl</td>
<td>009*05</td>
<td>2</td>
<td>20146</td>
<td>2</td>
<td>1</td>
<td>30146</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TESTSTA BAY2</td>
<td>S182D1</td>
<td>10</td>
<td>D6</td>
<td>02*14</td>
<td>2</td>
<td>20102</td>
<td>2</td>
<td>2</td>
<td>30102</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TESTSTA BAY1</td>
<td>S182D1</td>
<td>16</td>
<td>Bl</td>
<td>009*06</td>
<td>2</td>
<td>20115</td>
<td>2</td>
<td>1</td>
<td>30115</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TESTSTA BAY1</td>
<td>S182D1</td>
<td>17</td>
<td>Bl</td>
<td>009*07</td>
<td>2</td>
<td>20116</td>
<td>2</td>
<td>1</td>
<td>30116</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TESTSTA BAY2</td>
<td>S182D1</td>
<td>25</td>
<td>Bl</td>
<td>009*08</td>
<td>2</td>
<td>20110</td>
<td>2</td>
<td>1</td>
<td>30110</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TESTSTA BAY2</td>
<td>S182D2</td>
<td>10</td>
<td>D6</td>
<td>003*04</td>
<td>2</td>
<td>20105</td>
<td>2</td>
<td>2</td>
<td>30105</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TESTSTA BAY3</td>
<td>S182E2</td>
<td>10</td>
<td>D6</td>
<td>003*06</td>
<td>2</td>
<td>20124</td>
<td>2</td>
<td>2</td>
<td>30124</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TESTSTA BAY3</td>
<td>S1831</td>
<td>10</td>
<td>D6</td>
<td>003*10</td>
<td>2</td>
<td>20200</td>
<td>2</td>
<td>2</td>
<td>30200</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TESTSTA BAY3</td>
<td>S1831</td>
<td>10</td>
<td>D6</td>
<td>003*15</td>
<td>2</td>
<td>21200</td>
<td>2</td>
<td>1</td>
<td>31200</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TESTSTA BAY3</td>
<td>S1831</td>
<td>10</td>
<td>D6</td>
<td>003*10</td>
<td>2</td>
<td>20201</td>
<td>2</td>
<td>2</td>
<td>30201</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TESTSTA BAY1</td>
<td>S1831</td>
<td>16</td>
<td>Bl</td>
<td>010*00</td>
<td>2</td>
<td>20213</td>
<td>2</td>
<td>1</td>
<td>30213</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TESTSTA BAY1</td>
<td>S1831</td>
<td>17</td>
<td>Bl</td>
<td>010*01</td>
<td>2</td>
<td>20214</td>
<td>2</td>
<td>1</td>
<td>30214</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IL1</td>
<td>S1831</td>
<td>25</td>
<td>Al</td>
<td>014</td>
<td>2</td>
<td>20221</td>
<td>2</td>
<td>2</td>
<td>30221</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IL2</td>
<td>S1831</td>
<td>25</td>
<td>Al</td>
<td>015</td>
<td>2</td>
<td>20222</td>
<td>2</td>
<td>2</td>
<td>30222</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IL3</td>
<td>S1831</td>
<td>27</td>
<td>Al</td>
<td>016</td>
<td>2</td>
<td>20223</td>
<td>4</td>
<td>2</td>
<td>30223</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Fig. 4.6.18.-2 Example of printed List of Indication Signals**

**Page setup**

It is possible to change the settings of the printed page by selecting **Cross-Reference > Page Setup**. This opens the Page Setup dialog shown in Fig. 4.6.18.-3. The page settings include the width of the top, bottom, left and right margins. By default these settings have values: 20, 20, 20 and 20, respectively.
Print setup

Printer settings can be changed by selecting Cross-Reference > Print Setup. This opens the Print Setup dialog shown in Fig. 4.6.18.-4. This dialog contains options for printer name, properties, paper size, source and orientation.
4.7. **Using COM 500**

4.7.1. **Communication Diagnostics dialog**

The Communication Diagnostics dialog is a tool for displaying communication diagnostics for each NCC and system information in COM 500. Selected signals can be displayed here for diagnostic purposes. From the Tool menubar, it is possible to open the Signal Cross-Reference Tool and Tool Manager. It is also possible to change the used font.

In order to add an icon for the Communication Diagnostics, refer to Section 4.6.2. Adding icon for Communication Diagnostics dialog for more details. By double-clicking the icon, you can access the Communication Diagnostics dialog directly.

For each NCC of COM 500 a separate tab is included in the Communication Diagnostics dialog. The Diagnostics dialog is shared by two different notebook tabs. The first tab shows the Link Layer diagnostics and the other one shows the Alarm Groups diagnostics.

4.7.1.1. **Link Layer diagnostics**

Each NCC tab includes general information found from the cross-reference tables and diagnostics information.

General information displays the NCC’s name and description, the station number of NCC and the protocol of NCC. Diagnostics information displays diagnostic counter indices, names and their values in this NCC. Depending on the used protocol of NCC, the number of diagnostic counters may be different according to the following table below.

<table>
<thead>
<tr>
<th>Table 4.7.1-1</th>
<th>NCC diagnostics counters</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NCC (IEC 60870-5-104)</strong></td>
<td><strong>NCC (RP 570 Slave)</strong></td>
</tr>
<tr>
<td>Transmitted Telegrams</td>
<td>Transmitted Telegrams</td>
</tr>
<tr>
<td>Failed Transmissions</td>
<td>Failed Transmissions</td>
</tr>
<tr>
<td>Transmitted Timeouts</td>
<td>Timeout Errors</td>
</tr>
<tr>
<td>Transmitted I (Information) Format Messages</td>
<td>Received Telegrams</td>
</tr>
<tr>
<td>Transmitted S (Supervisory) Format Messages</td>
<td>Parity Errors</td>
</tr>
<tr>
<td>Transmitted U (Unnumbered control function) Format Messages</td>
<td>Overrun Errors</td>
</tr>
<tr>
<td>Received I Format Messages</td>
<td>Redundancy Errors</td>
</tr>
<tr>
<td>Received S Format Messages</td>
<td>Framing Errors</td>
</tr>
<tr>
<td>Received U Format Messages</td>
<td>Buffer Overflow Errors</td>
</tr>
<tr>
<td>Received Messages / Telegrams</td>
<td>Buffer Overflow Errors</td>
</tr>
<tr>
<td>TCP Connect Count</td>
<td>TCP Connect Count</td>
</tr>
<tr>
<td>TCP Accept Count</td>
<td>TCP Accept Count</td>
</tr>
<tr>
<td>TCP Close Count</td>
<td>TCP Close Count</td>
</tr>
</tbody>
</table>
For the NCC of protocol type CPI or Modbus, only the Alarm Groups tab is displayed, not the Link Layer tab.

<table>
<thead>
<tr>
<th>Table 4.7.1-1 NCC diagnostics counters (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>NCC (IEC 60870-5-104)</td>
</tr>
<tr>
<td>------------------------</td>
</tr>
<tr>
<td>Duplicates and Losses</td>
</tr>
<tr>
<td>Buffer Overflow Errors</td>
</tr>
</tbody>
</table>

1. These are valid only for DNP V3.00 with TCP/UDP.

On the right hand side of each NCC tab, there are two graphs displaying the counter values in a plot diagram (see Fig. 4.7.1.-1). The diagnostic counters, which are displayed in these graphs can be changed by selecting two appropriate counter names on the list. The first selected counter is displayed in the upper graph and the second in the lower graph. Press down the CTRL key while selecting the second counter with a mouse click. By default, the first two counters are selected, when the Communication Diagnostics dialog is opened. The counter values are refreshed.
every five seconds. If there is no need to update the graphs, unselect the last active counter name on the list by pressing the Space-key. If the counter value exceeds its maximum value 30,000, the value will restart from 0.

For each plot graph there is a zoom functionality that allows zooming a selected plot area in each graph. To zoom in a graph, click the **Zoom In** inside the appropriate graph, and select the zoom area by pressing and releasing the mouse button for a rectangular area in this graph. When releasing the mouse button, the selected area becomes zoomed. To zoom out the selected graph click **Zoom Out** (see Fig. 4.7.1.-2).

![Transmitted Telegrams](image1)

**Fig. 4.7.1.-2  Zoom Functionality of plot graph**

### 4.7.1.1. Alarm Group diagnostics

The Alarm Groups functionality means that a set of signals can be grouped to certain alarm groups. When one or multiple signals inside an alarm group get into the alarming state, the alarm group itself becomes alarming. When this occurs, COM 500 sends the alarming value to the NCC. When all the signals inside an alarm group return to the normal state, the alarm group itself is set to the normal state. In this case, COM 500 sends the normal value to the NCC. Note that if there are alarm state changes for some signals, which do not change the alarm group state, COM 500 does not send the same alarm group state to the NCC. However, all the alarm group changes are send, when communication is established between COM 500 and an IEC 60870-5-101/104 NCC. This is one configurable feature on the NCC tab. Group alarms are also sent when general interrogation occurs.

The Alarm Groups dialog (see Fig. 4.7.1.1.-1) shows the following information:
User’s Guide

- **Group** specifies the alarm group number. The group number is displayed, when signals are connected to alarm groups in the Signal Cross-References Tool.
- **Name** displays the alarm group name.
- **Address** displays the alarm group address.
- **On** displays the alarm group state. When the alarm group is in the alarming state, the check box is set under the On column. When the alarm group is in the normal state, the check box is not set under the On column.
- **Time Stamp of Last Signal Update** displays the time stamp, when a signal has been updated last time in COM 500 inside this alarm group, the alarm group state has not been changed.
- **Time Stamp Sent to NCC** displays the time stamp, when COM 500 has sent the alarm group state change to the NCC.

The Alarm Groups dialog can also be directly accessed from the ComTool, when a NCC is selected on the NCCs tab and the **Diagnostics** button is clicked in the Alarm Information panel.

![Alarm Groups dialog](image)

*Fig. 4.7.1.1.-1 Alarm Groups dialog*

By double-clicking an alarm group, you can see all the alarming signals in a specific group. The name of the alarm group, whose alarming signals are displayed, is identified in the title of the dialog (see Fig. 4.7.1.1.-2).
The different fields and buttons in the Alarming Signals dialog are described below.

**Filter**
By using filters, you can define the signals which you want to be displayed. The default filter name is “All”. When it is selected after filtering, all the signals are shown. Predefined user filters can be chosen from a drop-down menu. A filter, which is stored in a user profile, is set by clicking the Set Filter button. By default, the number of filters is 10.

**User-defined attributes**
By using the User-defined attributes you can define the attributes to be displayed on the three rightmost columns of the table (for example SS, AN and IU). User-defined attributes can be chosen from a drop-down menu. Selected attribute values are stored and restored. If the History function is enabled, the changing of user-defined attributes will clear old values from that column.

**Navigation**
You can navigate in the dialog with the buttons in the lower left corner. With these arrow buttons you can select one of the alarm groups (see below), from which alarming signals are displayed. Information on what group is active at that time, is shown in the dialog.

Select the first alarm group.

Select the previous alarm group.

Select the following alarm group.

Select the last alarm group.
The condition for alarming signals inside an alarm group can be defined in the Filter dialog (see Fig. 4.7.1.1.-3). The condition can be constructed by using certain dialog items (for example Attribute and Value) and text fields as in the figure below. It can also be directly entered as SCIL condition into the Filter text field.

In the example below, all the alarming signals which have a logical name with prefix S1B and index 10 are included in the condition.

![Filter dialog](image)

Fig. 4.7.1.1.-3  Filter dialog
4.7.1.2. **System information**

The System tab of the Communication Diagnostics dialog shown in Fig. 4.7.1.2.-1 contains license, application and system information. The license information is displayed with text *This product is licensed to* appended with the name of the COM 500 license owner. Application information displays the application name and number, for example *Application: COM 500, 1*. System information displays the license site info together with the system node number and station address in parentheses.

![Fig. 4.7.1.2.-1  System tab](image)

4.7.1.3. **Application tab**

The diagnostics of the parallel queues, process event queues and running objects are shown on the Application tab (Fig. 4.7.1.3.-1.). These diagnostics display how the COM 500 functionality increase the system load to the application.

Parallel Queues display the maximum length of parallel queues together with the length of the waiting executions in the parallel queues. The percentage of these values are shown as well.

The maximum length shown in the application is not an absolute limit, because the queue can continue growing.
Process Event Queues display the maximum number of process events that can be in the queue for event channel activation. The number of event channel start-up commands from the process in the event channel queue are shown together with the percentage of these values.

When the Process Event Queue exceeds 95% or reaches the maximum 100%, the queue length handling mechanism of COM 500 is activated. This activation can be seen, when for example a message COM 500 ev.ch. queue too long. The oldest update of signal EST_H01Q0:P10 is not sent to the NCCs is displayed in the Notification window. For further information on queue length handling, refer to Section 5.3. Data flow.

Running Objects displays the contents of common time and event channel queues and the contents of parallel queues. For COM 500 specific parallel queues, the contents are described more precisely in the descriptive text column, for example Parallel queue 2, Command Terminations. The object column contains the names of the command procedures or data objects currently under execution in REPR queues, for example C COM_GENINT. The character C identifies the command procedure, whereas D identifies the data object.

The objects in each of these queues are updated with an interval of 1 second. If an object is found from a queue, the type and name of the object will be shown, for example C COM_GENINT.
There is usually need to trace signals during the factory and site acceptance tests in the COM 500 project. Especially, if Stand-Alone COM 500 is used, this is the only easy way to test signals. During these tests, it is verified that each signal included in the system is transmitted and received in the correct way. Traceability in the COM 500 product means that signal values with related attributes are displayed and updated as event-based in the Signal Diagnostics dialog. The set of signals to be traced is selected in the Signal Cross-Reference Tool. The selection can consist of signal rows inside a certain rectangular area or individual signal rows. You can select individual signal rows, when you press the CTRL key and click the rows you want to be included in the selection. Both the indication and command signals can be selected. Each row included in the Signal Diagnostics is updated, when a value update related to that signal occurs there. The related attributes to be displayed can be selected from the appropriate drop-down menus. It is possible to store the history related to the signal changes, when Enable history in dialog is set. History is collected as long as the Signal Diagnostics dialog is displayed.

When using a signal dialog from another tool than COM diagnostics, there are functions that work in a different way:
User's Guide

- Navigation
  Shows information on what signal is selected. The navigation buttons where you can scroll back and forth are active.

- Table
  There are 11 columns and the first column is a combination of the logical signal name and index.

Fig. 4.7.2.-1 shows the Signal Diagnostics dialog:

The History viewer (Fig. 4.7.2.-2) shows the last 10 states of the selected signal. The name of the signal is shown in the dialog title. In the columns you can see the attribute values and the row number. If there is no value in a cell, the column attribute has been changed during the history gathering.
4.7.3. Command authorization

COM 500 checks the command authority of a NCC when a command is received. The command authority is determined by the following factors:

- Station Local/Remote switch must be in remote position, if the parameter Station L/R Check In Use is set.
- NCC must be given the authority to make commands.

These factors can either be used simultaneously or individually.

In case a command is not authorized, a negative command confirmation is sent to the NCC if the IEC 60870-5-101/104 protocol is used (refer to Chapter 5. Technical description). If DNP 3.0 is used, the command is confirmed with status information that the outputs are in the local state.

When the standalone COM 500 product is used, the following user interface is displayed on the Parameters tab of ComTool (see Fig. 4.7.3.-1). In this case, the selection Command Source Check in Use is not applicable.
4.7.4. Recording signal routing to log files

It is possible to log data forwarding between the COM 500 database and the NCC system, if Record to Log check box is set on the Parameters tab of ComTool. The generated log files can be cleared from the ComTool with the **Delete Log Files** button. Logging is stopped when Record to Log check box is not set.

The log mechanism saves data from every transaction between the COM 500 command procedures and the PC-NET. Some internal handling is also written to log. Runtime log is written to free type objects. The number of these free type process objects is 10, each of which consist 1000 lines. When these objects are written, log mechanism writes text files to a COM 500 specific path in the application directory. This path is shown on the Parameters tab of ComTool. Files can be generated up to 10, com_log1..10.log.

The user can read this log with a specific tool, which can be started from the Parameters tab of ComTool by using the **Log File Viewer** button (see Fig. 4.7.4.-1).

![Record to Log](Recordtolog2)

Fig. 4.7.4.-1  Access to Log File Viewer

When the tool is opened, it creates a new log file from the current runtime logs, com_log.log. The tool shows on the notebook tabs all the defined NCCs, and data sent to them and received from them with some default data:

The main dialog of the COM 500 Log Viewer tool is a logged events navigator with several notebook tabs containing a table, toolbar and menu (see Fig. 4.7.4.-2).

![Log File Viewer](LogFileViewer)

The base functionality of the tool is showing information from the log files and displaying it with or without filtering. All information is separated into notebook tabs. Each tab, except the last one, contains data related to a certain NCC. The last tab contains data, which is not included into any NCC specific notebook tabs.

Logged events are listed by tabs instead of showing all the information at the same time. Navigation buttons allow moving to the next and previous tabs, as well as to the beginning and to the last tab. The number of rows on a tab is configurable. The main table on the each notebook tab contains only most important columns, and detailed information about a record is shown on a double-click. The table rows are highlighted with different colours depending on the signal type. The tool has a possibility to customise filters for the following fields:

- Destination addresses range
- Process Object name (text filter)
- Date and time (for example all the signals regarding a certain period of time)
- Data source station number
There are four standard columns on each notebook tab:

- Date & Time from the triggered process object
- Used COM 500 command procedure
- Triggered process object name and index
- Possible SCIL status (or text description)
- Status of process object during signal routing
- Event Class

Three columns are visible only on NCC specific notebook tabs:

- Source STA object number
- Sent NCC address
- Sent value

The rows in the tables are highlighted with different colours depending on the signal type: successfully sent upstream data is light green and downstream data is light yellow, other data is white in colour. The lines with SCIL error are highlighted with red.

The user can switch between different NCC by selecting the appropriate notebook tab. The main table on each tab has a limited row count. If the number of possible log records is greater than this value, then full log data list will be shown by tabs.
The user can navigate the full list by using the toolbar buttons – First, Previous, Next, Last. The maximum row count is specified by Table_PageSize parameter of the [LViewer] section in the COMLViewer.INI file in the user parameters directory. The default page size is 20. The status bar at the bottom of table shows information about the total number of log records found for the currently selected NCC and currently displayed line numbers.

In case the log files are changed while the tool is running, it is possible to refresh log data by pressing toolbar button Refresh or by selecting Log > Refresh.

When the user tries to set the Record to Log option in Com Tool, the following caution dialog appears on the screen (see Fig. 4.7.4.-3). If Yes is clicked, the Record to Log function will be set, otherwise not.

![Record to Log - ComTool](image)

Fig. 4.7.4.-3 Caution dialog of Record to Log function

Using the logging mechanism generates more load to the system. In large systems it is not possible to use logging for a long time. The user must check from the diagnostic tool that the usage of event channel does not increase when logging is set to use. It must also be remembered that analog indication points can generate a lot of updates and some delta values should be used in that case (for example, analog inputs in IEC 103 devices).

Detailed event information can be viewed in a separate dialog (see Fig. 4.7.4.-4), which can be accessed by double-clicking the desired row in the main table. Another way to do it is to select the desired row in the main table, to click the right mouse button and to select Detail from the shortcut menu which appears on the screen.
This dialog contains two groups of attributes: Common attributes, which are common for all NCC protocols, and Protocol specific attributes. When an alarm group is displayed in the Detail dialog, the alarm group name is included into the Common attributes group. When an analog input process object is displayed in the Detail dialog, the attached Scale object is included into the Common attributes group.

Logged events listed in the tables can be filtered by different attributes. The Filter dialog is accessible from the toolbar button or by selecting View > Filter Events. Fig. 4.7.4.-5 appears on the screen after the option is selected:

Only successfully sent upstream or downstream data can be viewed in this dialog.
The user can specify any combination of the following filters: Process Object name, with a keyword which should be included in the process object name at a specified position; Destination address range; Time period; Source station number. All the filters are saved in COMLViewer.INI file in the user parameters directory.

The tool has also a possibility to fill the filter dialog automatically with attributes of the certain event. For that option the user should select a row, which contains the desired event, and select Use as Filter… from the shortcut menu (called in with the click of the right mouse button).

The currently selected filters are displayed in the status bar, which is placed on the right hand side of toolbar in the main dialog.
5. Technical description

About this section
This section contains descriptions about the functionality, design and configuration of COM 500. Detailed description is given to help the user to understand the function of COM 500.

5.1. Hardware requirements
COM 500 requires at least:

- Processing power of a 300 MHz Pentium. Computers with multi-processors may also be used.
- RAM size of 128 MB, smaller RAM size may result in degraded performance.
- COM 500 application requires approximately 100 MB of disk space. The recommended total disk capacity is at least 1 GB. Any SCSI or IDE controller supported by Windows 2000 may be used.

Options:

- A CD-ROM device is recommended for the installation of Windows and the COM 500 software.
- A 3.5”/1.44 MB floppy drive, CD-RW or a 4/8 GB DAT tape drive is recommended for the system backup purposes.
- Any Ethernet adapter supported by Windows may be used for connecting the base system computer to the LAN.
- For time synchronization, a PC 31/32 radio clock board from Meinberg Funkuhren, Germany, may be used. The board contains a radio receiver for the Frankfurt DCF-77 77 kHz radio transmitter. Optionally the PC 32 board can be connected with a serial line to a GPS receiver. In case of the LON protocol, a LON Clock Master card in the LON Star Coupler, RER 111 can be used.

5.2. Available protocols
Protocols that are supported in COM 500 are shown in Table 5.2.-1. The master protocols are used in process communication and the slave protocols are used in upper level communication.

CPI is also listed. It is actually not a protocol, but rather an interface that can be used for implementing new protocols to MicroSCADA environment. If protocols that are not listed above need to be used, there is a possibility to program the protocol conversion using CPI. The programming is done by using the C language.

Table 5.2.-1 Protocols that are supported in COM 500

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Type</th>
<th>Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPA</td>
<td>Master</td>
<td>PC-NET (and DCP-NET)</td>
</tr>
<tr>
<td>LAG 1.4 (LON)</td>
<td>Master</td>
<td>PC-NET</td>
</tr>
<tr>
<td>IEC 60870-5-101</td>
<td>Master and slave</td>
<td>PC-NET</td>
</tr>
<tr>
<td>IEC 60870-5-103</td>
<td>Master</td>
<td>PC-NET</td>
</tr>
<tr>
<td>IEC 60870-5-104</td>
<td>Master and slave</td>
<td>PC-NET</td>
</tr>
<tr>
<td>IEC 61850</td>
<td>Master</td>
<td>IEC 61850 Server</td>
</tr>
</tbody>
</table>
Some of the protocols listed above are master protocols, which means that the protocol is used for communicating with process devices, whereas slave protocols are used for communicating with upper level systems. The following sections provide reference documentation about the protocols supported by COM 500. In addition to the documents mentioned below, the MicroSCADA technology documentation can be used as reference.

### SPA

SPA-Bus Communication protocol V2.4.

### LAG 1.4 (LON)

LON Application Guidelines for Substation Automation. Version 1.4. This is the ABB standard for using LON as a substation automation protocol.

### RP 570 master and slave

This protocol is used for communication between the RTU 200 family process devices and the MicroSCADA systems. Protocol Specification: RTU PROTOCOL 570 and 571 (RP 570 and RP 571). Doc. id: 1KSE 300000-VW. M. Vänskä 95-10-18.

### ANSI X3.28 master

This protocol is used for communication with Allen-Bradley PLC devices. It is also used for communication with SRIO 1000M and SRIO 500M devices. Protocol Specifications:

- PLC-2-Family RS-232-C Interface Module. Doc. Id: 1771-6.5.8
- SRIO 1000M and 500MDoc. Id: 34 SRIO 100M 2 EN1 D

### IEC 60870-5-103 master

This protocol is used for connecting the MicroSCADA system to protection and control devices. Protocol Specification: INTERNATIONAL STANDARD IEC 60870-5-103.

### IEC 60870-5-101 master and slave

IEC 60870-5-104 master and slave

Protocol specification: INTERNATIONAL STANDARD IEC 60870-5-104.

IEC 61850 Master

This protocol is used for connecting the MicroSCADA system to protection and control devices. For more information about using this protocol refer to the IEC 61850 Master Protocol (OPC) *1.0 and OPC Data Access Client user’s guides.

DNP V3.00 master and slave

The following protocols describe the DNP V3.00 protocol:

- DNP V3.00 DATA LINK LAYER version 0.02 (P009-0PD.DL)
- DNP V3.00 APPLICATION LAYER version 0.03 (P009-0PD.APP)
- DNP V3.00 DATA OBJECT LIBRARY version 0.02 (P009-OBL)
- DNP V3.00 TRANSPORT FUNCTIONS version 0.01 (P009-0PD.TF)
- DNP V3.00 SUBSET DEFINITIONS version 2.00 (P009-01G.SUB)

Modbus master and slave


CDC-II

For more information on using this protocol, contact your supplier.

OPC Server

This protocol can be used for connecting the MicroSCADA system to a upper level system, which contains the OPC Client. For more information about using this protocol refer to OPC Data Access Server manual.

OPC Client

This protocol can be used for connecting the MicroSCADA system to a protection and control devices, which contain the OPC Server. For more information on using this protocol refer to OPC Data Access Client manual.

5.2.2. CPI

CPI software can be used to implement both the master and slave protocols. The CPI library contains functions to send and receive messages. It also contains functions to pack and unpack data. The CPI based communication software and COM 500 communicate through the TCP/IP network. The communication program that uses the CPI interface must emulate RTU device placed into a communication frontend.

When using a CPI program with COM 500 for upper level communication (slave protocol) the following rules apply:

- The communication system object attribute interface of the device is as in RP 570 slave
- The process database interface is of RTU 200 type
- System messages are as in RP 570 slave
The CPI interface is designed to support connections to several applications in a base system or in several base systems. All applications in one base system can be reached using the same TCP/IP socket.

When using CPI, the Communication Programming Interface CPI manual should be used as a guideline. This manual is delivered on request. In the CPI projects it is recommended to contact ABB Oy.

**Data flow**

Data flow through COM 500 is handled by the signal routing mechanism that consists of the following parts:

- Cross-reference mechanism, that is cross-reference tables created and maintained by the Signal Cross-Reference Tool
- Parameter files
- Command procedures

The other parts of the signal routing are:

- System message handling, application and system command handling
- Command authority check
- Group alarm handling

**Queue length handling**

When the signal flow from the process devices to COM 500 is much larger than the signal flow from COM 500 to the NCCs (for example in case of a start-up with a slow or damaged NCC connection), the event channel queue may fill up, which can lead to communication disturbances. This is prevented by implementing a queue length handling mechanism, which works as follows:
• When the event channel queue length is 95% of its maximum, analog values and pulse counters are not sent if the registration of the process object has changed, that is a newer event is in the queue.
• When the event channel queue has its maximum length, other data types are not sent if the registration of the process object has changed.

If a signal is not sent, a message is sent to the Notification Window. The maximum length of the event channel queue can be set by using the EM attribute of the application. Reading the EU attribute of the application indicates the current length of the event channel queue.

The event channel queue lengths can be seen on the Application tab of the Communication Diagnostics Dialog. For more information, see the Application tab in Section 4.7.1.3. Application tab.

5.3.1. Indications

5.3.1.1. Mechanism and data types

Indications (input process objects) receive data from the process devices. This data is then sent to the NCCs by COM 500. Data flow from a process device to one or several NCCs is shown in Fig. 5.3.1.1.-1.

![Diagram of data flow from process devices to NCC](image)

Fig. 5.3.1.1.-1 Indications from process devices to NCC.

The following input data types are supported by COM 500:
• Binary input
• Double binary input
• Digital input
Sending input signals to a NCC does not require any additional process objects, except for group alarm, since the data is sent directly to the NET unit using a set of command procedures based on the data stored in the cross-reference tables. This data includes:

- Address to which the data is sent (NCC address)
- Alarm group information
- Information about the handling of the signal (signal handling attributes)
- The scale object used in scaling of analog values

### 5.3.1.2. Telegrams and parameters

The following table presents the different IEC 60870-5-101/104 Application Service Data Unit (ASDU) types that are used in COM 500 when sending data to a NCC. The ASDU used depends on the signal handling attributes selected for the signal in the Signal Cross-Reference Tool. Only those signal handling attributes that affect the ASDU used are mentioned.

For more information about defining the signal handling attributes, see Section 4.6.13. Defining indication cross-references.

<table>
<thead>
<tr>
<th>Data type</th>
<th>Signal Handling Attributes</th>
<th>ASDU Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary input</td>
<td>None</td>
<td>M_SP_NB_1(1)</td>
</tr>
<tr>
<td></td>
<td>Send with Time Tag</td>
<td>M_SP_TB_1(2)</td>
</tr>
<tr>
<td></td>
<td>Send with Long Time Tag</td>
<td>M_SP_TB_1(30)</td>
</tr>
<tr>
<td></td>
<td>Send as Double Binary</td>
<td>M_DP_NB_1(3)</td>
</tr>
<tr>
<td></td>
<td>Send with Time Tag + Send as Double Binary</td>
<td>M_DP_TB_1(4)</td>
</tr>
<tr>
<td></td>
<td>Send with Long Time Tag + Send as Double Binary</td>
<td>M_DP_TB_1(31)</td>
</tr>
<tr>
<td></td>
<td>Send with and without Time Tag</td>
<td>M_SP_NB_1(1) + M_SP_TA_1(2)</td>
</tr>
<tr>
<td></td>
<td>+ Send with Long Time Tag + Send as Double Binary</td>
<td>M_SP_NB_1(1) + M_SP_TB_1(30)</td>
</tr>
<tr>
<td></td>
<td>Send with and without Time Tag + Send as Double Binary</td>
<td>M_DP_NB_1(3) + M_DP_TB_1(4)</td>
</tr>
<tr>
<td></td>
<td>Send with and without Time Tag + Send with Long Time Tag + Send as Double Binary</td>
<td>M_DP_NB_1(3) + M_DP_TB_1(31)</td>
</tr>
</tbody>
</table>
### Table 5.3.1.2-1  IEC 60870-5-101 ASDU types in COM 500 (Continued)

<table>
<thead>
<tr>
<th>Data type</th>
<th>Signal Handling Attributes</th>
<th>ASDU Type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Double binary</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>None</td>
<td>M_DP_NA_1(3)</td>
</tr>
<tr>
<td></td>
<td>Send with Time Tag</td>
<td>M_DP_TA_1(4)</td>
</tr>
<tr>
<td></td>
<td>Send with Long Time Tag</td>
<td>M_DP_TB_1(31)</td>
</tr>
<tr>
<td></td>
<td>Send as Single Indication</td>
<td>M_SP_NA_1(1)</td>
</tr>
<tr>
<td></td>
<td>Send with Time Tag + Send as Single Indication</td>
<td>M_SP_TA_1(2)</td>
</tr>
<tr>
<td></td>
<td>Send with Long Time Tag + Send as Single Indication</td>
<td>M_SP_TB_1(30)</td>
</tr>
<tr>
<td></td>
<td>Send with and without Time Tag</td>
<td>M_DP_NA_1(3) + M_DP_TA_1(4)</td>
</tr>
<tr>
<td></td>
<td>Send with and without Time Tag + Send as Single Indication</td>
<td>M_DP_NA_1(3) + M_DP_TB_1(31)</td>
</tr>
<tr>
<td></td>
<td>Send with and without Time Tag +</td>
<td>M_SP_NA_1(1) + M_SP_TA_1(2)</td>
</tr>
<tr>
<td></td>
<td>Send with and without Time Tag + Send as Single Indication</td>
<td>M_SP_NA_1(1) + M_SP_TB_1(30)</td>
</tr>
<tr>
<td><strong>Digital input</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>None</td>
<td>M_ST_NA_1(5)</td>
</tr>
<tr>
<td></td>
<td>Send with Time Tag</td>
<td>M_ST_TA_1(6)</td>
</tr>
<tr>
<td></td>
<td>Send with Long Time Tag</td>
<td>M_ST_TB_1(32)</td>
</tr>
<tr>
<td></td>
<td>Send as Analog Value</td>
<td>M_ME_NA_1(9)</td>
</tr>
<tr>
<td></td>
<td>Send with Time Tag + Send as Analog Value</td>
<td>M_ME_TA_1(10)</td>
</tr>
<tr>
<td></td>
<td>Send with Long Time Tag + Send as Analog Value</td>
<td>M_ME_TD_1(34)</td>
</tr>
<tr>
<td></td>
<td>Send with and without Time Tag</td>
<td>M_ST_NA_1(5) + M_ST_TA_1(6)</td>
</tr>
<tr>
<td></td>
<td>Send with and without Time Tag +</td>
<td>M_ST_NA_1(5) + M_ST_TB_1(32)</td>
</tr>
<tr>
<td></td>
<td>Send with and without Time Tag + Send as Analog Value</td>
<td>M_ME_NA_1(9) + M_ME_TA_1(10)</td>
</tr>
<tr>
<td></td>
<td>Send with and without Time Tag + Send as Analog Value</td>
<td>M_ME_NA_1(9) + M_ME_TD_1(34)</td>
</tr>
</tbody>
</table>
The IEC 60870-5-104 protocol uses the same ASDUs as IEC 60870-5-101, but the default signal handling attribute for IEC 60870-5-104 is Send with Long Time Tag.

The IEC 60870-5-104 protocol standard does not define ASDUs with Short Time Tag. However, it is possible to use Send with Time Tag in the IEC 60870-5-104 protocol.

When Send with and without Time Tag has been selected, two consecutive messages are sent, one with and one without a time tag. This feature is suitable for masters that handle time-tagged and non-time-tagged data separately.
The table below presents the IEC 60870-5-101/104 cause of transmission values that are possible in COM 500 for different types of data.

Table 5.3.1.2-2  IEC 60870-5-101/104 Cause Of Transmission (COT) values

<table>
<thead>
<tr>
<th>Data type</th>
<th>COT</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary input</td>
<td>3</td>
<td>Spontaneous</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>Requested</td>
</tr>
<tr>
<td></td>
<td>11</td>
<td>Return information caused by remote command</td>
</tr>
<tr>
<td></td>
<td>20</td>
<td>Interrogated by general interrogation</td>
</tr>
<tr>
<td>Double binary</td>
<td>3</td>
<td>Spontaneous</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>Requested</td>
</tr>
<tr>
<td></td>
<td>11</td>
<td>Return information caused by remote command</td>
</tr>
<tr>
<td></td>
<td>20</td>
<td>Interrogated by general interrogation</td>
</tr>
<tr>
<td>Digital input</td>
<td>3</td>
<td>Spontaneous</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>Requested</td>
</tr>
<tr>
<td></td>
<td>11</td>
<td>Return information caused by remote command</td>
</tr>
<tr>
<td></td>
<td>20</td>
<td>Interrogated by general interrogation</td>
</tr>
<tr>
<td>Analog input</td>
<td>3</td>
<td>Spontaneous</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>Requested</td>
</tr>
<tr>
<td></td>
<td>11</td>
<td>Return information caused by remote command</td>
</tr>
<tr>
<td></td>
<td>20</td>
<td>Interrogated by general interrogation</td>
</tr>
<tr>
<td>Pulse counter</td>
<td>3</td>
<td>Spontaneous</td>
</tr>
<tr>
<td></td>
<td>37</td>
<td>Requested by general counter request</td>
</tr>
</tbody>
</table>

The following table describes the input data objects and variations used with the DNP 3.0 slave protocol. The data object and variation used depends on the signal handling attributes. The variations described in the table below are default variations, that is variations that are used if no variation is specified by the master in the data request.

Table 5.3.1.2-3  DNP 3.0 input data objects and variations in COM 500

<table>
<thead>
<tr>
<th>Data type</th>
<th>Signal Handling Attributes</th>
<th>Object</th>
<th>Variation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary input*</td>
<td>None</td>
<td>1</td>
<td>1 (2) 1</td>
</tr>
<tr>
<td></td>
<td>Send Change</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Send Change with Time</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Send Change with Relative Time</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Double binary*</td>
<td>None</td>
<td>1</td>
<td>1 (2) 1</td>
</tr>
<tr>
<td></td>
<td>Send Change</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Send Change with Time</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Send Change with Relative Time</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Binary output</td>
<td>Report Status to Master</td>
<td>10</td>
<td>2</td>
</tr>
</tbody>
</table>
Signal specific classes

It is possible to define signal specific classes for the IEC 60870-5-101 and DNP 3.0 protocols in the COM 500 product. With this feature signals can have different priorities in events sent towards the NCC. To use a specific class in COM 500, write the class number in the column for the signal class, which is located on the Indications tab in the Signal Cross-Reference Tool, see Fig. 4.6.13.-1. If the cell is left empty, the default class is used.

The default class for the IEC 60870-5-101 protocol is 1. It is possible to select between classes 1 and 2; class 1 has a higher priority. The class definition for the IEC 60870-5-101 protocol is usable only when the unbalanced communication mode is used.

In DNP 3.0, there are two kinds of data: static data and event data. Static data in DNP 3.0 is called class 0 data. Event data can have three different classes or priorities: class 1 (high priority), class 2 (medium priority) and class 3 (low priority).

### Table 5.3.1.2-3 DNP 3.0 input data objects and variations in COM 500

<table>
<thead>
<tr>
<th>Data type</th>
<th>Signal Handling Attributes</th>
<th>Object</th>
<th>Variation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog input</td>
<td>None</td>
<td>30</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Send as 16-bit Value</td>
<td>30</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Send without Flag</td>
<td>30</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Send as 16-bit Value+Send without Flag</td>
<td>30</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Send Change Event without Time</td>
<td>32</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Send as 16-bit Value + Send Change Event without Time</td>
<td>32</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Send Change Event with Time</td>
<td>32</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Send as 16-bit Value + Send Change Event with Time</td>
<td>32</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Send as Binary Input</td>
<td>1</td>
<td>1(2)</td>
</tr>
<tr>
<td></td>
<td>Send as Binary Input + Send Change Event without Time</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Send as Binary Input + Send Change Event with Time</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pulse counter</td>
<td>None</td>
<td>20 (21)</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Send as 32-bit Value</td>
<td>20 (21)</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Send as Delta Counter</td>
<td>20</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Send as 32-bit Value + Send as Delta Counter</td>
<td>20</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Send without Flag</td>
<td>20</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Send as 32-bit Value + Send without Flag</td>
<td>20 (21)</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Send as Delta Counter + Send without Flag</td>
<td>20 (21)</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Send as 32-bit Value + Send as Delta Counter + Send without Flag</td>
<td>20</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>Send Change Event without Time</td>
<td>20</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>Send as 32-bit Value + Send Change Event without Time</td>
<td>22</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>Analog output</td>
<td>Report Status to Master</td>
<td>40</td>
<td>2</td>
</tr>
</tbody>
</table>

1. Variation 2 is used when the status of the process object changes.
2. Used if counters have been frozen by the master.
5.3.1.3. Handling of analog and digital values

Since some data types have a different value range in MicroSCADA and in the slave protocols supported in COM 500, some kind of scaling is needed. Analog input values are handled as follows:

In COM 500, you can define the scaling of an analog signal separately for each NCC. This is done by selecting an existing scale object to the signal in question in the Signal Cross-Reference Tool.

The scaling algorithm is as follows:

- The “Process” value range is scaled to the “MicroSCADA database” value range of the scale object.
- The value sent to the NCC is limited to the value range defined by the message type of the NCC protocol.
- If the value is over this value range, the overflow bit of the analog telegram is set in the IEC 60780-5-101/104 and DNP 3.0 protocols, and in the RP 570 protocol the status of the signal is marked as invalid.

For example, if the value of an analog signal sent to an IEC 60870-5-101/104 master as a scaled value is to be divided by ten, the parameters of the Scale Object Tool should be as shown in Fig. 5.3.1.3.-1. For more information on the Scale Object Definition Tool, refer to SYS 600 Application Objects manual.

Digital input values are handled as follows:

- In MicroSCADA the value is 0…65535.
- In RP 570 and CPI the value is 0…65535 or -2000…2000 (sent as analog value).
- In IEC 60870-5-101/104 the value (as seen in SCIL) is 0..127 (step point information) or -32767…32767 (sent as analog value).
• If the value range of the slave protocol is different than in MicroSCADA, a digital input value is limited as follows: the value sent to the NCC is limited between 0 and the maximum of the value range of the slave protocol.

• In Modbus the value is 0...65535 (sent as analog value).

5.3.1.4. Deadband

The transmission of analog values as events in DNP3.0 can be limited by using the deadband possibility. Currently, all changes to analog values are transmitted by the COM_USAI procedure to the NCC. The modification of the COM_USAI procedure is needed to define the deadband. Note that the modifications have an effect on all analog points transmitted to the NCC via DNP3.0.

The delta value can be hardcoded if the same delta value is acceptable throughout the whole system.

```plaintext
#WHEN 4 #BLOCK ; ********************** DNP 3.0 slave*******
  ;protocol parameters
  @SD_CLASS = 2 ; middle weight (priority)
  #IF %SIGNAL_CLASSES(%NCC_COUNTER) == 0 #THEN #BLOCK
  @EV_CLASS = 0 ; use default event class
  #BLOCK_END
  #ELSE @EV_CLASS = %SIGNAL_CLASSES(%NCC_COUNTER) ; use signal spes. class
  @DELTA = 25 ; original = 0
  @EV_ALL = 0
```

The event is only transmitted if the difference between the new value and the previously transmitted value is larger than 25.

The project specific definition can also be used in the following way:

```plaintext
#WHEN 4 #BLOCK ; ********************** DNP 3.0 slave*******
  ;**************** project-specific modifications********************
  #IF BIT(%SIGNAL_HANDLING_ATTRS(%NCC_COUNTER),0) == 1 #THEN #BLOCK
  ;write the project-specific code in this block
  @DELTA = 30
  #BLOCK_END
```

The event is only transmitted if the difference between the new value and the previously transmitted value is larger than 30. Now, this applies only to the points, which have the project specific bit set in the Signal X-references tool. This modification is useful if only a small group of points generate a useless load to the NCC line.

If each point or each station must have a limiting value of its own, the usage of a threshold value in the process object may be considered, see the Application Objects manual. The TH attribute can be used to limit the amount of activation of COM_USAI procedure. If a nonzero value is used in TH, it is usually better not to modify COM_USAI as described above.

For more information, contact your local supplier.
5.3.2. Commands

5.3.2.1. Mechanism and data types

COM 500 receives a command from an NCC as an input, which activates a set of command procedures. It sends the command to the process objects that are connected to the process units based on the information stored in the cross-reference tables. This data includes:

- Logical names and indexes of the output process objects
- Logical name and index of the response indication, if any connected
- Information about the handling of the signal (signal handling attributes)

![Diagram of command flow](image)

**Fig. 5.3.2.1.-1 Command from the NCC into the COM 500 application.**

The input process objects that receive the commands from the NCC are created automatically by the Signal Cross-Reference Tool. The following output data types are supported in COM 500:

- Binary output
- Digital output
- Analog output

5.3.2.2. Telegrams and parameters

The following table presents the different IEC 60870-5-101/104 ASDU types that are expected in COM 500 when receiving commands from an NCC. The ASDU used depends on the signal handling attributes selected for the signal in the Signal Cross-Reference Tool. Only those signal handling attributes that affect the ASDU used are mentioned.
If a digital command is made to a non-IEC protocol, the command type from an NCC must be analog. The Regulating Step Command is a binary command. Other protocols than IEC 60870-5-101/104 use the digital value itself in the command, for example a 16-bit value.

Table 5.3.2.2-1  IEC 60870-5-101/104 ASDU types in COM 500

<table>
<thead>
<tr>
<th>Data type</th>
<th>Signal Handling Attributes</th>
<th>ASDU Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary output</td>
<td>Project Specific</td>
<td>C_DC NA_1(46)</td>
</tr>
<tr>
<td></td>
<td>Inversed Value</td>
<td>C_SC NA_1(45)</td>
</tr>
<tr>
<td></td>
<td>Receive as Double Command</td>
<td></td>
</tr>
<tr>
<td></td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>Analog output</td>
<td>Project Specific</td>
<td>C_DC NA_1(46)</td>
</tr>
<tr>
<td></td>
<td>Inversed Value</td>
<td>C_SC NA_1(45)</td>
</tr>
<tr>
<td></td>
<td>Receive as Double Command</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Receive as Single Command</td>
<td>C_SE NA_1(48)</td>
</tr>
<tr>
<td></td>
<td>Receive as Direct Command</td>
<td>C_SE NB_1(49)</td>
</tr>
<tr>
<td></td>
<td>None</td>
<td>C_SE NC_1(50)</td>
</tr>
<tr>
<td>Digital output</td>
<td>Project Specific</td>
<td>C_SE NA_1(48)</td>
</tr>
<tr>
<td></td>
<td>None</td>
<td>C_SE NB_1(49)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>C_SE NC_1(50)</td>
</tr>
</tbody>
</table>

The following table describes the output data objects and variations used with the DNP 3.0 slave protocol.

Table 5.3.2.2-2  DNP 3.0 output data objects and variations in COM 500

<table>
<thead>
<tr>
<th>Data type</th>
<th>Signal Handling Attributes</th>
<th>Object</th>
<th>Variation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary output</td>
<td>Project Specific</td>
<td>10</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Inversed Value</td>
<td>12</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Report Status to Master</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>None</td>
<td>12</td>
<td>1</td>
</tr>
<tr>
<td>Analog output</td>
<td>Project Specific</td>
<td>40</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Inversed Value</td>
<td>41</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Report Status to Master</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Receive as Single Command</td>
<td>12</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>None</td>
<td>41</td>
<td>2</td>
</tr>
</tbody>
</table>

Analog output values are scaled and limited by using a reverse algorithm that is used when analog input values are sent to the NCC.

It is possible to define binary input commands received from the NCC for the analog output command. These are used when commanding a REC 561 type of device. It uses analog values for binary commands. These analog values can be defined by the user in the COMTool parameters, otherwise default values are used.

The RP 570 and CPI command analog output values are scaled and limited by using the scale COM_AIRPncc_number. They are generated when the COM 500 application is started for the first time.
5.3.2.3. Command confirmations in IEC 60870-5-101/104

IEC 60870-5-101/104 protocol includes the concept of command confirmation and termination. In COM 500 commands sent from a NCC using the IEC 60870-5-101/104 protocol are confirmed and terminated as follows:

• System commands are always confirmed by the COM 500 application software.
• All application commands except the reading of user data (ASDU 102) are confirmed and terminated by the COM 500 application software.
• Reset process commands (ASDU 105) are only confirmed, not terminated.

Direct data commands are confirmed and terminated as follows:

• A command is confirmed when the handling of the command in the corresponding command procedure begins.
• If the command is not authorized, a negative command confirmation is sent.
• If the response indication related to the command has not been connected to the command in the Signal Cross-Reference Tool, the command is terminated when the handling of the command in the corresponding command procedure is finished.

Secured data commands are confirmed and terminated as follows:

• A command is confirmed when the process device replies to the selected command. If the response is negative, a negative command confirmation is sent to the NCC.
• If the command is not authorized or it fails, a negative command confirmation is sent.
• A command is terminated when the process device replies to the executed command, and the command is not attached to a specific indication. If the reply is negative, a negative activation termination is sent to the NCC.
• If the response indication related to the command has not been connected to the command in the Signal Cross-Reference Tool, the command is terminated when the handling of the command in the corresponding command procedure is finished.

If an indication is connected to a data command, the following rules apply:

• If the output objects are of IEC type, the command is terminated when the termination is received from the device. The IEC/Analog Input termination process object must be in index (IX) with the indication process object index added with 100. The Object Address (OA) must be 1 000 000Hex added with a command object address to receive confirmation and termination from the device to the database. To use this function an indication must be connected to the command in the ComTool.
• In case of another output object type, the command is terminated when the connected response indication is updated.
• If the termination (IEC) or response indication (other types) is not received within the time-out parameter Response Indication Timeout defined in the Signal Cross-Reference Tool, a negative termination is sent.

The value of the PC attribute of each IEC slave station should be set to 0 when using the COM 500 software. Otherwise commands may not be properly confirmed or terminated.

5.3.3. System messages, system and application commands

The NET unit generates protocol-specific system messages as status codes to inform about some special conditions, for example, about the loss of communication. COM 500 provides means to use system messages and to make actions accordingly.

NCC protocols provide specific application and system commands that are used in such tasks as time synchronization or interrogation of data. These commands are also handled by a COM 500 application.

The system and application commands supported by COM 500 can be found in the interoperability lists and device profiles of the NCC protocols or in the MicroSCADA technology manuals describing the implementation of these protocols.

The NET unit handles application and system commands. These commands are received by process objects that are created by the Signal Cross-Reference Tool. After this, the COM 500 command procedures are activated. To ensure that these commands are received and executed properly, the values of the MI (Message Identification) and CA (Command Address) attributes of IEC and DNP slave stations should be checked as stated in Chapter 3 of this document.

5.3.4. Time synchronization

By default COM 500 should be synchronized from each NCC. Until a synchronization message is received, the time stamps of the messages sent to the NCC are marked as invalid. After a synchronization message has been received, time stamps are marked as valid until the system is restarted for the next time.

If the system is synchronized by other means, for example by using a local GPS receiver, there is no need to mark the time stamps as invalid. This can be done in different NCC protocols as follows:

• In IEC 60870-5-101/104 by setting the RM attribute of the IEC slave station so that bit 1 of the value is set (RM = 2 if no other bits are set)
• In RP 570 slave by setting the TI attribute of the SPI station to 1
• In DNP 3.0 by setting the TC attribute of the DNP slave station to 1
5.4. Cross-reference and parameter files

Cross-reference information and various parameters are stored in free type process objects and ASCII text files.

The files described in this chapter should never be edited manually because it may lead to a severe application malfunction.

Cross-reference files

The Signal Cross-Reference Tool writes the cross-reference information to ASCII text files from where they are loaded automatically at start-up. The following text files are found in the directory /APL/<name>/com500:

- COM_XRNCC1.txt contains the NCC definitions
- COM_XRCMD*.txt contains cross-reference information of the commands (output process objects)

If the previous COM 500 version is used, the directory may also contain COM_XRIND*.txt files. These files are no longer used to store the indication cross-reference information.

Cross-reference information of indications is stored in free-type process objects.

5.4.1. System and application parameter file

COM 500 uses a set of system and application parameters to control its operation. These parameters are used by the Signal Cross-Reference Tool and the COM 500 command procedures. Some of the parameters can be edited on the Parameters tab of the Signal Cross-Reference Tool and some are internal parameters of COM 500. The parameters are saved in the file Com500.ini.

5.4.2. Parameter files of the Signal Cross-Reference Tool

These parameter files are used for defining the user-interface, attributes and view definitions in the Signal Cross-Reference Tool. There are three parameter files, which have the following names, locations and purposes:

- Attr_com.txt contains a list of valid attributes concerning process objects, that can be attached as columns to the Indications and Commands tabs of the Signal Cross-Reference Tool. Location: /sc/Stool/SysConf.
- ComTool.ini is located in the directory: /sc/apl/<name>/par/<user> and it contains:
  - The definitions for the Signal Cross-Reference Tool co-ordinates on screen during the last session, number of columns attached to the Indications and Commands tabs and the number of selected view definitions.
  - The definitions for ruler positions located between adjacent columns to define the width of the column.
  - Definitions for attribute names and their titles in columns.
- ComView.ini contains the definitions for the number of views assigned to the Signal Cross-Reference Tool and the names of views defined using View Definitions. The assigned indication and command signal conditions for every view defined by using View Definitions. Location: /sc/apl/<name>/par/<user>.
5.5. Application objects

5.5.1. Introduction

Several application objects are created by COM 500. Some of these objects are created automatically at the first start-up, and some are created when definitions are made in the Signal Cross-Reference Tool. Also existing application objects are modified.

In COM 500 the following naming convention is used:

- Event channels, time channels, free-type objects and command procedures are named COM_*:*.
- Process objects and free-type process objects are named BNCC*:P.

COM 500 application objects should not be removed or modified.

5.5.2. Application objects created by COM 500

COM 500 creates new application objects for the following purposes:

- Event channels and command procedures for sending data from the input process objects to the NCCs.
- Process objects for receiving commands from the NCCs.
- Event channels and command procedures for interpreting commands coming from the NCCs and sending them to the correct output process objects.
- Event channels, process objects and command procedures for group alarm functionality.
- Event channels and command procedures for COM application start-up and initialization.
- Event channels and command procedures application and system commands.
- Time channels, event channels and command procedures for command termination.
- Free-type objects and process objects for storing cross-reference data.
- Free-type object for storing internal parameters.

In addition to the application objects described above, some other objects may also be needed for the COM functionality. The Signal Cross-Reference Tool creates these objects.

If an address overlap occurs when creating a process object with a predefined address, the execution of the COM 500 command procedure is attached to the secondary objects of the event channel connected to the existing process object.
5.5.3. Application objects modified by COM 500

When a cross-reference is attached to a process object, the following modifications are made:

- The Table Index (TI) attribute of the process object is set to point to the due position of the cross-reference table.
- The event channel, for example COM_USAI for analog input process object, is attached to the process object and the event channel activation is set. If the event channel (AN attribute) of the process object is already reserved, the execution of the COM 500 command procedure is attached to the secondary objects list of the event channel.

Other modifications made by COM 500 include:

- The execution of the command procedure COM_COMINI is attached to the predefined command procedure APL_INIT_1.
- The execution of the command procedure COM_SUSSTA is attached to the predefined command procedure APL_EVENT.
- The execution sequence for the NET restart uses the system event process object for the used NET node number.

5.6. COM 500 command procedures

For each MicroSCADA data type supported in COM 500 there is a command procedure to deliver this type of data. Each of these command procedures is executed in a parallel queue of its own. The data type and function of these command procedures can be identified to be based on the following naming convention:

- The command procedures that send data to the upper level system are named COM_US + data type, for example COM_USDB for double binary indication data.
- The command procedures that forward commands from the upper level system to the process devices are named COM_DS + data type, for example COM_DSAO for analog output data.

In addition to the command procedures designed for the actual data delivery, there are also command procedures for other purposes, for example parameter reading, interpreting cross-reference information, executing the system and application commands. All the command procedures included in COM 500 are shortly described in this section.

In some cases the command procedures are executed spontaneously, that is driven by event channel execution caused by the update of a process object, and in some cases the procedures are executed by other command procedures.

The command procedures are created automatically at start-up when a monitor is opened for the first time to an application that has been prepared for COM 500. The source code of the procedures is read from the text files located in the directory /com/active/com_. For performance reasons most of the command procedures are compiled when they are created, that is the compiled code is executed during the signal routing.
To prevent the handling of different data types from affecting each other, COM 500 uses different parallel queues for command procedures.

The following list shows the parallel queues used with the dedicated COM 500 command procedures.

**Table 5.6.-1 Used Parallel Queues with Dedicated Command Procedures**

<table>
<thead>
<tr>
<th>Queue</th>
<th>Command Procedures</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>COM_COMINI, COM_RDGEN, COM_RDXREF, COM_NETINI, COM_GRPAL, COM_GRPSTD, COM_RESPRC, COM_RDDTA, COM_SUSSTA, COM_PNDIND, COM_RESPRC, COM_DBSTA, COM_DCNET</td>
</tr>
<tr>
<td>7</td>
<td>COM_USDB</td>
</tr>
<tr>
<td>8</td>
<td>COM_USBI</td>
</tr>
<tr>
<td>9</td>
<td>COM_USAI</td>
</tr>
<tr>
<td>10</td>
<td>COM_USDI</td>
</tr>
<tr>
<td>11</td>
<td>COM_GENINT, COM_CNTINT</td>
</tr>
<tr>
<td>12</td>
<td>COM_USBS, COM_USPC</td>
</tr>
<tr>
<td>13</td>
<td>COM_DSBO</td>
</tr>
<tr>
<td>14</td>
<td>COM_DSAO, COM_DSDO</td>
</tr>
<tr>
<td>15</td>
<td>COM_USBO, COM_USAO</td>
</tr>
</tbody>
</table>

The parallel queues from number 3 to 6 are free to be used in the COM 500 applications (revision 3.0 or later). It must be noticed that LIB 500 uses those queues when installed. See the LIB 500 documentation for more details.

In situations where there is need for free parallel queues, the following can be done to 5 free queues:

- Set all the COM 500 command procedures in queue 1 to queue 0. Now these procedures use the first random queue.
- Move the command procedures from queue 12 and 15 to queue 10.
- Move the command procedures from queue 13 and 14 to queue 11.

For more information on how to change a queue, see the Application Objects manual.

### 5.6.1. Description of the command procedures

**COM_101SCR:C**

Creates an IEC 60870-5-101 slave line and station(s). This command procedure can be used for communication system configuration and executed for example from the predefined command procedure APL_INIT_1:C.

**COM_104SCR:C**

Creates an IEC 60870-5-104 slave line and station(s). This command procedure can be used for communication system configuration and executed for example from the predefined command procedure APL_INIT_1:C.
COM_AUTHCH:C
Executes the COM 500 authorization check mechanism. Refer to Section 4.6.16. Defining parameters for more information. This command procedure is executed by each of the command procedures COM_DS**:C.

COM_BOCMD:C
Executes a direct or secured object command depending on the command type, the protocol of the upper level system and the protocol of the process device. This command procedure is executed by the command procedure COM_DSBO:C.

COM_CNTINT:C
Executes a counter interrogation command sent from a NCC of protocol type IEC 60870-5-101. This command procedure is executed by the command procedure COM_IESA:C.

COM_COMINI:C
Executes the start-up mechanism of a COM 500 application by executing a number of sub-procedures. The execution of this command procedure is automatically attached to the predefined command procedure APL_INIT_1:C.

COM_CPIDI:C
Sets the DI (Database Initialized) attribute of CPI when the COM 500 process database has been updated after start-up (after time set in the parameter Database Initialization Time has expired). For more information, refer to Section 4.6.16. Defining parameters. This command is executed by the command procedure COM_NETINI:C.

COM_CPISS:C
Interprets the system messages coming from a CPI-connected NCC and executes a number of sub-procedures according to the received system messages.

COM_DBSTA:C
Marks the database initialized for the COM 500 application. This command procedure is executed by COM_NETINI:C.

COM_DCNET:C
Creates event channels and command procedures for restarting a communication unit. This command procedure is executed once by COM_COMINI:C.

COM_DNPSCR:C
Creates a DNP 3.0 slave line and station. This command procedure can be used for communication system configuration and executed for example from the predefined command procedure APL_INIT_1:C.
COM_DNPSS:C
Interprets and confirms the application commands sent from a NCC of protocol type DNP 3.0. Application commands (for example cold start) are executed by a number of sub-procedures.

COM_DSAO:C
Forwards an analog output-type command coming from a NCC to the process device. The value of the command is handled according to the signal handling attributes selected in the Signal Cross-Reference Tool.

COM_DSBO:C
Forwards a binary output-type command coming from a NCC to the process device. The value of the command is handled according to the signal handling attributes selected in the Signal Cross-Reference Tool. Executes the sub-procedure COM_BOCMD:C.

COM_DSDO:C
Forwards a digital output-type command coming from a NCC to the process device. The value of the command is handled according to the signal handling attributes selected in the Signal Cross-Reference Tool.

COM_DSXREF:C
Interprets and handles the data stored in the command cross-reference tables. This command procedure is executed by each of the command procedures COM_DS**:C.

COM_GENINT:C
Executes a general interrogation command sent from a NCC depending on the protocol of the NCC. This command procedure is executed by the command procedures COM_IESA:C, COM_CPISS:C and COM_RPSS:C.

COM_GRPAL:C
This command procedure takes care of the group alarm handling.

COM_GRPSND:C
Performs a forced sending of group alarms, for example at start-up or when re-initializing a NET database.

COM_IECTRM:C
Forwards a command termination sent from an IEC 60870-5-101/103 process device to a NCC of protocol type IEC 60870-5-101/104.

COM_IESA:C
Interprets and confirms the application commands sent from a NCC of protocol type IEC 60870-5-101/104. Application commands (for example general interrogation) are executed and terminated by a number of sub-procedures.
COM_IESEI:C
Sends an end-of-initialization message (ASDU 70) to a NCC of protocol type IEC 60870-5-101/104 after the COM 500 process database has been updated after start-up (after the time set in the parameter Database Initialization Time has expired). For more information, refer to Section 4.6.16. Defining parameters. This command procedure is executed by the command procedure COM_NETINI:C.

COM_IESS:C
Interprets and confirms the system commands sent from a NCC of protocol type IEC 60870-5-101/104.

COM_NETINI:C
Initializes the internal databases of the RP 570 and DNP 3.0 slave devices in NET. The CPI slave is also initialized. Executes the command procedures COM_GENITNT:C, COM_IESEI:C and COM_RPSDI:C (after the time set in the parameter Database Initialization Time has expired).

COM_PNDIND:C
Checks whether there are pending, that is response indications (indications connected to a command that have not yet been updated) older than the parameter Response Indication Time-out, and if such indications are found, terminates the corresponding commands (negative termination). This command procedure is called by time channel COM_PNDIND. Refer to Section 4.6.16. Defining parameters for more information.

COM_RDDATA:C
Executes a read of user data command sent from a NCC of protocol type IEC 60870-5-101/104. This command procedure is executed by the command procedure COM_IESA:C.

COM_RDGECN:C
Initializes and reads the system and application parameters either from the application itself or from the parameter file Com500.ini. This command procedure is executed either by the command procedure COM_COMINI:C at start-up or by the Signal Cross-Reference Tool when the parameters have been edited.

COM_RXREF:C
Loads the cross-reference information from the downstream cross-reference files to RAM at start-up. This command procedure is executed by the command procedure COM_COMINI:C.

COM_RESPRC:C
Executes a reset process command sent from a NCC of protocol type IEC 60870-5-101/104. This command procedure is executed by the command procedure COM_IESA:C.
**COM_RESSEL:C**
Resets the internal selection flag of a command coming from a CPI-connected NCC (after the time set by the parameter CPI Command Reset Time has expired), if no execute command is received to the same address.

**COM_REVDTA:C**
Contains the revision information of the current COM 500 version.

**COM_RPSCR:C**
Creates an RP 570 slave line and station. This command procedure can be used for communication system configuration. It can be executed, for example, from the predefined command procedure APL_INIT_1:C.

**COM_RPSDI:C**
Sets the DI (database initialized) attribute of a RP 570 slave station after the COM 500 process database has been updated after start-up (after the time set in the parameter Database Initialization Time has expired). This command procedure is executed by the command procedure COM_NETINI:C. For more information, see Section 4.6.16. Defining parameters.

**COM_RPSFT:C**
Loads FTABs from a text file to an RP 570 slave station. The FTAB file must be created by using other software.

**COM_RPSS:C**
Interprets the system messages coming from an RP 570 slave NCC and executes a number of sub-procedures according to the system message.

**COM_RPSY:C**
Marks an RP 570 slave NCC as synchronized when a clock synchronization message has been received from the NCC.

**COM_SUSSTA:C**
Sends the indications connected to process devices to the NCC after the process device is suspended. This command procedure is connected to the predefined event channel APL_EVENT.

**COM_USAI:C**
Sends analog input values to the NCCs. The value of the signal is handled according to the signal handling attributes selected in the Signal Cross-Reference Tool.

**COM_USAO:C**
Sends the status of analog output values to NCCs of protocol type DNP 3.0 if the corresponding signal handling attribute has been selected in the Signal Cross-Reference Tool.
COM_USB:C
Sends binary input values to the NCCs. The value of the signal is handled according to the signal handling attributes selected in the Signal Cross-Reference Tool.

COM_USB:C
Sends the status of binary output values to NCCs of protocol type DNP 3.0 if the corresponding signal handling attribute has been selected in the Signal Cross-Reference Tool.

COM_USB:C
Sends the bit stream values to the NCC. The value of the signal is handled by the signal handling attributes selected in the Signal Cross-Reference Tool.

COM_USDB:C
Sends double binary input values to the NCCs. The value of the signal is handled according to the signal handling attributes selected in the Signal Cross-Reference Tool.

COM_USDC:C
Sends digital input values to the NCCs. The value of the signal is handled according to the signal handling attributes selected in the Signal Cross-Reference Tool.

COM_USOXR:C
Interprets and handles the data stored in the command cross-reference tables when the status of output objects is sent to NCCs of protocol type DNP 3.0.

COM_USPC:C
Sends pulse values to the NCCs. The value of the signal is handled according to the signal handling attributes selected in the Signal Cross-Reference Tool.

COM_USXREF:C
Interprets and handles the data stored in the indication cross-reference tables. This command procedure is executed by each of the command procedures COM_US**:C.

5.6.2. Modifications to the command procedures

Without the exceptions mentioned in this chapter the COM 500 command procedures should not be modified.

Each of the command procedures COM_US**:C and COM_DS**:C are divided into four sections based on the NCC protocol; the first section is for RP 570 slave, the second for IEC 60870-5-101/104 slave, the third for CPI and the fourth is for DNP 3.0. In each of these sections there is the following empty SCIL block:

```scil
;************************ project-specific modifications ************************
#IF LENGTH(SELECT($SIGNAL_HANDLING_ATTRS(%NCC_NR),"==1")) > 0 #THEN #BLOCK
 ;write the project-specific code in this block
#BLOCK_END
```
This project specific block is for the project specific modifications that are protocol and data type specific, and can be activated by selecting the Project Specific signal handling attribute in the Signal Cross-Reference Tool for an individual signal. For example, if an analog signal is connected to three NCCs and the Project Specific signal handling attribute is selected for the RP 570 NCC, the SCIL code in the project specific block in the RP 570 section of the command procedure COM_USAI:C is executed when this individual signal is sent to the NCCs. The project specific block can be used for modifying the value, time stamp, status information and other parameters that are sent to the NCCs, or the data of the command received from a NCC.

When editing the COM 500 command procedures it should be ensured that the command procedures that are compiled are also compiled after editing, otherwise the performance of COM 500 may decrease.

5.7. File summary

The following files are copied to the system when COM 500 is installed. All the files are located in the directory /com/active/com_.

5.7.1. VSO files

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ComTool.vso</td>
<td>COM 500 Signal Cross-Reference Tool.</td>
</tr>
<tr>
<td>Com_Stand.vso</td>
<td>COM 500 Diagnostics Tool.</td>
</tr>
<tr>
<td>Com_Start.vso</td>
<td>COM 500 Start (login) picture.</td>
</tr>
</tbody>
</table>

5.7.2. INI files

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comstand.ini</td>
<td>Initialization file for the Diagnostics Tool.</td>
</tr>
<tr>
<td>Comtool.ini</td>
<td>Initialization file for the Signal Cross-Reference Tool.</td>
</tr>
<tr>
<td>Tools.ini</td>
<td>Initialization file for the Tool Manager.</td>
</tr>
<tr>
<td>Toolsupd.ini</td>
<td>File used for updating the Tool Manager.</td>
</tr>
<tr>
<td>Toolview.ini</td>
<td>Initialization file for the Tool Manager.</td>
</tr>
</tbody>
</table>

5.7.3. Text files for command procedure source code

<table>
<thead>
<tr>
<th>File</th>
<th>Description of the Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>COM_101SCR.txt</td>
<td>Creates a line and station for IEC 60870-5-101 slave</td>
</tr>
<tr>
<td>COM_104SCR.txt</td>
<td>Creates a line and station for IEC 60870-5-104 slave</td>
</tr>
<tr>
<td>COM_AUTHCH.txt</td>
<td>Checks the authority of a command from a NCC.</td>
</tr>
<tr>
<td>COM_BOCMD.txt</td>
<td>Performs a direct or secured command.</td>
</tr>
<tr>
<td>COM_CNTINT.txt</td>
<td>Performs a counter interrogation.</td>
</tr>
<tr>
<td>COM_COMINI.txt</td>
<td>Initializes a COM 500 application.</td>
</tr>
<tr>
<td>COM_CPIDI.txt</td>
<td>Sets the DI attribute of the CPI software.</td>
</tr>
<tr>
<td>COM_CPISS.txt</td>
<td>Receives and interprets the CPI system messages.</td>
</tr>
<tr>
<td>COM_DCNET.txt</td>
<td>Restarts COM 500 if NET is restarted.</td>
</tr>
<tr>
<td>COM_DBSTA.txt</td>
<td>Marks the database initialized.</td>
</tr>
<tr>
<td>File</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>COM_DNPSCR.txt</td>
<td>Creates a line and a station for DNP 3.0 slave.</td>
</tr>
<tr>
<td>COM_DNPSS.txt</td>
<td>Interprets DNP 3.0 application commands.</td>
</tr>
<tr>
<td>COM_DSAO.txt</td>
<td>Performs a direct command using an AO object.</td>
</tr>
<tr>
<td>COM_DSBO.txt</td>
<td>Performs a command using BO objects.</td>
</tr>
<tr>
<td>COM_DSDO.txt</td>
<td>Performs a direct command using a DO object.</td>
</tr>
<tr>
<td>COM_DSXREF.txt</td>
<td>Decodes command direction cross-reference data.</td>
</tr>
<tr>
<td>COM_GENINT.txt</td>
<td>Performs a general interrogation.</td>
</tr>
<tr>
<td>COM_GRPAL.txt</td>
<td>Sends a group alarm to a NCC.</td>
</tr>
<tr>
<td>COM_IECTERM.txt</td>
<td>Forwards command termination to NCCs.</td>
</tr>
<tr>
<td>COM_IESA.txt</td>
<td>Interprets the IEC 101/104 application commands.</td>
</tr>
<tr>
<td>COM_IESEI.txt</td>
<td>Sends an end-of-initialization message.</td>
</tr>
<tr>
<td>COM_IESS.txt</td>
<td>Interprets the IEC 101/104 system commands.</td>
</tr>
<tr>
<td>COM_NETINI.txt</td>
<td>Initializes the protocol converters in NET.</td>
</tr>
<tr>
<td>COM_PNDIND.txt</td>
<td>Terminates response indications after a timeout.</td>
</tr>
<tr>
<td>COM_RDDATA.txt</td>
<td>Performs a read-of-user-data command.</td>
</tr>
<tr>
<td>COM_RDGEN.txt</td>
<td>Reads application and system parameters.</td>
</tr>
<tr>
<td>COM_RDXREF.txt</td>
<td>Reads cross-reference information.</td>
</tr>
<tr>
<td>COM_RESPRC.txt</td>
<td>Performs a reset process command.</td>
</tr>
<tr>
<td>COM_RESSEL.txt</td>
<td>Resets selection flags of CPI commands.</td>
</tr>
<tr>
<td>COM_REVDTA.txt</td>
<td>COM 500 revision information.</td>
</tr>
<tr>
<td>COM_RPSCTRACT.txt</td>
<td>Creates a line and station for an RP 570 slave.</td>
</tr>
<tr>
<td>COM_RPSDI.txt</td>
<td>Sets the DI attribute of an RP 570 slave station.</td>
</tr>
<tr>
<td>COM_RPSFT.txt</td>
<td>Loads FTABs to an RP 570 slave.</td>
</tr>
<tr>
<td>COM_RPSS.txt</td>
<td>Interprets RP 570 system messages.</td>
</tr>
<tr>
<td>COM_RPSY.txt</td>
<td>Marks the RP 570 slave as synchronized.</td>
</tr>
<tr>
<td>COM_SUSSTA.txt</td>
<td>Sends the signals connected to a suspended station.</td>
</tr>
<tr>
<td>COM_USA1.txt</td>
<td>Sends analog data to the NCC.</td>
</tr>
<tr>
<td>COM_USAO.txt</td>
<td>Sends analog output status to the NCC.</td>
</tr>
<tr>
<td>COM_USB1.txt</td>
<td>Sends binary input data to the NCC.</td>
</tr>
<tr>
<td>COM_USBO.txt</td>
<td>Sends binary output status to the NCC.</td>
</tr>
<tr>
<td>COM_USB5.txt</td>
<td>Sends bit stream data to the NCC.</td>
</tr>
<tr>
<td>COM_USDB.txt</td>
<td>Sends double binary data to the NCC.</td>
</tr>
<tr>
<td>COM_USDI.txt</td>
<td>Sends digital input data to the NCC.</td>
</tr>
<tr>
<td>COM_USPC.txt</td>
<td>Sends pulse counter data to the NCC.</td>
</tr>
<tr>
<td>COM_USXREF.txt</td>
<td>Decodes monitoring direction cross-reference data.</td>
</tr>
</tbody>
</table>

5.7.4. Text files for object creation and other purposes

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COM_COM.txt</td>
<td>Source file for the APL_COM.txt definition text file.</td>
</tr>
<tr>
<td>COM_START.txt</td>
<td>Makes definitions at application start-up.</td>
</tr>
</tbody>
</table>
5.8. Exporting and importing cross-references with Microsoft Excel

If there is need to construct templates in Microsoft Excel, define cross-references for some signals in the ComTool and select Cross-Reference > Export. Fig. 5.8.-1 shows the Export dialog, from which you can define the Field Separator as TAB (tabulator). This function generates the COM_XRIND.xrf file into the application's PICT folder and it can be used for importing the template into Microsoft Excel.

![Export dialog of ComTool](image)

In the Microsoft Excel, select File > Open and select files of type All Files (*.*) from the drop-down menu. Navigate to the application's PICT folder and select the COM_XRIND.xrf file. Click Open. When Microsoft Excel recognises the file format, it launches the Text Import Wizard - Step 1 of 3 (see Fig. 5.8.-2). Select the Delimited file type and Start import at row 1. Click Next.
The Text Import Wizard - Step 2 of 3 is shown in Fig. 5.8.-3. Set the Delimiter to Tab and the Text Qualifier to (none). Click Finish.

---

**Fig. 5.8.-2  Text Import Wizard - Step 1 of 3 dialog of Microsoft Excel**

The Text Import Wizard - Step 2 of 3 is shown in Fig. 5.8.-3. Set the Delimiter to Tab and the Text Qualifier to (none). Click Finish.
The information included in the import file is displayed in Microsoft Excel, see Fig. 5.8.-4. The width of the columns can be adjusted according to the widest column cell by double-clicking at the top of intermediate column headers.

The information in the following columns is surrounded by double quotation marks. Logical name (LN), Object Identifier (OI), Object Text (OX), Address (Ad) and Scale (Sc). If an empty contents is included, it is represented as "" characters. Other columns, for example Index (IX), Process Object Type (PT), Alarm Group (AG), Alarm Bit (AB) and Signal Handling (SH) include integer values. If an empty contents is included, the cell's contents is empty. The Address, Alarm Group, Alarm Bit, Signal Handling and Scale columns appear for each NCC in which the NCC number is used as a prefix together with a colon.

The contents of Alarm Bit (AB) column depends on the Alarm Group (AG) definition in the following way. If the Alarm Group value has been defined to be for example 1, the first signal of this alarm group is identified with Alarm Bit value 1, the second signal of this alarm group is identified with Alarm Bit value 2 and so on. For the next Alarm Group, the alarm bit values start again from 1. If no alarm group definition exists, there is no need to fill the Alarm Bit column.

When definitions have been typed in the Microsoft Excel sheet, the signals to be imported into Signal Cross-Reference Tool can be determined by selecting the rectangular area of the signals and cross-reference definitions. This means that each
column and row in the sheet is selected and the information is copied to the clipboard by selecting Edit > Copy. This copied information can then be pasted to the Notepad application by pasting the contents of clipboard by selecting Edit > Paste in the Notepad. When information is pasted from the clipboard, the tabulator is always used as a field separator. Use then Notepad to store the information into a file to be imported into the Signal Cross-Reference Tool. Save the file to the application’s PICT folder with name COM_XRIND.xrf. Note that you should verify that all the information is included, because the indication cross-references are constructed into COM 500 according to the information on that file. Previous cross-references are removed from COM 500, when Import Mode Construct new cross-references is being used, and new cross-references are constructed according to the import file.

Selecting Cross-Reference > Import in the Signal Cross-References Tool opens the Import ComTool dialog, see Fig. 5.8.-5. Define the Import Mode as Construct new cross-references, Signals as indications and Field Separator as TAB (tabulator). Click OK.

![Import - ComTool dialog](image)

**Fig. 5.8.-5 Import dialog of ComTool**

When the importing into ComTool has finished, there is a need to refresh the view. This is done in order to update the displayed information in Indications according to the imported data, see Fig. 5.8.-6.
5.9. Converting cross-references from Microsoft Excel to COM 500 cross-references

Typically, the signal lists contain all the signals related to the information between COM 500 and NCC. These lists contain the used cross-references for indication and command addresses between substation (COM 500) and upper level system (Network Control Center). These lists are mainly maintained outside the COM 500 product, and their contents may already be specified by the upper level system. Due to the numerous amount of the different signal lists (with different amount of sheets used, different column names, and so on), the generic functionality to convert these signal list’s cross-reference files (.XRF), used by COM 500 product, has been introduced in Signal Cross-references Tool.

This functionality can be used to convert the indication signals: binary inputs, double binary indications, analog inputs and digital inputs. With regard to the command addresses, the signal engineering needs to be done in Signal Cross-References Tool only. At the moment, there is not a similar functionality in the product for handling the command cross-references outside the COM 500 product. Typically, the requirement to support signal lists is more important for indications. It is due to the bigger amount of signal related information concerning the indications, when compared with commands.

5.9.1. Cross-Reference File Converter

Converter can be started from the Signal Cross-References Tool menubar by selecting Cross-Reference > Convert or clicking the appropriate toolbar button .

Several settings have been introduced to identify the cross-reference information during the conversion.

Converter consists of five different tabs. The first four tabs are meant for each different indication type: Binary inputs, Double Binary Indications, Analog Inputs and Digital Inputs. Whereas, the fifth tab contains the Destination Parameters.
5.9.1.1. Source File Parameters

Source File Parameter specifies the file name and its location used as a source signal list file for each different indication type. It is also possible for the user to change the file name and location to something else when ... is clicked. Clicking this button opens the File Chooser.

When View is clicked, the Converter opens the source file in SCIL Viewer, see Fig. 5.9.1.1.-1.

The following chapters: Source File Parameters, Signal Identification Column Positions and Cross-Reference Identification Column Positions are common to the first 4 tabs. Whereas the functionality of Destination Parameters tab is described in its own Destination Parameters chapter, later on.
### 5.9.1.1. Binary inputs source file in SCIL Viewer

In SCIL Viewer, it is possible to see the contents of the source file as usual in text editor applications. This quality is needed in the next step, in which the row numbers that are being used as a source for the information during the conversion need to be specified.

Start from Row specifies the first row number to be handled. The default value is 1. If the source file contains a heading the Start from Row value should be set to 2.

Until Row specifies the last row that is handled during the conversion. The default value is the last row of the source file. Both Start from Row and Until Row values are read during the start-up of Converter, or when the source file name is changed via File Chooser.

### 5.9.1.2. Signal Identification Column Positions

This information is needed, when the signals are identified by their name and type during the conversion. Typically, the signal is identified based on the combination of Logical Name and Index attributes. The signal type is based on the value of Process Object Type. The column positions for LN and IX are mandatory. Column position PT is not needed, if the indication type specific tabs is used to convert signals of the same type, that is Binary Inputs tabs for binary input signals and Double Binary Indications tabs for double binary indication signals and so on. If the column position has not been specified and the user reads the source file into some of the indication tabs, the Converter informs the user to verify that all the signals in the source file are the same type as selected tabs.
If only one source file contains all the different indication types, then the conversion can be handled in one tab only. In this case, there is a need to specify the column position for the PT attribute.

Other signal identification columns and Object Text and Object Identifier are meant for recognizing the signals in the Preview and the functional purpose of each row in the resulted file, if later transferred to another system. With regard to the Object Identifier, the Preview can also combine the contents of Object Identifier, if it has been structured into several columns (Substation, Bay, Device, and so on). During the conversion, these columns are merged into one column in the result file. The values of these columns are not applied to the process database, when importing the converted file in the Signal Cross-References Tool later. This is because the import functionality is only meant for importing the cross-reference information.

The column position of each attribute is recognized through introducing its column position in the original file. Column positions are identified as numerical and alphanumerical information, for example 2 - B, where number 2 refers to the second column from the left-hand side of the file, or letter B, which refers to the B column in the source application.

If the data in the source columns has been qualified with "" characters, then the qualifier " should become selected for the appropriate attribute. As a default, None is applied as a qualifier.

5.9.1.3. Cross-Reference Identification Column Positions

These columns specify the actual cross-reference information, which is used at a run-time by COM 500 signal routing. Typically, each cross-referenced signal contains at least the Address. In the case of NCC connection, the address information may consist of the Address only, or also the Bit Number may be included. The values for Address and possible Bit Number should be integer values representing the address used between the COM 500 and NCC. As a default, the Bit Number is selected as type None, that is not defined in the converted file. It should be noted that Bit Number should be located in its own column position in the file to be converted.
In addition to the address column positions, the Alarm Group and Signal Handling may be included in the converted file. The value for Alarm Group should be an integer value representing the number of groups related to NCC in question. Whereas, the value for Signal Handling should be an integer value representing a different number related to the signal process object type and supported by COM 500 signal routing.

Scale column position should be defined in case the analog input signals are included into converted file. The value for Scale should be text representing the Scale object in the COM 500 process database. Note that the Cross-reference Converter does not check the existence of the Scale object in COM 500 process database. If the Scale object is not found during the signal routing, the message “COM 500 Scale object is not found” is produced in the Notify Window. The message also informs about the used Scale object and the signal identification.

For the DNP and IEC protocol it is also meaningful to include the Signal Class column position. The value for Signal Class should be an integer value representing the number of signal class applicables in communication.

As a default, both the Scale and Signal Class column positions are set as None, that is not defined.

5.9.1.4. Preview

The result of reading the file to be converted is produced in the Preview area. The Preview displays the information in the same order as it appears in the converted file.

The following table describes the functions of the buttons in this tool, see Table 5.9.1.4-1.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>Reads the input file in SCIL Viewer. It is possible to Print and Copy to clipboard the contents of opened file.</td>
</tr>
<tr>
<td>Read File</td>
<td>Reads the input file in selected tab and displays the result in Preview area</td>
</tr>
<tr>
<td>Convert tab</td>
<td>Converts the input file in selected tab and produces the file in output folder with specified name and format</td>
</tr>
<tr>
<td>Convert All</td>
<td>Converts all the input files in tabs and produces the file in output folder with specified name and format</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the Cross-Reference File Converter tool</td>
</tr>
</tbody>
</table>

5.9.1.5. Destination Parameters

It is possible to define the conversion Output File Name and location in this tab. As a default, the conversion result is written in the PICT folder of running application.

If there is a need to specify another file, click the button in the Destination Parameters, which opens the File Chooser dialog. Use this dialog to define another output file name and location.

When Append to File option is set (default), the conversion result is appended to the end of the file, if it exists. If Append to File is not set, the conversion result always overwrites the file, if it exists.
In this tab, it is also possible to select the output file format. There are two possible formats: Version 3.0 and Version 4.0. The version 3.0 is used in COM 500 product versions 3.0 and its related Service Packs running in MicroSCADA 8.4.3 environment. The version 4.0 is used in COM 500 product versions 4.0 and its related Service Packs running in MicroSCADA 8.4.4 or later environments.

5.9.1.6. Conversion Example

Below is an example on how to convert the indication cross-references from the tabular sheet to the file, and from there to convert by Cross-Reference File Converter to be later imported into Signal Cross-Reference Tool.

1. Open the tabular sheet in the application including the indication signals.
2. Select File > Save As from the application.
3. Save the file in the PICT folder or the running application and use the Text type (Tab delimited) with .txt extension.
4. If the different sheets are included in each indication signal type, the saving needs to be done for each sheet separately. Use the file names such as: AI.txt, BI.txt, DB.txt and DI.txt. This is because these are the default names used by the Cross-Reference File Converter when converting input files.
5. Start the Signal Cross-References Tool.
7. Specify the Source File Parameters, Signal Identification Column Positions, Cross-Reference Identification Column Positions according to each file to be converted. Click Read File to verify the result of column positions.
8. Define the definitions in the Destination Parameters tab according to the environment.
9. For each signal type, click the Convert tab or Convert All to convert the cross-references from .txt files to .xrf files.
11. Select Cross-Reference > Import from the Signal Cross-References Tool.
12. Set the option Construct new cross-references, First Row Includes Columns and Field Separator to , (comma).
13. Click OK.
14. When Importing is finished, refresh the view in Signal Cross-References Tool by re-selecting the active view name from the View menu.
Appendix

Command procedure changes

The following command procedures have changed from revision 2.0:

COM_AUTHCH
COM_BOCMD
COM_CNTINT
COM_COMINI
COM_CPISS
COM_DNPSS
COM_DNPSCR
COM_DPSTA
COM_DSAO
COM_DSBO
COM_DSDO
COM_DSXREF
COM_GENINT
COM_GRPAL
COM_GRPSND
COM_IECTRM
COM_IESA
COM_IESS
COM_IESEI
COM_NETINI
COM_PNDIND
COM_RDDATA
COM_RDGEN
COM_RDXREF
COM_RESPRC
COM_REVDTA
COM_RPSDI
COM_RPSFT
COM_RPSS
COM_RPSY
COM_SUSSTA
The following command procedures have changed from revision 2.0A:

- COM_AUTHCH
- COM_BOCMD
- COM_CNTINT
- COM_COMINI
- COM_CPISS
- COM_DPSTA
- COM_DSAO
- COM_DSBO
- COM_DSDO
- COM_DSXREF
- COM_GENINT
- COM_GRPAL
- COM_GRPSND
- COM_IECTRM
- COM_IESA
- COM_IESS
- COM_IESEI
- COM_NETINI
- COM_PNDIND
- COM_RDDATA
- COM_RDGEN
- COM_RDXREF
- COM_REVDTA
- COM_RESPRC
User's Guide

COM_RPSDI
COM_RPSFT
COM_RPSS
COM_RPSY
COM_SUSSTA
COM_USAI
COM_USAO
COM_USB1
COM_USBO
COM_USDB
COM_USDI
COM_USB5
COM_USPC
COM_USXREF

The following command procedures have changed from revision 3.0:

COM_BOCMD
COM_CNTINT
COM_COMINI
COM_DPSTA
COM_DSAO
COM_DSBO
COM_DSDO
COM_GENINT
COM_GRPAL
COM_GRPSND
COM_IECTRM
COM_IESA
COM_NETINI
COM_PNDIND
COM_RDGEN
COM_REVDTA
COM_RPSDI
COM_RPSFT
COM_RPSS
COM_SUSSTA
The following command procedures have changed from revision 4.0:

- COM_104SCR
- COM_BOCMD
- COM_DSAO
- COM_GENINT
- COM_GRPAL
- COM_GRPSEND
- COM_IESA
- COM_INIT
- COM_NETINI
- COM_REVDTA
- COM_RPSFT
- COM_SUSSTA
- COM_USAI
- COM_USAO
- COM_USBI
- COM_USBO
- COM_USBS
- COM_USDB
- COM_USDI
- COM_USPC
## 7. Index

### A

**AB** ........................................................................................................... 116  

**Add**  
Alarm group ........................................................................................................... 40  
Cross-reference ....................................................................................................... 49  
Icon for the Communication Diagnostics ............................................................... 30  
Icon for the Signal Cross-Reference Tool ............................................................... 30  
NCC .......................................................................................................................... 35  
New attribute .......................................................................................................... 44  
Signals ....................................................................................................................... 46  
View definitions ....................................................................................................... 42  

**Address** ........................................................................................................... 116  
**Address offsets** .................................................................................................. 31  
**AG** ....................................................................................................................... 54, 116  
**Alarm Bit** ........................................................................................................... 116  
**Alarm Groups** ..................................................................................................... 12, 39, 72, 116  

**Analog**  
Data .......................................................................................................................... 113  
Input ........................................................................................................................... 49, 53, 92, 94, 95, 96, 97, 100, 105  
Output ......................................................................................................................... 56, 57, 59, 96, 99, 100, 105  
Signal .......................................................................................................................... 47, 52, 97, 112  
ANSI X3.28 ............................................................................................................... 88  
ANSI X3.28 master ................................................................................................... 88  
AO object ..................................................................................................................... 113  
APL:BSV ..................................................................................................................... 28  
APL_EVENT .............................................................................................................. 105, 110  
APL_INIT_1:C ......................................................................................................... 106, 107, 110  

**Application**  
Backup ..................................................................................................................... 13  
Check list ...................................................................................................................... 28  
Commands .................................................................................................................. 17, 25, 90, 101, 102, 104, 105, 108, 113  
Malfunction ............................................................................................................... 103  
Objects ......................................................................................................................... 19, 27, 104, 114  
Page .................................................................................................................... 76, 78, 91  
Preparation ................................................................................................................ 18, 105  
Start-up ...................................................................................................................... 17, 104, 113  
Application Service Data Unit (ASDU) .................................................................. 92, 99, 109  
ASCII .......................................................................................................................... 103  
Attr_com.txt .............................................................................................................. 103, 114  
Authority .................................................................................................................... 80, 112  
Auto-addressing ......................................................................................................... 44, 45  
Automatic application update script ........................................................................ 19  

### B

Backup copies ............................................................................................................ 13
User’s Guide

Base system ........................................................................................................... 90
Base system computer ............................................................................................ 87
Binary
   Input .................................................................................................................. 46, 50, 91, 113
   Output .............................................................................................................. 56, 59, 95, 99, 100, 108, 111, 113
Binary input .......................................................................................................... 100
Bit stream ...................................................................................................... 92, 111, 113
BNCC* ................................................................................................................ 28, 104
BO objects .......................................................................................................... 113

C
C language .............................................................................................................. 87
CA ............................................................................................................................. 102
CD-ROM ............................................................................................................. 87
Class ....................................................................................................................... 96
Column Attributes ................................................................................................. 43
COM 500 .............................................................................................................. 8, 11, 12, 15, 87, 89
COM 500 application ............................................................................................ 16, 27
COM 500 Base System ......................................................................................... 21
COM_* .................................................................................................................. 28
COM_101SCR ....................................................................................................... 24
COM_BOCMD:C ................................................................................................. 108
COM_COMINI .................................................................................................... 105
COM_COMINI:C ................................................................................................. 105
COM_CPIDI:C .................................................................................................... 107
COM_CPISS:C .................................................................................................... 108
COM_DS ............................................................................................................... 105
COM_DS**:C ....................................................................................................... 107, 108, 111
COM_DSBO:C .................................................................................................... 107
COM_GENITNT:C .............................................................................................. 109
COM_IESA:C ..................................................................................................... 107, 108, 109
COM_IESEI:C ..................................................................................................... 109
COM_NETINI:C ................................................................................................ 109, 110
COM_RPSDI:C ................................................................................................ 109
COM_RPSS:C .................................................................................................... 108
COM_SUSSTA ................................................................................................... 105
COM_US ............................................................................................................... 105
COM_US**:C ...................................................................................................... 111
COM_USAO ........................................................................................................ 105
COM_USBS:C .................................................................................................... 111
COM_USDB ........................................................................................................ 105
COM_XRIND.xrf file .......................................................................................... 114

Command
   Authority check .............................................................................................. 15, 37, 90
   Authority dialog ............................................................................................... 62
   Confirmation ..................................................................................................... 101
   Procedures ...................................................................................................... 90, 104, 105
User's Guide

Signals .......................................................... 59
Source Check In Use ........................................ 62
Termination ......................................................... 101
Commands page .............................................. 29, 30, 33, 58
Communication
  Disturbances .................................................. 90
  Gateway .......................................................... 11, 15
  Server ................................................................. 15
Communication Diagnostics dialog ......................... 30, 70
Communication system configuration ..................... 110
ComTool.ini .......................................................... 103
ComView.ini .......................................................... 103
Configuration ........................................................ 8, 87
Configuration tips .................................................. 24
Corresponding signal .......................................... 50
CPI (Communication Programming Interface) .......... 17, 87, 89, 111, 112
CPI Command Reset ............................................ 110
CPI Selection Reset Time ..................................... 62
Cross-reference .................................................. 49, 103, 108, 111, 113
  Command signal ............................................... 58
  Export .............................................................. 63
  Import .............................................................. 64
  Indication signals .............................................. 47, 64
  Mechanism ........................................................ 90
  Menu ................................................................. 31
  Print ................................................................. 65
  Signals .............................................................. 44
Cross-references
  for commands .................................................. 56
  for indications ................................................... 47

D
DAT tape drive .................................................... 87
Database Initialisation Time ..................................... 61, 109
DCP-NET unit ..................................................... 15, 21, 22
Defining
  Attributes ......................................................... 43
  Indication cross-references ................................ 47
  NCC ................................................................. 37
  Parameters ......................................................... 61
Delete
  Alarm group ..................................................... 41
  Attribute .......................................................... 44
  Cross-reference ................................................ 53, 60
  NCC ................................................................. 37
  Signals .............................................................. 46
  Design ............................................................. 8, 87
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>DI attribute</td>
<td>112, 113</td>
</tr>
<tr>
<td>Diagnostics Tool</td>
<td>112</td>
</tr>
<tr>
<td>Digital Input</td>
<td>91, 113</td>
</tr>
<tr>
<td>Digital Output</td>
<td>56, 59, 99, 100</td>
</tr>
<tr>
<td>DNP 3.0</td>
<td>80</td>
</tr>
<tr>
<td>DO object</td>
<td>113</td>
</tr>
<tr>
<td>Double Binary data</td>
<td>113</td>
</tr>
<tr>
<td>Double Binary indication data</td>
<td>105</td>
</tr>
<tr>
<td>Double Binary input</td>
<td>91, 111</td>
</tr>
<tr>
<td>Edit Alarm group</td>
<td>41</td>
</tr>
<tr>
<td>Edit Attributes</td>
<td>44</td>
</tr>
<tr>
<td>Edit Signals</td>
<td>46</td>
</tr>
<tr>
<td>EM</td>
<td>91</td>
</tr>
<tr>
<td>Engineering process</td>
<td>11</td>
</tr>
<tr>
<td>Environment model of COM 500</td>
<td>17</td>
</tr>
<tr>
<td>Ethernet adapter</td>
<td>87</td>
</tr>
<tr>
<td>EU</td>
<td>91</td>
</tr>
<tr>
<td>Event channels</td>
<td>77, 104, 105</td>
</tr>
<tr>
<td>Exporting cross-references with Microsoft Excel</td>
<td>114</td>
</tr>
<tr>
<td>FCOM_COLDSTART</td>
<td>38</td>
</tr>
<tr>
<td>Field Separator</td>
<td>114, 117</td>
</tr>
<tr>
<td>File Chooser</td>
<td>39</td>
</tr>
<tr>
<td>Filters</td>
<td>75</td>
</tr>
<tr>
<td>Floppy drive</td>
<td>87</td>
</tr>
<tr>
<td>Free Integer (FI) attribute</td>
<td>28</td>
</tr>
<tr>
<td>Free-type objects</td>
<td>104</td>
</tr>
<tr>
<td>FTAB file</td>
<td>110</td>
</tr>
<tr>
<td>FTABs</td>
<td>113</td>
</tr>
<tr>
<td>Function Table download</td>
<td>38</td>
</tr>
<tr>
<td>Functionality</td>
<td>8, 87</td>
</tr>
<tr>
<td>GPS receiver</td>
<td>87</td>
</tr>
<tr>
<td>Group alarm</td>
<td>113</td>
</tr>
<tr>
<td>Handling</td>
<td>90</td>
</tr>
<tr>
<td>History viewer</td>
<td>79</td>
</tr>
<tr>
<td>HSI</td>
<td>11, 18, 27, 56, 62</td>
</tr>
<tr>
<td>HW requirements</td>
<td>87</td>
</tr>
</tbody>
</table>
MicroSCADA Pro

User’s Guide

I
IDE ........................................................................................................... 87
IEC 60870-5-101 .......................................................................................... 57, 100, 109, 111, 112
IEC 60870-5-101/103 .................................................................................. 108
IEC 60870-5-101/104 .................................................................................. 22
IEC 60870-5-103 .......................................................................................... 15, 56
IEC 60870-5-104 .......................................................................................... 112
IL (Information object address Length) .......................................................... 44
Import Mode .................................................................................................. 117
Importing
  Cross-references with Microsoft Excel .......................................................... 114
  Signals ........................................................................................................... 26
Index ............................................................................................................. 116
Indication Address Overlap Check ................................................................. 45
Indication signal ............................................................................................. 32, 50, 54
indication signals ........................................................................................... 118
Indications ..................................................................................................... 31, 91
Indications page ............................................................................................. 30, 32, 33
Initialisation of event state signals ................................................................. 53
Installation ..................................................................................................... 18, 87
Internal Process Objects .................................................................................. 28
Internal process objects .................................................................................. 31
International Standard ..................................................................................... 88
Interpreting cross-reference information ....................................................... 105
IX ............................................................................................................... 43, 116
L
LA .................................................................................................................. 54
LAN ................................................................................................................. 87
LIB 5xx .......................................................................................................... 18, 26, 27, 28, 62
Link Layer diagnostics .................................................................................. 70
LN ................................................................................................................. 43, 116
Logical name .................................................................................................. 116
LON ................................................................................................................. 88
LON Clock Master card .................................................................................. 87
LON Star Coupler ............................................................................................ 87
M
Mapping signals ............................................................................................. 15
Master protocols ............................................................................................. 87
MI .................................................................................................................. 102
Miscellaneous information ............................................................................. 62
Modbus .......................................................................................................... 22, 36, 37, 38
Monitoring direction cross-reference ............................................................. 113
N
NCC .............................................................................................................. 11, 12, 17, 91, 99, 101, 103, 104, 107, 108, 110, 111, 112, 113
NCCs page ...................................................................................................... 30, 33, 34

133
Negative
  Command Confirmation ................................................................. 80, 101
  Termination .................................................................................. 109
NET ................................................................................................... 92, 102, 109
NET Initialisation Start Delay ...................................................... 61
NETCONF tool ................................................................................ 22
Notification window ......................................................................... 77, 91

O
  Object Identifier ........................................................................... 116
  Object Navigation Tool .............................................................. 27
  Object Text .................................................................................. 116
  OI .................................................................................................. 43, 116
  Open monitor ................................................................................ 66
  Operation Mode .......................................................................... 37, 38, 63
  OX ................................................................................................ 43, 116

P
  Parallel Queues ........................................................................... 76, 106
  Parameter
    Files .......................................................................................... 90, 103
    Reading ..................................................................................... 105
  Parameters page ........................................................................... 30, 33, 61
  PC 31/32 radio clock board ......................................................... 87
  PC-NET .................................................................................... 15, 20, 22, 24
  Picture Editor ................................................................................ 27
  PLC-2-Family ............................................................................... 88
  Process
    Communication ......................................................................... 87
    Devices ..................................................................................... 11, 105
    Event Queues .......................................................................... 77
    Object Definition Tool ............................................................ 27, 46
    Object Type ............................................................................. 116
    Objects .................................................................................... 104
  Progress Indicator ........................................................................ 34
  Project Specific ........................................................................... 112
  Protocol
    Conversion .............................................................................. 11, 87
    Converters ............................................................................... 113
    Protocols ................................................................................ 22, 88
    PT ............................................................................................ 43, 116
    Pulse counter ........................................................................... 51, 92, 113

Q
  Queue length handling .............................................................. 77, 90

R
  RAM ............................................................................................ 87
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read-of-user-data</td>
<td>113</td>
</tr>
<tr>
<td>Record to Log</td>
<td>62</td>
</tr>
<tr>
<td>Reset</td>
<td></td>
</tr>
<tr>
<td>Alarm group</td>
<td>41</td>
</tr>
<tr>
<td>Process</td>
<td>101</td>
</tr>
<tr>
<td>Response Indication Timeout</td>
<td>62, 102, 109</td>
</tr>
<tr>
<td>Response indications</td>
<td>57, 109, 113</td>
</tr>
<tr>
<td>Reusing existing application</td>
<td>26</td>
</tr>
<tr>
<td>REx</td>
<td>56, 59, 62</td>
</tr>
<tr>
<td>REX 561 Command Values</td>
<td>62</td>
</tr>
<tr>
<td>REx Select Execute Delay</td>
<td>62</td>
</tr>
<tr>
<td>RP 570</td>
<td>15, 109, 110</td>
</tr>
<tr>
<td>RP 570 slave</td>
<td>89</td>
</tr>
<tr>
<td>RS-232-C Interface Module</td>
<td>88</td>
</tr>
<tr>
<td>RTU</td>
<td>89</td>
</tr>
<tr>
<td>RTU 200</td>
<td>18, 88, 89</td>
</tr>
<tr>
<td>RTU PROTOCOL 570 and 571</td>
<td>88</td>
</tr>
<tr>
<td>RTU specific configuration</td>
<td>52</td>
</tr>
<tr>
<td>Running Object</td>
<td>77</td>
</tr>
<tr>
<td>Scale</td>
<td>116</td>
</tr>
<tr>
<td>Scaling signals</td>
<td>97</td>
</tr>
<tr>
<td>SCIL</td>
<td>111</td>
</tr>
<tr>
<td>SCS</td>
<td>17</td>
</tr>
<tr>
<td>SCSI</td>
<td>87</td>
</tr>
<tr>
<td>Selection flags</td>
<td>113</td>
</tr>
<tr>
<td>Send IEC Terminations</td>
<td>62</td>
</tr>
<tr>
<td>SH</td>
<td>116</td>
</tr>
<tr>
<td>Signal</td>
<td></td>
</tr>
<tr>
<td>Engineering</td>
<td>12, 28</td>
</tr>
<tr>
<td>Generation</td>
<td>12, 26</td>
</tr>
<tr>
<td>Handling</td>
<td>59, 99</td>
</tr>
<tr>
<td>Rerouting</td>
<td>11, 28</td>
</tr>
<tr>
<td>Specific classes</td>
<td>50, 96</td>
</tr>
<tr>
<td>Signal Cross-Reference Tool</td>
<td>19, 30, 101, 102, 103, 108, 109, 110, 112</td>
</tr>
<tr>
<td>Signal Diagnostics</td>
<td>79</td>
</tr>
<tr>
<td>Signal Handling</td>
<td>116</td>
</tr>
<tr>
<td>signal identification columns</td>
<td>121</td>
</tr>
<tr>
<td>signal lists</td>
<td>118</td>
</tr>
<tr>
<td>Signal routing</td>
<td>90</td>
</tr>
<tr>
<td>Signals</td>
<td>117</td>
</tr>
<tr>
<td>Slave</td>
<td></td>
</tr>
<tr>
<td>Protocols</td>
<td>87</td>
</tr>
<tr>
<td>Station</td>
<td>110</td>
</tr>
<tr>
<td>Software installation</td>
<td>11, 18</td>
</tr>
<tr>
<td>SPA-Bus</td>
<td>88</td>
</tr>
<tr>
<td>Section</td>
<td>Reference</td>
</tr>
<tr>
<td>---------</td>
<td>-----------</td>
</tr>
<tr>
<td>SPACOM</td>
<td>56, 60</td>
</tr>
<tr>
<td>SRIO 1000M</td>
<td>88</td>
</tr>
<tr>
<td>SRIO 500M</td>
<td>88</td>
</tr>
<tr>
<td>STA Object Status Check Timeout</td>
<td>62</td>
</tr>
<tr>
<td>Stand-Alone COM 500</td>
<td>16</td>
</tr>
<tr>
<td>Standard Configuration Tool</td>
<td>27</td>
</tr>
<tr>
<td>Start (login) picture</td>
<td>112</td>
</tr>
<tr>
<td>Start-up actions</td>
<td>19</td>
</tr>
<tr>
<td>Station L/R Check In Use</td>
<td>62, 80</td>
</tr>
<tr>
<td>Station L/R Object Index</td>
<td>62</td>
</tr>
<tr>
<td>Station L/R Object Logical Name</td>
<td>62</td>
</tr>
<tr>
<td>Status Codes</td>
<td>14</td>
</tr>
<tr>
<td>Information</td>
<td>112</td>
</tr>
<tr>
<td>SYS_BASCON.com</td>
<td>21</td>
</tr>
<tr>
<td>SYS_COM500.com</td>
<td>21</td>
</tr>
<tr>
<td>System Backup</td>
<td>13, 87</td>
</tr>
<tr>
<td>Commands</td>
<td>17, 25, 90, 101, 102, 104, 105, 109, 113</td>
</tr>
<tr>
<td>Page</td>
<td>76</td>
</tr>
<tr>
<td>Parameters</td>
<td>113</td>
</tr>
<tr>
<td>Table Index (TI) attribute</td>
<td>28, 64, 105</td>
</tr>
<tr>
<td>TCP/IP network</td>
<td>89</td>
</tr>
<tr>
<td>Text Import Wizard</td>
<td>115</td>
</tr>
<tr>
<td>Time Channels</td>
<td>104</td>
</tr>
<tr>
<td>Stamp</td>
<td>112</td>
</tr>
<tr>
<td>Synchronisation</td>
<td>87, 102</td>
</tr>
<tr>
<td>Timeout</td>
<td>57, 61, 113</td>
</tr>
<tr>
<td>Traceability</td>
<td>78</td>
</tr>
<tr>
<td>Trip Signals list</td>
<td>54</td>
</tr>
<tr>
<td>Upgrade</td>
<td>18</td>
</tr>
<tr>
<td>Upper level Communication</td>
<td>87</td>
</tr>
<tr>
<td>System</td>
<td>105</td>
</tr>
<tr>
<td>View Definitions</td>
<td>41, 42</td>
</tr>
<tr>
<td>Zoom In</td>
<td>72</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>72</td>
</tr>
</tbody>
</table>